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HD LLC

ABOUT THIS MANUAL

Overview and Scope

This manual describes the installation and use of Harmonic Drive LLC (HD LLC) HDM
software.

Related Documentation

Links to publications, along with hardware manuals and data sheets, can be found under
the Documents heading at: http://www.harmonicdrive.net/

HD LLC software and related information can be found at:
http://www.harmonicdrive.net/support/ndm-downloads/

Comments

HD LLC welcomes your comments on this manual. See http://www.harmonicdrive.net for
contact information.

Copyrights

No part of this document may be reproduced in any form or by any means, electronic or
mechanical, including photocopying, without express written permission of HD LLC.
Windows NT, 2000, XP, and Vista are trademarks or registered trademarks of the Microsoft
Corporation.

Document Validity

We reserve the right to modify our products. The information in this document is subject to
change without notice and does not represent a commitment by HD LLC. HD LLC assumes
no responsibility for any errors that may appear in this document.
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1.1.1: Product Warnings

Observe all relevant state, regional, and local safety regulations when installing and using
HD LLC amplifiers. For safety and to assure compliance with documented system data,
only HD LLC should perform repairs to amplifiers.

Hazardous voltages.
Exercise caution when installing and adjusting HD LLC amplifiers.
Risk of electric shock.

DANGER On some HD LLC amplifiers, high-voltage circuits are connected to mains power.
Refer to hardware documentation.

Risk of unexpected motion with non-latched faults.

After the cause of a non-latched fault is corrected, the amplifier re-enables the
PWM output stage without operator intervention. In this case, motion may re-start
unexpectedly. Configure faults as latched unless a specific situation calls for non-
latched behavior. When using non-latched faults, be sure to safeguard against
unexpected motion.

Latching an output does not eliminate the risk of unexpected motion with non-
latched faults.

Associating a fault with a latched, custom-configured output does not latch the
fault itself. After the cause of a non-latched fault is corrected, the amplifier re-
enables without operator intervention. In this case, motion may re-start
unexpectedly.

For more information, see Faults (p. 68).
When operating the amplifier as a CAN or DeviceNet node, the use of ASCII serial

commands may affect operations in progress. Using such commands to initiate
motion may cause network operations to suspend.

Operation may restart unexpectedly when the commanded motion is stopped.
Use equipment as described.

Operate amplifiers within the specifications provided in the relevant hardware
manual or data sheet.

FAILURE TO HEED THESE WARNINGS CAN CAUSE EQUIPMENT DAMAGE,
INJURY, OR DEATH.

6 HD LLC



CHAPTER

1: INTRODUCTION

This chapter describes the basic functions and operational theory of HDM. Topics include:

v/ Host Computer Requirements (p. 8).
v" Amplifier Commissioning Software (p. 9).

v~ Servo Operating Modes and Control Loops (p. 10).

HD LLC 7
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1.1: Host Computer Requirements

1.1.1: Computer and Operating System

Minimal hardware requirements:

e CPU: 400 MHZ.

e RAM: 128 MB.

Operating Systems Supported: Windows NT, 2000, XP.

Vista users see Special Notes for Vista Users (p. 8).
1.1.2: Special Notes for Vista Users

Windows Vista is supported in this version of HDM.

Note that when the installer starts, a message will be displayed stating that an unidentified
program is trying to access the computer. Click the button to allow the installer to continue,
and HDM will be installed properly.

On previous versions of Windows, the user data for HDM (like ccx, ccm, files, etc.) were
stored in C:\Program Files\Harmonic Drive\HDM. Because of Windows Vista security, the
HDM user files are stored on Vista systems in C:\Users\Public\Public Documents\Harmonic
Drive\HDM.

1.1.3: Software
HD LLC HDM software, Version 6.0 or higher.

1.1.4: Serial Communications
For each PC-to-amplifier connection via serial port:

e One standard RS-232 serial port or a USB port with a USB-t0-RS-232 adapter.
¢ One serial communication cable. See amplifier data sheet for part numbers.

1.1.5: CAN Communications

(RTL Series and DDP Series.)

e One Copley Controls CAN PCI network card (part number CAN-PCI-02).
HDM also supports CAN network cards made by these manufacturers: KVaser,
Vector, and National Instruments.

¢ One PC-to-amplifier CANopen network cable. See amplifier data sheet for part
numbers.

See the amplifier data sheet for CAN network wiring instructions.

8 HD LLC
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1.2:

HD LLC

Amplifier Commissioning Software

HD LLC HDM software allows fast and easy commissioning of HD LLC amplifiers. It
provides access to all amplifier configuration controls. It supports all HD LLC amplifiers,
including HD LLC’s CANopen amplifier.

HDM communicates with amplifiers via RS-232 or CAN connections. On RTL Series, and
DDP Series, the multi-drop feature allows HDM to use a single RS-232 serial connection to
one amplifier as a gateway to other amplifiers linked together by CAN bus or DeviceNet
connections.

Motor data can be saved as .ccm files. Amplifier data is saved as .ccx files that contain all
amplifier settings plus motor data. This makes it possible to quickly set up amplifiers by
copying configurations from one amplifier to another.

HDM also provides access to HD LLC Virtual Machine (HDVM), a program that is set up in
HDM and downloaded to the amplifier to provide on-board control. When a HDVM program
is running, the amplifier receives its input commands from the HDVM program. For more
information, see the HD LLC Indexer 2 Program User’s Guide.

NOTE: The feature descriptions in this manual may not apply to all HD LLC amplifiers under
all configurations. Significant differences between amplifier models are noted. See the
relevant hardware manual or data sheet for more information.
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1.3: Servo Operating Modes and Control Loops

Target
Position

10

HD LLC amplifiers use up to three nested control loops - current, velocity, and position - to
control a motor in three associated operating modes.

Control Loops Model

In position mode, the amplifier uses all three loops. As shown in the typical system
illustrated below, the position loop drives the nested velocity loop, which drives the nested
current loop.

Limits
Position Velocity Limited Current Limited PWM
Command Command | Velocity Command Current Command
Y ' ' Y ' [= ! Y ' '
Trajectory | : Position | Velocity | : II_ ' Velocity ! :_ ! Current ' Current ! Motor/
Generator Loop Limiter T : Loop T Limiter Loop Sensors
E E
Actual Position DeRved Velocity R Actual Current

In velocity mode, the velocity loop drives the current loop. In current mode, the current loop
is driven directly by external or internal current commands.

Basic Attributes of All Servo Control Loops
These loops share several common attributes:

Loop Description

Attribute

Command Every loop is given a value to which it will attempt to control. For example, the velocity
input loop receives a velocity command that is the desired motor speed.

Limits Limits are set on each loop to protect the motor and/or mechanical system.

Feedback The nature of servo control loops is that they receive feedback from the device they are
controlling. For example, the position loop uses the actual motor position as feedback.

Gains These are constant values that are used in the mathematical equation of the servo
loop. The values of these gains can be adjusted during amplifier setup to improve the loop
performance. Adjusting these values is often referred to as tuning the loop.

Output The loop generates a control signal. This signal can be used as the command signal to
another control loop or the input to a power amplifier.

For more information on using HDM to set up and tune control loops, see
Control Loops (p. 93).

HD LLC



CHAPTER

2: INSTALLATION, STARTUP, AND
INTERFACE TOUR

This chapter shows how to install, start, and set up communications for HDM. Perform the
steps outlined below. Details follow in the chapter.

1 Verify that the system on which you will install HDM meets the
Host Computer Requirements (p. 8).
NOTE: Vista users see Special Notes for Vista Users (p. 8).
Install HDM Software (p. 12).

Start HDM (p. 13).

Configure Serial Port Parameters (p. 14) or Configure CAN Network Parameters (p. 16).

The chapter also includes HDM Interface Tour (p. 18) and describes how to Connect to an
Amplifier in HDM (p. 17) and Rename an Amplifier (p. 17).

HD LLC 11
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2.1: Install HDM Software

12

A WO DN =

Optionally download software from the Web

Choose or create a folder where you will download the software installation file.
In an internet browser, navigate to: http://www.harmonicdrive.net/support/hdm-downloads/
Under Software Releases, click on HDM.

When prompted, save the HDM.zip file to the folder chosen or created in Step 1.
The folder should now contain a file named HDM.zip.

Extract the contents of the zip file to the same location.
The folder should now contain the files HDM.zip and Setup.exe.

If desired, delete HDM.zip to save disk space.

Install HDM Software

If installing from a CD, insert the CD (HD LLC part number HDM).
Normally, inserting the CD causes the installation script to launch, and a HDM Installation
screen appears. If so, skip to Step 3.

If the software installation file is on a hard drive, navigate to the folder and then double-
click on Setup.exe

OR

if you inserted the CD and the HDM Installation screen did not appear, navigate to the root
directory of the installation CD and then double-click on Setup.exe.

Respond to the prompts on the HDM Installation screens to complete the installation. We
recommend accepting all default installation values.
NOTE: Vista users see Special Notes for Vista Users (p. 8).

HD LLC
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2.2: Start HDM Software

HD LLC

Ed|

Installation, Startup, and Interface Tour

Double-click the HDM shortcut icon on the Windows desktop to start HDM.

If communications were set up
already...

If communications were not set up...

...the HDM Main Screen opens. If there are
multiple ports, the HD LLC Neighborhood root will
be selected as shown below:

Bl HoM V6.0 (DEP-180-18 unname(
File  Amplifier Tools Help

i e BN =

[=+/_4 HD Neighbarhasd
BB wirual Amplifier
o -—-BC O unnamed

Inpu

Select the desired amplifier. For instance:

[=~_4 HD Meighbarhood
o KB fiptual smplifier
(o - —- B~ Ohi1: unnamed

See Connect to an Amplifier (p. 17).

...see the screen below:

H Communications Wizard @

Select device:
(%) Serial Parts
() CAN Network

[ flext = ] [ Cancel ]

In this case, proceed to Configure Serial Port
Parameters (p. 14) or Configure CAN Network
Parameters (p. 16).

If the amplifier is to run under DeviceNet control,
select Serial Ports. For more information, see the
Copley DeviceNet Programmer’s Guide.

After an amplifier has been selected, the HDM Main Screen looks similar to this:

S=1Ey

= HDM V6.0 (DEP-180-18 unnamed)

File  Amplifier Took Help

A7 e AV EE [ E cadl <af + &

[ 4 HD Neighbortood
Input / Qutput

Lo KB wirtual Amplifier

B B k1 unname:
CWh Contro] Program

[E Loop I—bl W Laop I—Dl | Loop ]—Pl MotorFeedback ]

|

Home

Configure Faults

|Sine Commutation |R0tar',-' Matar

|.°.m|:| Under Can Control

F12 To Disable

If the Basic Setup options have not been chosen, the Basic Setup screen opens.

13
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2.3: Configure Serial Port Parameters

One or more serial ports on a PC can be used to connect amplifiers. Use the following
instructions to add ports for amplifiers, to choose baud rates for those ports, and to
remove ports for amplifiers.

2]
Double-click the HDM shortcut icon on the Windows desktop to start HDM.

If a serial or CAN port has not been selected, the Communications Wizard Select device
screen appears.
ﬂﬂommunications Wizard @

Select device:
() 5erial Parts
() CAN Metwork

[ Mext = l [ Cancel ]

If the HDM Main screen appears instead of Select Device,
choose Tools>Communications Wizard.

Choose Serial Ports and click Next to open the Communications Wizard Select
Ports/Serial Ports screen.

= Communications Wizard @

Select Ports

To add serial ports, selectthem from the Awailable Ports list, then press Add.

To remove setial ports, selectthern from the Selected Ports list, then press Remaove.

Available Ports; Selected Ports:

From the Available Ports list, choose the serial ports that will be used for amplifiers.

= To allow an amplifier to connect through a port, select the port name and click Add.
= To remove a port from Selected Ports, select the port name and click Remove.

Continued...

14 HD LLC
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...Config

ure Serial Port Parameters, continued:

Installation, Startup, and Interface Tour

Click Next to save the choices and open the Communications Wizard Configure Serial
Ports screen.

= Communications Wizard

Configure Serial Ports

Select one or more serial ports from the list, then select the baud rate.

Selected Ports:

Baud Rate: | 115200 w

[ = Back ] [ Einish ] [ Cancel

&3

Configure the desired ports.

Highlight a port in the Selected Ports list.
Choose a Baud Rate for that port.
Repeat for each selected port.

Click Finish to save the choices.

HD LLC
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2.4: Configure CAN Network Parameters

A CAN port can be used to connect the host PC to one or more amplifiers. Use the
following instructions to configure CAN network settings.

7]
1 Double-click the HDM shortcut icon on the Windows desktop to start HDM.

If communications have not been set up, the Communications Wizard Select device
screen appears.
ﬂﬂommunications Wizard @

Select device:
() 5erial Parts
() CAN Metwork

[ Mext = l [ Cancel ]

If the HDM Main screen appears choose Tools>Communications Wizard.

3 Choose CAN Network.

Select device:

() Serial Port:

[ Mext = l l Cancel ]

4 Click Next to open the Communications Wizard Configure CAN Network screen.

H Communications Wizard @
Configure CAN Network

CAN Card: ICDpIey ~]

Channel; I 1]
Bit Rate: |1Mbit,l's "I

<gack | [Eneh Cancel |

5 Choose the appropriate CAN Card, Channel, and Bit Rate, and click Finish.
NOTES:
1) The CAN Card list shows the manufacturer names of all supported CAN cards that
have been connected to the PC and for which drivers have been installed.
2) All amplifiers must be set to the same bit rate (default is 1 Mbit/s).

16 HD LLC
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2.5: Connect to an Amplifier in HDM

Choose an amplifier by clicking on its name in the HD LLC Neighborhood. The neighborhood
organizes amplifiers according to the connection method.

One amplifier: Multiple amplifiers on serial:

E& HDM V6.0 (DEP-180-18 unnamet File Amplimer Tools He
Eile aAmplfier Tools Help [EE' :._»'- E
Iﬁ ﬁ m J |:|:lFl|l'-_-l.l ”l‘-_-ll;lhtll:ll'hl:ll:ld

B vikual Amplifier
- COM3: X fsis

(=% HD Meighborhood
o BB Wirtual Amplifier
o —- B " Ch1: unnamed

B Comg: v Asis

H | Inpu oo KB COMS: Z s

CAN network: Multi-drop: CAN or DeviceNet:

File amplifier Tools Help Fle amplifier Took Help

FEZENEE |[TE0EE

- == Copley Heighborhood
SR op =y Heighborhoo d -4

BB vitual Amplifier
B0 virtual Amplifier COM1: ACP

- BB CANT: X Axis == Node 1: ACM
B CANT: v Axis Mode 2: XSL1

BB CaNiZ: Z Axis
=8 Node 10: XSL-2

When there is only one amplifier available for connection, the software will connect
automatically on startup.

2.6: Rename an Amplifier

Each amplifier represented in the HD LLC Neighborhood amplifier tree has a name. The
default name for an amplifier is unnamed. Use this procedure to rename an amplifier.

1 Choose Main Menu AmilifieréRename to open the Rename Amplifier screen.

Enter the new name;

| FHA-17C-50-US200-C-E| |

l Ok ] [ Cancel ]

2 Enter the new name and click OK to close the screen.

HD LLC 17
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2.7: HDM

Interface Tour

HDM User Guide

HDM features are called out in the diagram below. Screen details vary depending on
amplifier model and mode selection. Details follow in the chapter.

Copley —
Ne ighbor hood
Tres

M ain Menu

Ble  Amplifier Tools Hep -

Toocl Bar

o7 bl B VEEE B ndadadal

=1 Copley Maighbornood UL CAN Nebwork: T address: T T 4
B3 Vidual Amplifier M Lo sclacabad ot abnind g mer ot

L==BCOM: Zenue XTL |gput Output

CWM Contral Program I

=T o

" Stake: Fre-operatioral ]

LAN Configuration }-—o EL

nop }——b W Loop |——’ | Loop }——) MotorFeedback

|CAN or DeviceNet
[ Infermation

;Fundi:}nal
iDiagrElm

Home |

Status I [Sine Commutation Riabary Motor

Ragen Saftings

o Under CAN Contraly, IHEREICEET SN

Configuns Faulke E

Bar

2.7.1: Tool Bar Overview

Click on any of the tools in the toolbar to access the tools described below.

Icon Name Description For More Information
ﬂ Basic Setup Opens Basic Setup screen. | Basic Setup (p. 31)
O Control Panel Opens Control Panel. Control Panel (p. 123)
& &
[a Auto Phase Opens Auto Phase tool. Motor Phasing (p. 75)
Auto Tune Opens Auto Tune for Linear | Auto Tune all Loops for
Servo Motors. Linear Motors (p. 115)
Scope Opens Scope. Scope Tool (p. 129)
Error Log Opens Error Log. Error Log (p. 149)

Amplifier Properties

Displays basic amplifier
properties.

Save amplifier data to disk

Saves contents of amplifier
RAM to a disk file.

Restore amplifier data from disk

Restores an amplifier file
from disk to amplifier RAM.

Save amplifier data to flash

Saves contents of amplifier
RAM to flash memory.

Restore amplifier data from flash

Restores contents of flash
memory to amplifier RAM.

Data, Firmware, and Logs
(p. 143)

18
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2.7.2: Main Menu Overview
The HDM Main Menu choices are described below.

Installation, Startup, and Interface Tour

Menu Selection Description For More Information
File Save MACRO File (MACRO amplifiers only.) Saves | Save MACRO File for Delta Tau
amplifier setup and tuning Controllers (p. 146).
parameters in a format that can
be read by Delta Tau controllers.
Save Amplifier Saves contents of amplifier RAM | Data, Firmware, and Logs (p.
Data to a disk file. 143).
Save As>V6.0 Saves amplifier data file in
Format format usable by HDM Version
6.0.
Restore-> Amplifier | Restores contents of an
Data amplifier file from disk to
amplifier RAM.
Restore>HDVM Prompts for a HD LLC Virtual Indexer 2 Program User Guide.
Control Program Machine program file. The
program in this file will replace
the current program in flash.
This procedure also results in
the setting of the Indexer 2
Program option Enable Control
Program on Startup. This
configures the program to auto
start when the amplifier is
powered up or reset.
Restore>Cam Prompts for a saved Cam Table See Camming Users Guide.
Tables file (.cct file). All tables in
amplifier flash will be replaced by
the ones in this file.
Restore>Gain Prompts for a saved Gain Gain Scheduling (p. 187).
Scheduling Table Scheduling Table (.ccg file).
Exit Closes HDM.
Amplifier | Basic Setup Opens Basic Setup screen. Basic Setup (p. 31)
Control Panel Opens Control Panel. Control Panel (p. 123)
Auto Phase Opens Auto Phase tool. Motor Phasing (p. 75)
Scope Opens Scope. Scope Tool (p. 129)
Error Log Opens Error Log. Error Log (p. 149)
Amplifier Displays basic amplifier
Properties properties.
Network Opens the CAN Configuration CAN: CAN Network Configuration
Configuration screen. (p. 67).
Rename Prompts for new amplifier name. Rename an Amplifier (p. 17)
Auto Tune Opens Auto Tune for Linear Auto Tune all Loops for Linear
Servo Motors. Motors (p. 115)
Gain Scheduling Opens Gain Scheduling screen. Gain Scheduling (p. 187).
Continued...

HD LLC
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...Main Menu Choices, continued:

Menu Selection Description For More Information
Tools Communications Starts sequence of prompts to Configure Serial Port Parameters
Wizard set up communications. (p. 14) and Configure CAN
Network Parameters (p. 16).
Communications Opens Communications Log. Communications Log (p. 150).
Log
Download Starts prompts to download Download Firmware to the
Firmware firmware from disk to amplifier. Amplifier (p. 147).
Download CPLD Starts prompts to download PLD
Program code from disk to amplifier.
Manual Phase Opens Manual Phase tool. Phase Motor Manually (p. 86).
View Scope Files Opens Trace Viewer window. Scope Files (p. 139).
1/0 Line States Opens I/O Line States window, Digital Inputs and Outputs (p.
showing high/low status of the 47).
amplifier’s inputs and outputs.
HDM Lock/Unlock Opens screen for locking and Lock/Unlock HDM Controls
unlocking HDM functionality. (p. 155).
ASCIl Command Opens screen to accept ASCII HDM ASCII Command Line
Line format commands. Interface Tool (p. 184).
Help HDM User Guide Opens this manual.
All Documents Opens the Doc folder in the HDM installation folder
(typically c://Program Files/HD LLC Motion/HDM/Doc).
This folder contains all of the related documents that were installed
with HDM.
Downloads Web Opens default web browser with pages from HD LLC’s website.
Page
Software Web Page
View Release Opens latest HDM release notes in a text viewer.
Notes
About Displays HDM version information.
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2.7.3: Functional Diagram

The functional diagram, shown below, provides button-click access to most of the screens
used to configure an amplifier. It also indicates the flow of control from input, across all
active control loops, to motor/feedback. Only those control loop buttons that are
appropriate to the amplifier and operational mode appear on the diagram.

Input ! Qutput |

HD LLC

HOWM Control Frogram I
CAH Configuration I—Q M Loop I—} W Lloop }—} | Leop
-

EMotor."reedbac-ké

Home |

Regen Settings | Configure Faults |

Installation, Startup, and Interface Tour

Name Description For More Information
Input/ Opens Input/Output screen. Digital Inputs and Outputs (p. 47)
Output
HDVM Opens HD LLC Virtual Machine screen. Indexer Program User’s Guide.
Control
Program
Input Opens screen for configuring the input command. Command Inputs (p. 57)
Command | Button label varies depending on the selected

control loop input.
Control Each opens a control loop configuration screen. Control Loops (p. 93)
Loops
Motor/ Opens the Motor/Feedback screen. Motor/Feedback (p. 37)
Feedback
Home Configure and test homing. Homing (p. 121)
Regen Opens Regen Settings screen. Regen Resistor Configuration
Settings (p. 181)
Configure | Opens Fault Configuration screen. Faults (p. 68)
Faults
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2.7.4: CAN Information and Status Bar

CAN Information
The Main screen displays the basic CAN information. The example below shows CAN
information:

AN Metwork: Address: 1 State: Pre-operational

The Address field shows the amplifier's present CAN address. For more information, see
CAN Network Configuration (p. 67). When the Position Loop Input is set to CAN, the State
field shows the state of the amplifier’'s CANopen state machine (for more information, see
CANopen Programmer’s Manual).

Status Bar

The status bar describes the present commutation mode, motor type, and amplifier control
status as shown below. It also includes a reminder that pressing the F12 function key
while HDM is running disables the amplifier.

\Sinusoidal Commutation |Rotary Motor Amp Software Disabled  F12ToDisable |
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CHAPTER

3: AMPLIFIER SETUP PROCEDURE

Perform the steps listed below, in the order presented, to set up and tune an
amplifier/motor pair. Details follow in the chapter.

Prepare for setup (p. 26).
Start HDM and enter Basic Setup parameters (p. 26).
Enter Motor/Feedback/Brake Stop parameters (p. 27).

Use Calculate to automatically set initial gains and limits (p. 27).

1
2
3
4
5 Configure digital I/O (p. 27).
6 Configure the command input (p. 27).
7 Configure faults (p. 28).
8 Configure an optional regen resistor (p. 28).
9 Phase and jog the motor (p. 28).
10 Tune the control loops (p. 28).
11 Set gains and limits for stepper mode (stepper only) (p. 28).
12 Configure Homing (p. 28).

13 Test with load attached (p. 29).
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Amplifier Setup Procedure

3.1: Warnings and Notes

HD LLC

NOTE: To immediately software disable the amplifier at any time while running HDM, press
function key F12. Also, the amplifier’s enable input can be used to disable the amplifier.

DANGER

WARNING

DANGER: Hazardous voltages.
Exercise caution when installing and adjusting.

Do not make connections to motor or drive with power applied.

Risk of unexpected or uncontrolled motion with HDM in CAN mode.

HDM can be used while the amplifier is under CAN control. However, some
extreme changes made with HDM could cause unexpected or uncontrolled
motion.

Failure to heed these warnings can cause equipment damage, injury, or
death.

Spinning motor with power off may damage ampilifier.

Do not spin motors with power off. Voltages generated by a motor can
damage an amplifier.

Failure to heed this warning can cause equipment damage.
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3.2: Setup Procedure

1 Prepare for setup
= Understand this procedure’s Warnings and Notes (p. 25).
= Verify that amplifier power is OFF.
= Verify wiring and connections.
= Make sure motor is securely fastened with no load connected.
= Apply power to the amplifier.

For RTL Series amplifiers apply 24V only.
For DDP Series amplifiers apply AUX HV only.

2 Start HDM and enter Basic Setup parameters
|
. # Double-click HDM icon on the Windows desktop to start HDM.

= If necessary, Connect to an Amplifier (p. 17) from the list in the HD Neighborhood tree.

= ‘.ﬁ If the Basic Setup screen does not appear, click the Basic Setup button.

Choose:

In most cases, click Change Settings to Change Basic Setup

o et Settings (p. 32).
M Then proceed to Step 3 of this Setup Procedure,
Enter Motor/Feedback/Brake Stop parameters (p. 27).
To load a .ccx file that was prepared for the amplifier/motor
OR Load ccx File | combination, see Copy Amplifier Data (p. 153). Then proceed to
Step 13 of this Setup Procedure, Test with load attached (p. 29).

Continued...

26 HD LLC



HDM User Guide Amplifier Setup Procedure

...Setup Procedure, continued:

3 Enter Motor/Feedback/Brake Stop parameters
) M Click Motor/Feedback to open the Motor/Feedback screen.
] To optionally load data from an existing motor data file,
see Load Motor/Feedback/Brake Settings from a File (p. 39) and then skip to
Step 4, Use Calculate to automatically set initial gains and limits (p. 24).
OR
] On the Motor tab, modify the appropriate Rotary Motor Setup Parameters (p. 40) or Linear
Motor Setup Parameters (p.41).
] On the Feedback tab, as appropriate for each encoder or resolver, verify the parameters
described in Feedback Parameters, Rotary (p. 42) or
Feedback Parameters, Linear (p. 43).
= If using a brake, click the Brake/Stop tab to verify Brake/Stop Parameters (p. 44).
4 Use Calculate to automatically set initial gains and limits
- T Calculatel
Click Calculate to have the software calculate and display initial loop gains and limits. See
The Calculate Function (p. 46).
= Load the calculated values into amplifier RAM by clicking OK.
5 Configure digital 1/0
u Input # Output
Click Input/Output on the Main screen to open the Input/Output screen.
Verify the I/O settings described in Digital Inputs and Outputs (p. 47).
. On the Input/Output screen, click Close.
6 Configure the command input
= Analog C-ommand | or Funhad C;mmand | or Digital Pos-ition Inputs CAN Con-figuration
Click the appropriate button to configure the amplifier's command input.
For more information see Command Inputs (p. 57).
NOTE: If the amplifier is to run HDVM programs or in Camming mode see the relevant
documents.
= After setting command input parameters, Click Close.
Continued...

HD LLC
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...Setup Procedure, continued:

7

10

11

12

Configure faults

Configure Faults |

Click Configure Faults to open the Fault Configuration screen and set latching faults as
needed. See Faults (p. 68).

Click OK to close the Fault Configuration screen.

Configure an optional regen resistor

Configure Regen

If the amplifier is equipped with a regen resistor, click Regen Settings to open the Regen
Settings screen. See Regen Resistor Configuration (p. 181) for regen resistor
parameters.

Click OK to close the Regen Settings screen.
Phase and jog the motor
Apply AC or HV power.

[a Phase Motor with Auto Phase (p. 76).

To verify Auto Phase results, Phase Motor Manually (p. 86).

Run a move in jog mode (p. 127) to verify that the amplifier can drive the motor.
Tune the control loops

Starting with the Current Loop set up and tune all applicable Control Loops (p. 93).
If you are setting up a linear motor, you can optionally Tune All Loops with Auto Tune
(Linear Motors) (p. 115) instead.

Set gains and limits for stepper mode (stepper only)

If tuning a stepper amplifier in stepper mode:

= Error! Reference source not found. (p. Error! Bookmark not defined.).

= [f using Encoder Correction, Error! Reference source not found. (p. Error!
Bookmark not defined.).

= Error! Reference source not found. (p. Error! Bookmark not defined.).

Configure Homing
Configure Homing (p. 121).

Continued...
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...Setup Procedure, continued:

13 Test with load attached

Iﬂl On the HDM Main screen, click Save to Flash.
] Remove amplifier power.

" Attach load.

] Reconnect amplifier power.

= If necessary, re-tune velocity and position loops.

Iﬂl On the HDM Main screen, click Save to Flash.

ﬂ On the HDM Main screen, click Save to Disk (for backup or duplication).
= The amplifier tuning procedure is complete.

NOTE: To copy the results of this setup to other amplifiers,
see Copy Amplifier Data (p. 153).
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CHAPTER

4: BASIC SETUP

This chapter describes the Basic Setup screen. Perform the basic steps outlined below to
access and enter the Basic Setup options. Details follow in the chapter.

1
Iﬁ Click to open the Basic Setup screen.

2 ]
Sekkings
hotor Farmily: Brushless
hotor Type: Linear
Hall Type: Analog
Hall Fhase Correction: on

lIze Halls for velocityPosition:  Of
LIse Back EMF for Yelocity: Off

Motor Encoder: Lowe Freguency Analog

Multi-mode Encoder Port: Buffered Motor Encoder
Cperating Mode: Fosition, Analog Input
Change Settings | Load cex File ServoTube Setup Cancel

Review settings.

Choose:

e St If necessary, click Change Settings to
M Change Basic Setup Settings (p. 32).

OR Load eox File | If you.ha\_/e a.ccx file that was prepared for the ampl_ifjer/motor
combination, click Load ccx File and see Copy Amplifier Data (p. 153).

OR - To change Basic Setup settings for a ServoTube motor, click
_Seatdesp | ServoTube Setup.

OR Cancel | To accept the displayed settings, click Cancel.
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4.1: Change Basic Setup Settings

1 chang=setings | On the Basic Setup screen, click Change Settings to start the Basic
Setup wizard. Use the Back and Next buttons to navigate screens.
Screen details vary depending on amplifier model and mode selection.

2 SetMotor Options (p. 33). x

Motor Options

Miokar Family:
{* Brushless { Brush

Motor Type:
* Rotary Linear

[ =Back | mext > | Cancel |

3 SetFeedback Options (p. 34) x

Feedback Options

Hall Types: IDigitaI - I

[¥ Hall Fhase Correction

Mokar Encoder: IPrimar\; Incremental ;l

Position Encader: ISecondary Incremental LI

Position Encoder Type:
f* Rotary & Linear

[~ Use Position Encoder In Passive (Manitor) Mode

<Back || Hext= Y Cancel

Continued...
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...Change Basic Setup Settings, continued:

4  Set Operating Mode Options (p. 35). x|
Operating Mode Options
COperating Mode: IPDSitiDn VI
Command Source! I vI

Digital Input Source
% High Speed Inputs
(= Multi-mede Fort

< Back | Mext = | Cancel |

Basic Setup

5 Set Miscellaneous Options (p. 35). x|

Miscellaneous Options

Commutation Mode:

% Sinusoidal 7 Trapezoidal ¢ Estimated Sinusoidal

£ Use Biack EMF For Yelocity
" Use Halls Far Yelosity,

Multi-mode Part: |Differential Input LI

<Back ||i Finish il  Cancel

6 When satisfied with the settings, click Finish on the final screen.

4.2: Motor Options

View or change the settings described below. Options vary with amplifier model.
Setting Description
Motor Family Select motor family: Brushless, Brush, or Three Phase Stepper.

(Three Phase Stepper configures the amplifier to operate as an open-
loop stepper drive for three-phase stepper motors.)

Motor Type Select motor type: Rotary or Linear.

HD LLC
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4.3: Feedback Options

View or change the settings described below. Options vary with amplifier model.

34
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Setting Description

Hall Type Select Hall type: None, Digital, or Analog (Analog is used with ServoTube
motors).

Hall Phase If selected, will enable error checking between Hall switches and

Correction encoder based phase angle. See Faults (p. 68).

Motor Encoder

Select type and source of motor feedback.
¢ None: No motor encoder.

e Primary Incremental: Incremental encoder on primary feedback
connector.

e Secondary Incremental: Incremental encoder on multi-mode port.
¢ Analog: Analog encoder on primary feedback connector.

e Low Frequency Analog: ServoTube motor on primary feedback
connector.

¢ Resolver (Resolver version only): Resolver on primary feedback
connector.

Additional encoder types are supported by certain HD LLC amplifier
models. See the amplifier data sheet for more information.

Position Encoder

Select type and source of Position (load) feedback.
¢ None: No position encoder

e Primary Incremental: Incremental encoder on primary feedback
connector.

e Secondary Incremental: Incremental encoder on multi-mode Port.
e Analog: Analog encoder on primary feedback connector.

Position Encoder
Type

Select the type of Position (load) encoder:
e Rotary.
e Linear.

Use Position
Encoder in
Passive (Monitor)
Mode

When this is checked, the position of the position encoder will be
reported by the passive load position variable but it will not be used to
control the position of the axis.

Stepper Amplifiers Only

Motor Encoder

Select the encoder type:
e None

e Primary incremental

Run in Servo (With encoder only.) Amplifier operates as a true, closed loop, servo
Mode amplifier controlling a stepper motor.

Enable Encoder (With encoder only.) Amplifier runs as a stepper drive; encoder feedback
Correction is used to correct positional errors. See Error! Reference source not

found. (p. Error! Bookmark not defined.).

For more information see Motor/Feedback (p. 37).
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Basic Setup

4.4: Operating Mode Options

View or change the settings described below. Options vary with amplifier model.

Setting

Description

Operating Mode

Choose the mode of operation: Current, Velocity, or Position.
See Servo Operating Modes and Control Loops (p. 10).

Command Source

Choose the command input source:

¢ Analog Command: Analog voltage provides command input.
See Command Inputs (p. 57).

¢ PWM command (current and velocity mode only): Digital pulse-width
modulated signal provides command input.
See Command Inputs (p. 57).

e Function Generator: Internal function generator provides command
input.

e Software Programmed: The amplifier is controlled by software
commands from either the HD LLC Virtual Machine (HDVM) or an
external source. See HD LLC Indexer Program User’s Guide or the HD
LLC ASCII Interface Programmer’s Guide.

¢ Camming: Runs in Camming Mode. See HD LLC Camming User Guide.

¢ Digital Input: Command input is provided via the chosen Input Source
(below). See Digital Position Input Settings (p. 62).

e CAN: Command input is provided over the CANopen network. See the
CANopen Programmer’s Guide.

Input Source

Choose the input source for PWM or Digital input commands:

¢ Single-ended Inputs: Command input is provided via two of the
amplifier's programmable digital inputs.

e Multi-mode Port: Command input is provided via differential inputs on
the amplifier's multi-mode port.

¢ Differential Inputs: Command is provided via differential inputs.

¢ High Speed Inputs. Command is provided via two of the amplifier's high
speed inputs.

4.5: Miscellaneous Options

View or change the settings described below. Options vary with amplifier model.

HD LLC

Setting

Description

Commutation

Commutation method: Sinusoidal, Trapezoidal, or Estimated Sinusoidal.

Use back EMF for
Velocity

If selected, will use the motor's measured back EMF to determine motor
velocity. Recommended only for medium- to high-speed. Accuracy
depends on the accuracy of the programmed Back EMF value, and may
be affected by factors such as cable resistance.

Use Halls for
Velocity and
Position

If selected, will use transitions of the Hall switches to determine motor
velocity and position. Recommended only for medium- to high-speed
applications (may run roughly at low speeds).

Multi-mode Port

Selects the mode for the amplifier’'s multi-mode port:

e Buffered Motor Encoder. The multi-mode port functions as a buffered
digital encoder output based on the digital encoder input.

e Emulated Motor Encoder. The multi-mode port functions as an
emulated digital encoder output based on the motor analog encoder or
motor resolver.

e Emulated Position Encoder. The multi-mode port functions as an
emulated digital encoder output based on the position analog encoder.

o Differential Input. The multi-mode port functions as a differential
command input.
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CHAPTER

5: MOTOR/FEEDBACK

This chapter describes motor, feedback, and brake parameters, and the Calculate function.
Access these features as described below. Details follow in the chapter.

' ""_|°t°”md'°°"'°k Click Motor/Feedback to open the Motor/Feedback screen.

2
ﬂ Load Motor/Feedback/Brake Settings from a File (p. 39).

2 Enter settings manually:

" hotar |

Click the Motor tab to view or change Rotary Motor Setup Parameters (p. 40)
or Linear Motor Setup Parameters (p. 41 ).

" Feedback I

Click the Feedback tab to view or change Feedback Parameters, Rotary (p.42) or
Feedback Parameters, Linear (p. 43). Read the Feedback Notes (p. 44) for important
related information.

" Erake\Stop |

Click the Brake/Stop tab to view or change Brake/Stop Parameters (p. 45). Read the
Brake/Stop Notes (p. 45) for important related information.

M Use The Calculate Function (p. 46) to calculate initial gains and limits.

Iﬂl On the Main screen, click Save to Flash to avoid losing the changes.
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5.1: Motor/Feedback Screen Overview

HDM User Guide

A typical Motor/Feedback screen is shown below. Parameters vary with amplifier model.

Motor /Feedback - Rotary Motor

hiator ] Feedback] Brake\Stop ]

Manufacturer:

Madel Mumber:

fdatar Inertia:

opey

Units

|cEL341FE-001

011976 fkgom® <]

Murmbeer of Poles: 4

Tarcue Conztant:

% Metric {7 English ‘

| 04401 [rmipk

Back emf Constant:

o ———

Peak Torgue: | 14 67 |Wkrpm j
| 12545 |um 7| Resistance:
227 ahi
Continuous Torgue: L
| oesss w7 Incluctance:
223 mH
elocity Limit:
G4 rpm
F-T TS T TS T T T TS s s s s E s S l
' '
i Iﬂ| ﬂ‘ E:H‘ ﬁ‘ i ﬁ Calculate Ol ‘ Cancel
'

T

Motor Data Controls

*

Calculate Function

Choose default units for screen.

Choose specific units for field.

The Calculate function is described in The Calculate Function (p. 46).

Data on the Motor/Feedback screen can be saved to and restored from disk files using the
controls described below.

Icon

Name

Description

Save motor data to
disk

Saves motor/feedback/brake settings from PC to a disk file with
.ccm name extension.

Restore motor data
from disk

Restores contents of a .ccm file from disk to PC.

Save motor data to
flash

Saves motor/feedback/brake settings from PC to amplifier
permanent flash memory.

L

Restore motor data
from flash

PC.

Restores motor/feedback/brake settings from flash memory to the

For more information see Data, Firmware, and Logs (p. 143).
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5.2: Load Motor/Feedback/Brake Settings from a File

HD LLC

If needed, download the motor data file from the HD LLC website:

In an internet browser, navigate to http://www.harmonicdrive.net/support/hdm-
downloads/

Click on the appropriate motor name.

When prompted, save the file to the MotorData folder in the HDM installation folder.
(The default installation folder is

C:\Program Files\HD LLC Motion\HDM\MotorData.)

Extract the contents of the zip file to the same location.

The folder should now contain the new motor data file (with a .ccm filename
extension).

If desired, delete the .zip file to save disk space.

Load the motor data into the ampilifier:

'—Immmedmk Click Motor/Feedback to open the Motor/Feedback screen.

On the Motor/Feedback screen, click Restore Motor Data from Disk.
When prompted, navigate to the folder containing the file,
then click on the file name, and then click Open.

Calculat i . o
S| CaleUla El Calculate initial gains and limits with

The Calculate Function (p. 46).

Iﬂl On the Main screen, click Save to Flash to avoid losing the changes.
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5.3: Rotary Motor Setup Parameters

View or change the settings described below. Options vary with amplifier model. Metric
units are shown here.

40

Setting Description

Manufacturer Motor manufacturer's name. Saved for reference in the motor data file.

Model Number Motor model number. Saved for reference in the motor data file.

Units Selects whether the parameters entered in this screen are in Metric or English units.

Motor Inertia

The rotor inertia of the motor. Used for calculating initial velocity loop tuning values.
Range: 0.00001 to 4,294 kg cm?. Default: 0.00001 kg-cm?

Number of Poles

(Brushless only.) The number of magnetic poles in the motor. Required for correct
commutation of the motor. If the number of poles is not known,
Verify the motor’s pole count (p. 91). Range: 2 to 200. Default: 4.

Peak Torque

The peak torque that the motor can produce. Peak Torque divided by torque
constant = motor’s peak current limit. Range: 0.001 to 2,100 Nm. Default: 0.0001
Nm.

Continuous The continuous torque that the motor can produce. Used with the torque constant to
Torque calculate continuous current. Range: 0.001 to 1,000 Nm. Default: 0.0001 Nm.
Velocity Limit Maximum speed of the motor. Used to calculate the velocity and acceleration limits

for the velocity loop. Range dependent on encoder resolution.

Torque Constant

Relates the motor's input current to torque produced. Sometimes abbreviated as Kt.
Range: 0.001 to 1,000 Nm/Apk. Default: 0.001 Nm/Apk.

Back emf Relates the motor's input voltage to speed. Sometimes abbreviated as Ke. Used for
Constant calculating the maximum velocity for a given amplifier bus voltage.
Range: 0.01 to 21,000,000 V/Krpm. Default: 0.01 V/Krpm.
Resistance Motor resistance line-to-line. Used for calculating the initial current loop tuning
values.
Range: 0.01 to 327 Q. Default: 0.01 Q.
Inductance Motor inductance line-to-line. Used for calculating the initial current loop tuning

values.
Range: see the hardware documentation.

Stepper Amplifiers Only

Rated Torque

Motor’s rated operating torque. Min: .001. Max: 1000.

Rated Current

Motor’s rated continuous current. Min: 0.001. Max: 1000.

Basic Step Angle

Fundamental stepper motor step, in degrees. Min: 0.225. Max: 22.5. Default 1.8.

Microsteps/Rev

Number of microsteps per revolution of the motor.
Min: 4. Max: 100,000,000. Default 4000.

Full Steps/Rev

This read-only value can be used after entering Basic Step Angle to cross-check
against motor data sheet.
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Motor/Feedback

5.4: Linear Motor Setup Parameters

View or change the settings described below. Options vary with amplifier model. Metric
units are shown here.

HD LLC

Setting

Description

Manufacturer

Motor maker’'s name. Saved in the motor data file. Choose from list or enter
manually.

Model Number

Motor model number. Saved in the motor data file. Choose from list or enter
manually.

Units Selects whether the parameters entered in this screen are in Metric or English units.

Mass The mass of the motor. Used for calculating initial velocity loop tuning values.
Range: .0001 Kg to 100,000 Kg. Default: .0001 Kg.

Peak Force The peak force that the motor can produce. Peak Force divided by Force Constant =

motor’s peak current limit. Range: 0.00001 to 2,000 N. Default: 0.00001 N.

Continuous Force

The continuous force that the motor can produce. Used with the force constant to
calculate continuous current. Range: 0.00001 to 1,000 N. Default: 0.00001 N.

Velocity Limit

Maximum speed of the motor. Used to calculate the velocity and acceleration limits
for the velocity loop. Range dependent on encoder resolution.

Force Constant

Relates the motor's input current to force produced. Sometimes abbreviated as Kf.
Range: 0.00001 to 2,000 N/Amp. Default: 0.00001 N/Amp.

Back emf Relates the motor's input voltage to speed. Sometimes abbreviated as Ke. Used for

Constant calculating maximum velocity for a given amplifier voltage. Range: 0.01 to 1,000
V/M/Sec. Default: 0.01 V/M/Sec.

Resistance Motor resistance line to line. Used for calculating the initial current loop tuning
values. Range: 0.01 to 327 Q. Default: 0.01 Q.

Inductance Motor inductance line to line. Used for calculating the initial current loop tuning

values. Range: see the hardware documentation.

Magnetic Pole
Pair Length

The length of a pair of magnets which equals the distance moved in one electrical
cycle of the motor.

Stepper Amplifiers Only

Rated Force

Motor’s rated operating force. Min .001 N. Max 1000 N.

Rated Current

Motor’s rated continuous current. Min: 0.01 A. Max 1000 A.

Full Step Fundamental stepper motor step distance. Min: 0.0001mm. Max: 5000 mm.
Microsteps/ Number of microsteps per full step. Min: 1. Max: 100,000,000.
Full Step
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5.5: Feedback Parameters, Rotary

As appropriate for each encoder or resolver, enter the parameters described here.
Options vary with amplifier model.

42

Feedback
Type

Parameters/Actions

Incremental

In the Motor Encoder lines or Position Encoder lines field, enter the number of encoder
lines (see encoder or motor data sheet). As indicated by the counts field, the number of
encoder counts per revolution is equal to 4 x the number of lines.

I 1000 lines = I 4000  counts

Analog

In Fundamental Lines, enter the number of fundamental encoder lines (see encoder or
motor data sheet). As indicated by the Fundamental Counts field, the number of
fundamental encoder counts per revolution is equal to 4 x the number of Fundamental
Lines.

Optionally modify the encoder resolution by changing the Interpolation value. The
interpolated resolution (Interpolated Counts Per Rev) is the product of Fundamental
Counts value and the Interpolation value.

Fundamertal Lines I 1000 = 4000 Fundiamental Counts

Interpolation |1 W I

Interpolated Courts Per Rewy. 4000

Resolver

Optionally modify the feedback resolution by changing the value in Counts Per Rev.
Default: 16384.

Resalver
’V I 4000 Courts Per Rev

Halls

With amplifier set to Use Halls for Velocity/Position, optionally increase the counts per
rev ratio by incrementing the Halls Count Multiplier.

Hall Court hultiplier: |1 W I

Courts per Rew 12

Defautt |

If two feedback devices are installed, verify that the values of Motor Turns to Position
Turns correctly represent the ratio of motor encoder turns to position encoder turns. The
details of the following screen may vary depending on the types of feedback devices

present.
Ratio
fdatar Turns

Positon Turns

—
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Motor/Feedback

5.6: Feedback Parameters, Linear

As appropriate for each encoder installed, enter the parameters described below. Options
vary with amplifier model.

HD LLC

Feedback | Parameters/Actions
Type
Incremental | Choose units and then enter the Encoder Resolution (see encoder or motor data sheet).
Encoder Resolution: I 1a] omm % um O onm
Analog Enter the Fundamental Pitch (distance between encoder lines; see encoder or motor data
sheet). As indicated by the Fundamental Resolution field, Fundamental Pitch divided by
four gives Fundamental Resolution. The interpolated resolution is the dividend of
Fundamental Resolution value/Interpolation value. Optionally modify the Interpolated
Resolution by changing the Interpolation value.
Fundatnental Pitch I 4 UM = 4 um EL;r;cémg;ﬁal
Interpolation I'l S l
Interpolated Resolution 1 um
Low (Normally used with Copley ServoTube) Pole Pitch is the distance between poles in a poll
Frequency pair, as entered in the Magnetic Pole Pair Length field on the Motor tab. The interpolated
Analog resolution is the dividend of Pole Pitch/Counts per pole value, expressed in micrometers.
Optionally modify the resolution by changing the Counts/Pole value. Click Restore
Default to restore default Counts/Pole.
Pale Pitch 512 tmtn
Counts/Pale I 4000 Restare Default |
Interpolated Resolution 1248 urm
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5.7: Feedback Notes
5.7.1: Encoder and Resolver Support

Some HD LLC amplifiers are offered in multiple versions to support different types of
encoder or resolver feedback. Some encoder versions support digital quadrature
encoders, some support analog sin/cos encoders, and others support both. Encoder
versions normally require Hall switches for the commutation of brushless motors. The
resolver versions support standard, single speed, transmit-type resolvers.

5.7.2: Dual Feedback Amplifiers

Some HD LLC amplifiers can receive position feedback from sensors on the motor, the
load, or both, through the Primary Feedback channel, a Secondary Feedback channel

(multi-mode port) or both. (Some amplifiers can also operate in certain modes without
encoders or resolvers.)

When the amplifier is configured with a multi-mode port (see Feedback Options, p. 34) the
multi-mode port can:

e Provide a buffered digital encoder output based on the digital encoder input.
¢ Provide an emulated digital encoder output based on the analog encoder or resolver
input.

e Provide a second digital encoder input to be used in the dual encoder position mode. In
this mode, an encoder attached to the load provides position loop feedback, and the
motor encoder or resolver provides velocity loop feedback.

A dual-feedback setup is shown below. The amplifier receives feedback from an
incremental motor encoder through the Primary feedback channel. Position (load) encoder
feedback comes through the multi-mode port. The ratio of motor turns to position encoder
turns is 1 to 10.

Motor,/Feedback - Rotary Motor 5[

Maotor  Feedback I |

I 1000 lines = I 4000 counts

"Mutor Primary Incremertal

Position Secondary Incremental

I 1000 lings = I 4000 counts

Fatio

Mator Turns I 1
Positon Turns I 1D|

Ok Cancel

g - e B
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5.8: Brake/Stop Parameters

Enter the following parameters as appropriate.

Parameter Description
Brake/Stop Delay Time Range of accepted values: 0 to 10,000 mSec

Brake Activation Range of accepted values: 0 to 183,105 rpm (mm/s for linear motor)
Velocity

PWM Delay Brake/Stop Range of accepted values: 0 to 10,000 mSec
Response Time

5.9: Brake/Stop Notes

Many control systems employ a brake to hold the axis when the amplifier is disabled. On
brake-equipped systems, disabling the amplifier by a hardware or software command
starts the following sequence of events.

e The motor begins to decelerate (at Abort Deceleration rate in position mode or Fast
Stop Ramp rate in velocity mode). At the same time, the Brake/Stop Delay Time count
begins. This allows the amplifier to slow the motor before applying the brake.

o When the motor slows to Brake/Stop Activation Velocity OR the Brake/Stop Delay
Time expires, the brake output activates and PWM Delay Brake/Stop Response Time
count begins.

o When response time has passed, the amplifier's output stages are disabled. This delay
ensures the brake has time to lock in before disabling the power section.

Enable Impt —_— Brake!Stop delay time

Speed
Brakef=top activation welocity

Brake Ouptput

Enahle b T e T
Powver Section

BrakeiStop response time

This sequence is not available in the current mode of operation. Instead, in current mode,
the amplifier output turns off and the brake output activates immediately when the disable
command is received.
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5.10: The Calculate Function

The Calculate function uses programmed motor and encoder values to calculate initial
gains and limits. These can be modified to fine-tune the amplifier. Follow the steps below:

1 =8| Calculat
{ots| Calculate Click Calculate to calculate and display the settings.

x|

Current Loop Cp Gain 15349 |
Current Loop Ci Gain: a3
Feak Current Limit: 13.95 A
Continuous Current Limit: 468 A
[FT Time Limit: 1000 e
Yelocity Loop Wp Gain: 1332
Yelocity Loop Vi Gain: 29458
YVelocity Loop Welocity Lirmit: 3000 rpm =
Yelocity Loop Accel., Decel, Fast Stop: 1000 rps®
Yelocity Tracking Window G600 rpm
Welacity Tracking Time: 100 ms
Position Loop Proportional Gain Pp 1000
Positon Loop Yelocity Feedforward Wi 16384
Position Loop Following Errar: 4000 Coun

Rl | _>I_I

Cancel

2 Verify the peak current limit, continuous current limit, and velocity loop velocity limit.
If one or more of these values seems inappropriate, click Cancel and check: Peak Torque
(or Force), Continuous Torque (or Force), Velocity Limit, and Torque (or Force) Constant.
Correct them if needed. See Rotary Motor Setup Parameters (p. 40)
or Linear Motor Setup Parameters (p. 41).

If the Motor/Feedback values were correct but the peak current limit, continuous current
limit, or velocity loop velocity limit values are not optimal for the application, change these
limits during the tuning process.

3 Load the values into amplifier RAM by clicking OK.
NOTE: When loading motor data from a file, if the motor wiring configuration in the motor
file does not match the configuration currently stored in the amplifier, HDM prompts for
verification on which configuration to use. Select the file configuration by clicking Yes.
The configuration will be tested as part of Motor Phasing (p. 75).

k|
On the Main screen, click Save to Flash to avoid losing the changes.
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CHAPTER

6: DIGITAL INPUTS AND OUTPUTS

This chapter shows how to configure the amplifier’s digital inputs and outputs. Perform the
steps outlined below. Details follow in the chapter.

" D]
Click Input/Output to open the Input/Output screen.

As needed, set Digital Inputs (p. 48).

As needed, set Digital Outputs (p. 50).

Click Close to close screen and save changes to amplifier RAM.

a b~ ODN

Iﬂl On the Main screen, click Save to Flash to avoid losing the changes.
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6.1: Digital Inputs

6.1.1: Digital Inputs Screen Overview
A typical Input/Output screen is shown below. (Features vary with amplifier model and
configuration.)

Red light: inhibited motion or active input, depending on input function.
Grey light: motion not inhibited.
No light: not configured.

Lo/Hi: Indicates state of input.
1o ]

Digital Inputs 1-5 ] Digital Inputs 6-12 | Digital Outputs |

Debounce time CAM address
[IN1] |Amp Enable-LC Enables With Clear Faults - 0 ms Lo
* Pull up +5% | J |
" Pull dowen [IN2] |N0t Configured j | o ms Lo BITO
[IN3] |Nnt Configured ﬂ | 0 ms Lo BIT 1
& Pull up +5¥ [IN4] |Nnt Configured ﬂ | 0 ms Hi BIT 2
(‘Rgull dowin 1 B ot Configured ms  Hi BIT 3
I Restore Defaulks Close
Indicates input is used as a CAN address bit.
Hold position setting
Parameter Description
Pull up +5V Pulls up the group of inputs up to internal +5 V.
Pull down Pulls the group of inputs down to internal signal ground.

the state. Increase to prevent multiple triggering caused by switch bounce upon switch
closures. Range: 0 to 10,000 mSec.

Quadrature control inputs.

Debounce Time | Specifies how long an input must remain stable at a new state before the amplifier recognizes

Debounce does not affect inputs that have been configured as PWM, Pulse and Direction, or

IN1-IN12 Select the function for the input. See Digital Input Functions (p. 49) for input function
descriptions.

*Hold position
when limit
switch is active

Available in position mode when one or more inputs are configured as a limit switch (NEG Limit-
HI Inhibits, NEG Limit-LO Inhibits, POS Limit-HI Inhibits, or POS Limit-LO Inhibits). The *Hold
position option prevents any motion while a limit switch is active. This option uses the Abort
Deceleration rate to stop the motor as described in Trajectory Limits (p. 113).

CAUTION: If the amplifier is switched back to current or velocity mode with this option
selected, the limit switches will no longer function.

Restore Defaults restores all inputs and outputs to factory defaults. Close button closes the screen.
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6.1.2: Digital Input Functions

6.1.3:

HD LLC

Digital Inputs and Outputs

The programmable digital input functions are described below.

Input Function

Description

LO Enables with reset

AMP Enable- A low input will enable the amplifier.

LO Enables with clear faults Any transition will clear latched faults and outputs.
AMP Enable- A high input will enable the amplifier.

HI Enables with clear faults Any transition will clear latched faults and outputs.
AMP Enable- A low input will enable the amplifier.

A low to high transition will reset the amplifier.

AMP Enable-
HI Enables with reset

A high input will enable the amplifier.
A high to low transition will reset the amplifier.

AMP Enable-LO Enables

A low input will enable the amplifier.

AMP Enable-HI Enables

A high input will enable the amplifier.

Not Configured

No function assigned to the input.

NEG Limit-HI Inhibits*

A high input will inhibit motion in negative direction.

NEG Limit-LO Inhibits*

A low input will inhibit motion in negative direction.

POS Limit-HI Inhibits*

A high input will inhibit motion in positive direction.

POS Limit-LO Inhibits*

A low input will inhibit motion in positive direction.

Reset on LO-HI Transition

A low to high transition of the input will reset the amplifier.

Reset on HI-LO Transition

A high to low transition of the input will reset the amplifier.

Motor Temp HI Disables

A high input will generate a Motor Over Temperature fault.

Motor Temp LO Disables

A low input will generate a Motor Over Temperature fault.

Home Switch Active HI

A high input indicates the home switch is activated.

Home Switch Active LO

A low input indicates the home switch is activated.

Motion Abort Active HI

A high input causes the amplifier to stop motion, using the Abort
Deceleration rate described in Trajectory Limits (p. 113). The
amplifier remains enabled.

Motion Abort Active LO

A low input causes the amplifier to stop motion, using the Abort
Deceleration rate described in Trajectory Limits (p. 113). The
amplifier remains enabled.

Hi Res Analog Divide Active HI

A high input causes the firmware to divide the level of the analog
input signal by 8.

Hi Res Analog Divide Active LO

A low input causes the firmware to divide the level of the analog
input signal by 8.

High Speed Position Capture on
LO-HI Transition

Position will be captured on the low to high transition of the input.

High Speed Position Capture on
HI-LO Transition

Position will be captured on the high to low transition of the input.

PWM Sync Input

PWM synchronization input. See Synchronizing PWM Switching
Frequency (p. 56). (For high-speed inputs only.)

Standard Input Function Assignments

Enable Input: On most HD LLC ampilifiers, IN1 is dedicated to the enable function. Accelus
uses IN2 for the enable function.

Other inputs can be programmed as additional enables. If there is more than one input
programmed as an enable then all the inputs must be in the enabled state before the
amplifier PWM output stage will be enabled.

Motor Over Temperature: On most HD LLC amplifiers, IN5 is located on the motor
feedback connector and is intended to be used for Motor Over Temperature. Other: Other
inputs may have predefined functions depending on mode of operation.
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6.2: Digital Outputs

6.2.1: Screen Overview
A typical Digital Outputs screen is shown below. Options vary with amplifier.

JRIaTEY
* Hi/Lo state of output

Digital Inpuks 1—5] Digital Inputs &-12  Digital Cutputs ]

Grey light:
Output is not active

[out1] |EEETE Lo -

[OUT2] [mot Configured R
[OUT3] [Not Configured =l oH
[OUT4] [Brake-Active High = H e - Red light:

Output is active

I Restare Defaults Clase

Parameter Description

Configure Custom Opens screen to display custom digital output settings.
Available only when function is set to Custom.

Restore Defaults Restores all inputs and outputs to factory defaults.

Close Closes screen and saves changes to amplifier RAM.

6.2.2: Standard Output Functions

The standard output functions are described below. Custom output functions follow.

Output Function Description

Not Configured No function. Output remains high.

Fault Active High Output goes high when one or more faults are detected.
See Faults (p. 68).

Fault-Active Low Output goes low when one or more faults are detected.

Brake-Active High Output goes high to activate the brake.

See Brake/Stop Parameters (p. 45).

Brake-Active Low Output goes low to activate the brake.
See Brake/Stop Parameters (p. 45).

PWM Sync Output (OUT1 The PWM synchronization output.
only) See Synchronizing PWM Switching Frequency (p. 56).

Custom Event See Custom Digital Output Settings: Custom Event (p. 51).

Custom Trajectory Status See Custom Digital Output Settings: Custom Trajectory Status (p. 54).

Custom Position Triggered See Custom Output Settings: Position Triggered Output (p. 55).
Output

Program Control Active High | Output state controlled by HDVM or external program.

Program Control Active Low | Output state controlled by HDVM or external program
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6.2.3: Custom Digital Output Settings: Custom Event

Any of the amplifier’s digital outputs can be programmed to respond to a combination of
events including faults, warnings, and status indications. The output goes active when one
or more of the selected events take place.

Configure a Custom Event output

[OUT2] |[eEd Nl Hi

Configure Custom |

Choose Custom Event for an output and then click Configure Custom to open the

Event Configuration screen.

x|
I~ amplifier Fault
[T Amp Over Temperature [ Latch Qutput
[~ Makar Phasing Erear

[~ Feedback Error Clear |

[~ Maokar Over Temp

™ Under valkage
[ Cwver voltage
[~ shart Circuit
[~ Current Limited

[~ wolkage Limited -
4 | L|_I

= Qutput Active High % Cukput Active Low

Cancel | Help |

2 Select one or more Custom Event Functions (p. 52).
Multiple functions are OR’ed together, so any event activates the output.

3 Choose Output Active High to have the output go high when active or Output Active Low
to have the output go low when active.

4 To latch the output, set the Latch Output option.
The Clear button clears all check marks.

Latching an output does not eliminate the risk of unexpected motion with
non-latched faults.

Associating a fault with a latched, custom-configured output does not latch

the fault itself. After the cause of a non-latched fault is corrected, the

amplifier re-enables without operator intervention. In this case, motion may re-
DANGER start unexpectedly.

Failure to heed this warning can cause equipment damage, injury, or death.

5 Click OK to save changes to amplifier RAM and close the screen.

HD LLC 51



Digital Inputs and Outputs

Custom Event Functions

HDM User Guide

Select any combination of events to configure a custom event output:

Event

Description

Amplifier Fault

A latched fault is active.

Amp Over Temperature

Motor Phasing Error

Feedback Error

Motor Over Temperature

Under Voltage

Over Voltage

Short Circuit

For descriptions of these fault events, see
Fault Configuration Parameters (p. 69).

Current Limited

The current output is being limited by the I°T algorithm or a latched
current fault has occurred. See Limits (p. 100.)

Voltage Limited

Current loop is commanding the full bus voltage in an attempt to control
current. Commonly occurs when the motor is running as fast as the
available bus voltage will allow.

Positive Limit Switch

Axis has contacted positive limit switch.

Negative Limit Switch

Axis has contacted negative limit switch.

Amp Disabled by Hardware

Amplifier enable input(s) is not active.

Amp Disabled by Software

Amplifier is disabled by a software command.

Attempting to Stop Motor

The amplifier, while in velocity or position mode, has been disabled.

In velocity mode, amplifier is using the Fast Stop Ramp described in
Velocity Loop Limits (p. 104). In position mode, the amplifier is using the
Abort Deceleration rate described in Trajectory Limits (p. 113).

The output remains active until the amplifier is re-enabled.

Motor Brake Active

Motor brake activated. See Brake/Stop Notes (p. 45).

PWM Outputs Disabled

The amplifier's PWM outputs are disabled.

Positive Software Limit

Actual position has exceeded the positive software limit setting.
See Homing (p. 121).

Negative Software Limit

Actual position has exceeded the negative software limit setting.
See Homing (p. 121).

Following Error

Following error has reached programmed fault limit.
See Following Error Fault Details (p. 72).

Following Warning

Following error has reached programmed warning limit.
See Following Error Fault Details (p. 72).

Position has Wrapped

The position counters have exceeded the maximum range of
-2% — 2%.1 and have wrapped. Normal amplifier operation is not affected.

Velocity Limited

The velocity command (from analog input, PWM input, or position loop)
has exceeded the velocity limit. See Velocity Loop Limits (p. 104).

Acceleration Limited

In velocity mode, motor has reached an acceleration or deceleration limit
that was set as described in Velocity Loop Limits (p. 104).

Pos Outside of Tracking
Window

The following error has exceeded the programmed value.
See Tracking Window Details (p. 73).

Home Switch Active

Axis has contacted the home limit switch.

In Motion

The motor is moving, or it has not yet settled after a move. The amplifier
is settled when it comes within the position tracking window and stays
there for the tracking time at the end of a move. Once this bit is set, it
remains set until a new move is started.

Vel Outside of Tracking
Window

Difference between target and actual velocity has exceeded the window.
See Tracking Window Details (p. 73).

Phase not Initialized

Amplifier is using Phase Initialization function and phase is not
initialized.

Command Input Fault

See Fault Configuration Parameters (p. 69).
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Digital Inputs and Outputs

Non-Latched vs. Latched Custom Event Digital Outputs

or

or

Like an amplifier fault, a custom-configured output can be non-latched or latched.

If a non-latched, custom-configured digital output goes active, it goes inactive as soon as
the last of the selected events is cleared.

If a latched output goes active, it remains active until at least one of the following actions
has been taken:

Power-cycle the amplifier

Cycle (disable and then enable) an enable input that is configured as
Enables with Clear Faults or Enables with Reset.

ﬁ Access the HDM Control Panel and press Clear Faults or Reset.

Custom Event Output Fault Handling vs. Overall Fault Handling
A fault on an output programmed for Custom Event is separate from a fault on the amplifier.
For instance, suppose:

o OUT3 has a Custom Event configuration. Only the Under Voltage fault condition is

selected, and the output is latched.

e Under Voltage is not latched on the Configure Faults screen.

An under voltage condition occurs, and the amplifier goes into fault condition, output stages
are disabled, and faults are reported. At the same time, OUT3 goes active.

The under voltage condition is corrected, and:

e The amplifier fault is cleared. Output stages are enabled.

e OUT3 remains active.
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6.2.4: Custom Digital Output Settings: Custom Trajectory Status

Any of the amplifier’s digital outputs can be programmed to respond to a combination of
amplifier trajectory status conditions. The output goes active when one or more of the
conditions is met.

Configure a Custom Trajectory Status output

L0110} bed B " istom Trajectory Status Hi

Configure Custom |

Choose Custom Trajectory Status for an output and then click Configure Custom
to open the Trajectory Status Configuration screen.
B x|

[~ Homing Error

[ Referenced (Homed)

[~ Homing In Progress

[ Move Abarted

[~ Trajeckory Generatar RURRing

[~ Camming Buffer Error

= Qutput Active High ¢ Cutput Active Low

Cancel |

2 Select one or more trajectory status conditions described below.
Multiple functions are OR’ed together, so any status match activates the output.

Trajectory Status Functions
Status Description
Homing Error Activate output if an error occurred in the last homing attempt.

Referenced Activate output if the most recent homing attempt was successful.
(Homed)

Homing in Activate output when a homing move is in progress.

Progress

Move Aborted | Activate output if move is aborted.

Trajectory Activate output while trajectory generator is generating a move.
Generator

Running

Camming A camming buffer error has occurred.

Buffer Error

3 Choose Output Active High to have the output go high when active or Output Active Low
to have the output go low when active.

4 Click OK to save changes to amplifier RAM and close the screen.
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6.2.5: Custom Output Settings: Position Triggered Output

Any of the amplifier’s digital outputs can be programmed to respond in certain ways to the
position of the controlled axis. The output goes active when the axis position meets the
specified criteria.

Configure a Position Triggered output

Lo 0] (" uistom Position Triggered Qutput Hi

Configure Custom |

Choose Custom Position Triggered Output for an output and then click Configure
Custom to open the In Position Configuration screen.

Position Triggered Dutpuk ﬂ

Configuration
¢ In Position Window
™ Trigger At Pasition
" Trigoer Paositive Makion
" Trigoer Megative Mation

 Qukput Ackive High % Oukpuk Ackive Low

Upper Position: I 0 counks
Lower Positian: I 0 counts

% Use Actual Position
(= Use Limited Position

Cancel |

2 Select one of the configurations described below and enter appropriate values for the
parameters.

Configuration | Description and Parameters

In Position Activates the output while the axis is in the window between the programmed Upper
Window and Lower positions.

Trigger at Activates the output for the programmed Time when the axis travels through the
Position programmed Position.

Trigger Positive | Activates the output for the programmed Time when the axis travels in the positive
Motion direction through the programmed Position.

Trigger Activates the output for the programmed Time when the axis travels in the negative
Negative Motion | direction through the programmed Position.

3 Choose Output Active High to have the output go high when active or Output Active Low
to have the output go low when active.

4 In stepper mode with no encoder, choose Use Limited Position. Otherwise choose
Use Actual Position.

5 Click OK to save changes to amplifier RAM and close the
Custom Output Configuration screen.
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Synchronizing PWM Switching Frequency

In some situations, such as when sampling small analog signals, it is desirable to
synchronize the PWM switching frequency among multiple amplifiers. In these cases, one
amplifier serves as a master for one or more slave amplifiers. The PWM sync output of the
master sends a signal that is received as a PWM sync input by each slave.
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CHAPTER

7: COMMAND INPUTS

This chapter shows how to configure the amplifier's command inputs. Perform the basic
steps outlined below. Details follow in the chapter.

1 Analog Command | Fihd Command Digital Pasition Inputs CAMN Configuration Frogrammed Fosition
or or or or or

Frogrammed Velocity Programmed Current

Click to open the loop command input settings screen.

2 Change/verify command input parameters as described in the following sections:

Analog Command Settings (p. 58)

PWM Input Settings (p. 60)

Digital Position Input Settings (p. 62) or

CAN Network Configuration (p. 67)
Software Programmed Input Settings (p. 65)
Camming User Guide

3 Click Close to close screen and save changes to amplifier RAM.
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Analog Command Settings

View or change the settings described below.

Parameter Description

Scaling Current mode: output current produced by +10 Vdc of input.

Range: 0 to 10,000,000 A. Default: Peak Current value.

Velocity mode: output velocity produced by +10 Vdc of input.

Range: 0 to 100,000 rpm (mm/sec).

Default: Maximum Velocity value.

Position mode: position change (counts or mm) produced by +10 Vdc of input.
Range: 0 to 1,000,000,000 counts.

Default: 1 Revolution of a rotary motor or 1 pole pair distance for a linear motor.
For more information, see Scaling (p. 58).

Dead Band Sets dead band. Range: -10,000 to 10,000 mV. Default: 0.
For more information, see Dead Band (p. 59).

Invert Command Inverts polarity of amplifier output with respect to input signal.

Offset (Current and Velocity modes only.) Used to offset input voltage error in an open
loop system. Not recommended for use when the amplifier is part of a closed
loop system.

Range: -10,000 to 10,000 mV. Default: 0. For more information, see
Offset (p. 59).

Analog Input Filter Programmable input filter. Disabled by default. See Low-Pass and Bi-Quad
Filters (p.163).

For more information, see Analog Command Notes (p. 58).

7.1.1: Analog Command Notes

The amplifier can be driven by an analog voltage signal through the analog command input.
The amplifier converts the signal to a current, velocity, or position command as appropriate
for current, velocity, or position mode operation, respectively.

The analog input signal is conditioned by the scaling, dead band, and offset settings.
Scaling

The magnitude of the command generated by an input signal is proportional to the input
signal voltage. Scaling controls the input-to-command ratio, allowing the use of an optimal
command range for any given input voltage signal range.

For example, in current mode, with default scaling, +10 Vdc of input generates a command
equal to the amplifier's peak current output; +5 Vdc equals half of that.

Scaling could also be useful if, for example, the signal source generates a signal range
between 0 and +10 Vdc, but the command range only requires +7.5 Vdc of input. In this
case, scaling allows the amplifier to equate +7.5 Vdc with the amplifier's peak current (in
current mode) or maximum velocity (in velocity mode), increasing the resolution of control.
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Dead Band

To protect against unintended response to low-level line noise or interference, the amplifier
can be programmed with a “dead band” to condition the response to the input signal
voltage. The amplifier treats anything within the dead band ranges as zero, and subtracts
the dead band value from all other values. For instance, with a dead band of 100 mV, the
amplifier ignores signals between —100 mV and +100 mV, and treats 101 mV as 1 mV, 200
mV as 100 mV, and so on.

200

100 Dead Band
t R
u
P N a
t \ \/
u 0
(o]
-100
-200

-200 -100 0 100 200
Input
Offset

To remove the effects of voltage offsets between the controller and the amplifier in open
loop systems, HDM provides an Offset parameter and a Measure function. The Measure
function takes 10 readings of the analog input voltage over a period of approximately 200
ms, averages the readings, and then displays the results. The Offset parameter allows the
user to enter a corrective offset to be applied to the input voltage.

The offset can also set up the amplifier for bi-directional operation from a uni-polar input
voltage. An example of this would be a 0 to +10 Vdc velocity command that had to control
1000 rpm CCW to 1000 rpm CW. Scale would be set to 2000 rpm for a +10 Vdc input and
Offset set to -5V. After this, a 0 Vdc input command would be interpreted as -5 Vdc,
which would produce 1000 rpm CCW rotation. A +10 Vdc command would be interpreted
as +5 Vdc and produce 1000 rpm CW rotation.

Monitoring the Analog Command Voltage
The analog input voltage can be monitored in the Control Panel and in the Scope Tool. The
voltage displayed in both cases is after both offset and deadband have been applied.

Analog Command in Position Mode

The Analog Position command operates as a relative motion command. When the amplifier
is enabled the voltage on the analog input is read. Then any change in the command
voltage will move the axis a relative distance, equal to the change in voltage, from its
position when enabled.

To use the analog position command as an absolute position command, the amplifier should
be homed every time it is enabled. The Homing sequence may be initiated by CAN, ASCII
serial, DeviceNet, or HDVM Indexer program commands.
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7.2: PWM Input Settings

View or change the settings described below.

Parameter Description
Scaling Current mode: output current at 100% duty cycle.
Range: 0 to 10,000,000 A. Default: Peak Current value.

Velocity mode: output velocity at 100% duty cycle.
Range: 0 to 100,000 rpm (mm/sec).
Default: Maximum Velocity value.

PWM Input Type | One wire 50% or two wire 100% with direction.
Options Invert PWM input: Inverts the PWM logic.

Allow 100% output: Overrides the 100% command safety measure.
See Failsafe Protection from 0 or 100% Duty Cycle Commands (p. 61).

Invert Sign Input: In 100% duty cycle mode, inverts the polarity of the directional
input.

For more information, see PWM Input Notes (p. 60).

7.2.1: PWM Input Notes

Two Formats

The amplifier can accept a pulse width modulated signal (PWM) signal to provide a current
command in current mode and a velocity command in velocity mode. The PWM input can be
programmed for two formats: 50% duty cycle (one-wire) and 100% duty cycle (two-wire).

50% Duty Cycle Format (One-Wire)

The input takes a PWM waveform of fixed frequency and variable duty cycle. As shown
below, a 50% duty cycle produces zero output from the amplifier. Increasing the duty cycle
toward 100% commands a positive output, and decreasing the duty cycle toward zero
commands a negative output.

—-——  Decreasing Duty Cycle Increasing Duty Cycle

— LU

50 % Duty Cycle

Amplifier Output 0 /
Max -

The command can be inverted so that increased duty cycle commands negative output and
vice versa.
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100% Duty Cycle Format (Two-Wire)

One input takes a PWM waveform of fixed frequency and variable duty cycle, and the
other input takes a DC level that controls the polarity of the output. A 0% duty cycle creates
a zero command, and a 100% duty cycle creates a maximum command level. The command

can be inverted so that increasing the duty cycle decreases the output and vice versa.
100%

100%
Duty Cycle

Duty Cycle

- UL

Direction Input

Amplifier Output 0

Min -

Failsafe Protection from 0 or 100% Duty Cycle Commands
In both formats, the amplifier can be programmed to interpret 0 or 100% duty cycle as a
zero command, providing a measure of safety in case of controller failure or cable break.

HD LLC
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7.3: Digital Position Input Settings

View or change the settings described below.
Parameter Description

Control Input Pulse and Direction: One input takes a series of pulses as motion step
commands, and another input takes a high or low signal as a direction command.
Pulse Up / Pulse Down: One input takes each pulse as a positive step command,
and another takes each pulse as a negative step command.

Quadrature: A/B quadrature commands from a master encoder (via two inputs)
provide velocity and direction commands.

Increment position | Rising Edge: Increment position on the rising edge of the input pulse.

on Falling Edge: Increment position on the falling edge of the input pulse.
Stepping Input Pulses: Number of Input Pulses required to produce output counts.
Resolution Range: 1 to 32,767. Default: 1.

Output Counts: Number of Output Counts per given number of input pulses.
Range: 1 to 32,767. Default: 1.

Invert Command When selected, inverts commanded direction.

For more information, see Digital Position Input Notes (p. 62).

7.3.1: Digital Position Input Notes

62

Three Formats

In position mode, the amplifier can accept position commands using one of these signal
formats: pulse and direction, count up/count down, and quadrature.

In all three formats, the amplifier can be configured to invert the command.

Pulse Smoothing

In digital position mode, the amplifier’s trajectory generator can be used to create
trapezoidal profiles, with programmed acceleration, deceleration and velocity, from a simple
pulse train or burst of pulses

To bypass the trajectory generator while in digital or analog position modes, set the
maximum acceleration to zero. The only limits in effect will now be the velocity loop velocity
limit and the current limits. (Note that leaving the maximum acceleration set to zero will
prevent other position modes from operating correctly.)
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Pulse and Direction Format

In pulse and direction format, one input takes a series of pulses as motion step commands,
and another input takes a high or low signal as a direction command, as shown below.

Pulse Input J_H_Hﬂ HII—HL

Direction Input =~ = m————— e e - - - - s m e m s s - - - - == ==

Velocity /
Command =L = m o m e e . - - - - - - == - /7

The amplifier can be set to increment position on the rising or falling edge of the signal.
Stepping resolution can be programmed for electronic gearing.
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Count Up/Count Down Format

In the count up/count down format, one input takes each pulse as a positive step
command, and another takes each pulse as a negative step command, as shown below.

Up Input J—H—H—H
Command = = = =@ = & e e e e e, - - - = e - - /___

Velocity /
The amplifier can be set to increment position on the rising or falling edge of the signal.
Stepping resolution can be programmed for electronic gearing.

Quadrature Format
In quadrature format, A/B quadrature commands from a master encoder provide velocity
and direction commands, as shown below.

A Input

B Input

Velocity / \

Command

The ratio can be programmed for electronic gearing.
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7.4: Software Programmed Input Settings

These settings can be saved to flash to allow default conditions to be set and used when
the amplifier is powered up or reset.

Poten

tial for unexpected movement.

If Programmed Velocity or Programmed Current are set to values other than 0,
the motor will move after power-up or reset if the amplifier is hardware enabled.

Failure to heed this warning can cause equipment damage, injury, or death.

DANGER

7.4.1: Programmed Position

View or change the settings described below.

Setting Description

Move Relative or Absolute.
Type Trap or S-Curve.
Distance Move distance.

7.4.2: Programmed Velocity

View or change the setting described below.

7.4.3:

Setting Description
Programmed Move velocity. Units: rmp (rotary) or mm/s (linear).
Velocity
Programmed Current
View or change the settings described below.
Setting Description
gﬁ)rgr;;a]rtnmed Current applied during the constant velocity portion of the move. Units: A.

Current Ramp

Acceleration/deceleration current. Units: mA/s.

HD LLC
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HD LLC

8: CAN NETWORK CONFIGURATION

A CANopen network can support up to 127 nodes. Each node must have a unique and
valid seven-bit address (Node ID) in the range of 1-127. (Address 0 should only be used
when the amplifier is serving as a HDM serial port multi-drop gateway.)

Configure a CAN interface

Verify that the CAN network has been cabled and terminated as per amplifier documents.

M Click CAN Configuration to open the CAN Configuration screen. (If CAN is not
the Position Loop Input, choose Amplifier>Network Configuration instead.)

CAN Configuration x| |
Mebwork Type: ~Input Mapping
& CAR (" Devicemet
Mumber of Inputs: |4 vI
Bit Rake: Ileit,l's vl
Bit O: IIN2 - I
—Address Configuration 1 @
Bit 1: IIN3 - I
[~ Use Swikch @
¥ U s e e Il Note that opti based
v Use Programmed Yalue Bit 3: IINS vl ( 0 e atopuons may Vary ase on
amplifier model and configuration.)
Siibch Yalue: Bt 4; IN':'“E :I'
Input Lines Yalue: 1z Eit 5: INDHE - I
Programmed ¥alue: I 1 it &: I@
Mew Resulting Address: 13

The amplifier must be reset for the new settings to take affect.

Save & Reset | Save & Close | Cancel | Help |

Choose network type (CAN).

Choose a Bit Rate and choose any combination of address sources (Switch, Inputs, and
Programmed Value). The address is the sum of the values from these sources.

For each source selected, perform the additional steps described below.

Source Additional Steps

Use Switch Verify the S1 switch setting. (Assigns values for Bit 0 — Bit 3 of CAN address.)
Use Inputs Enter Number of Inputs. Choose an input to represent each CAN address bit.
Use Programmed Value | Enter the Programmed value.

Click Save & Reset to save changes to amplifier flash, close the screen, and reset the
amplifier. Click Save & Close to save changes to amplifier flash without resetting.
NOTE: Address and bit rate changes take effect only after power-up or reset.

67



CHAPTER

9: FAULTS

This chapter shows how to configure the amplifier’s fault latching. Perform the basic steps
outlined below. Details follow in the chapter:

1 Semiave 2] Glick Configure Faults to open Faults Configuration screen.
: x|

Fault Configuration

rLatch Fault

Iv Short Circuit

¥ Amp Orver Temperature
¥ Matar Over Temp

[~ ower Walkage

[~ Under Yalkage

¥ Feedback Errar

[~ Makar Phasing Errar
¥ Follawing Errar

[~ Cammand Input Faulk

~Cptional Faults

[~ Qwer Current {(Latched)

Restore Defaults |

Cancel | Help |

Select the faults to latch. See Fault Configuration Parameters (p. 69).

Click OK to close screen and save changes to amplifier RAM.

Iﬂl On the Main screen, click Save to Flash to avoid losing the changes.

Risk of unexpected motion with non-latched faults.

After the cause of a non-latched fault is corrected, the amplifier re-enables
the PWM output stage without operator intervention. In this case, motion
may re-start unexpectedly. Configure faults as latched unless a specific
situation calls for non-latched behavior. When using non-latched faults, be
sure to safeguard against unexpected motion.

DANGER Failure to heed this warning can cause equipment damage, injury, or
death.

HD LLC 68



HDM User Guide

9.1: Fault Configuration Parameters

Faults

Each of the following faults can be latched by selecting it on the Fault Configuration
screen. For more information on latching, see Fault Latching Notes (p. 70). For details on
limits and ranges, see the amplifier documentation.

Note: The list of faults may vary with amplifier model.

Fault Description

Fault Occurs When...

Fault is Corrected When...

*Amp Over
Temperature

Amplifier's internal temperature
exceeds specified temperature.

Amplifier's internal temperature falls
below specified temperature.

Motor Phasing Error

Encoder-based phase angle does
not agree with Hall switch states.
This fault can occur only with
brushless motors set up using
sinusoidal commutation. It does not
occur with resolver feedback or with
Halls correction turned off.

Encoder-based phase angle agrees
with Hall switch states. See Trouble
Shoot Manual Phase w/ Encoder and
Halls (p. 91).

*Feedback error

Over current condition detected on
output of the internal +5 Vdc supply
used to power the feedback.

Resolver or analog encoder not

connected or levels out of tolerance.

Differential signals from incremental
encoder not connected.

Encoder power returns to specified
voltage range.

Feedback signals stay within
specified levels.

Differential signals connected.

*Motor Over Temp

Motor over-temperature switch
changes state to indicate an over-
temperature condition.

Temperature switch changes back to
normal operating state.

Under Voltage

Bus voltage falls below specified
voltage limit.

Bus voltage returns to specified
voltage range.

Over Voltage

Bus voltage exceeds specified
voltage limit.

Bus voltage returns to specified
voltage range.

*Following Error

User set following error threshold
exceeded.

See Position and Velocity Error
Notes

(p- 71).

*Short Circuit Detected

Output to output, output to ground,
internal PWM bridge fault.

Short circuit has been removed.

Command Input Lost

PWM or other command signal not
present.

Command signal restored.

Over Current (Latched)

Output current I°T limit has been
exceeded.

Amplifier is reset and re-enabled.

*Latched by default.
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9.2: Fault Latching Notes

9.2.1: Clearing Non-Latched Faults

The amplifier clears a non-latched fault, without operator intervention, as soon as the fault
condition is corrected.

Risk of unexpected motion with non-latched faults.

After the cause of a non-latched fault is corrected, the amplifier re-enables the
PWM output stage without operator intervention. In this case, motion may re-start
unexpectedly. Configure faults as latched unless a specific situation calls for non-

latched behavior. When using non-latched faults, be sure to safeguard against
DANGER unexpected motion.

Failure to heed this warning can cause equipment damage, injury, or death.

9.2.2: Clearing Latched Faults

A latched fault is cleared only after the fault has been corrected and at least one of the
following actions has been taken:

e Power-cycle the amplifier

e Cycle (disable and then enable) an enable input that is configured as
Enables with Clear Faults or Enables with Reset

o Access the HDM Control Panel and press Clear Faults or Reset

o Clear the fault over the CANopen network or serial bus

9.2.3: Example: Non-Latched vs. Latched Faults

For example, the amplifier temperature reaches the fault temperature level and the amplifier
reports the fault and disables the PWM output. Then, the amplifier temperature is brought
back into operating range. If the Amp Over Temperature fault is not latched, the fault is
automatically cleared and the amplifier's PWM outputs are enabled. If the fault is latched,
the fault remains active and the amplifier’'s PWM outputs remain disabled until the faults are
specifically cleared (as described above).
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9.3: Position and Velocity Error Notes

9.3.1: Error-Handling Methods

In position mode, any difference between the limited position output of the trajectory
generator and the actual motor position is a position error. The amplifier's position loop uses
complementary methods for handling position errors: following error fault, following error
warning, and a position-tracking window.

To set position error handling parameters for servo amplifiers, see
Enter basic Position Loop settings (p. 106). For stepper amplifiers, see
Error! Reference source not found. (p. Error! Bookmark not defined.).

Likewise, in velocity or position mode, any difference between the limited velocity
command and actual velocity is a velocity error. The amplifier’s velocity loop uses a velocity
tracking window method to handle velocity errors. (There is no velocity error fault.)

To set parameters for velocity error handling, see
Enter basic Velocity Loop settings (p. 102).

9.3.2: Following Error Faults

When the position error reaches the programmed fault threshold, the amplifier immediately
faults. (The following error fault can be disabled.)
For detailed information, see Following Error Fault Details (p. 72).

9.3.3: Following Error Warnings

When the position error reaches the programmed warning threshold, the amplifier
immediately sets the following error warning bit in the status word. This bit can be read
over the CAN network. It can also be used to activate a digital output.

9.3.4: Position and Velocity Tracking Windows

HD LLC

When the position error exceeds the programmed fracking window value, a status word bit
is set. The bit is not reset until the position error remains within the tracking window for the
programmed tracking time.

A similar method is used to handle velocity errors.
For detailed information, see Tracking Window Details (p. 73).
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9.3.5: Following Error Fault Details

Position Error Reaches Fault Level

As described earlier, position error is the difference between the limited position output of
the trajectory generator and the actual position. When position error reaches the
programmed Following Error Fault level, the amplifier faults (unless the following error fault
is disabled.) As with a warning, a status bit is set. In addition, the fault is recorded in the
error log. See Error Log (p. 149).

Additional responses and considerations depend on whether the fault is non-latched or
latched, as described below.

Amplifier Response to Non-Latched Following Error Fault

When a non-latched following error fault occurs, the amplifier drops into velocity mode and
applies the Fast Stop Ramp deceleration rate to bring the motor to a halt. The amplifier PWM
output stage remains enabled, and the amplifier holds the velocity at zero, using the
velocity loop.

Resuming Operations After a Non-Latched Following Error Fault

The clearing of a non-latched following error depends on the amplifier's mode of operation.
Issuing a new trajectory command over the CAN bus, the ASCII interface, or DeviceNet will
clear the fault and return the amplifier to normal operating condition.

If the amplifier is receiving position commands from the digital or differential inputs, then the
amplifier must be disabled and then re-enabled using the ampilifier's enable input or though
software commands. After re-enabling, the amplifier will operate normally.

Amplifier Response to a Latched Following Error Fault

When a latched following error fault occurs, the amplifier disables the output PWM stage
without first attempting to apply a deceleration rate.

Resuming Operations After a Latched Following Error Fault

A latched following error fault can be cleared using the steps used to clear other latched
faults:

e Power-cycle the amplifier

e Cycle (disable and then enable) an enable input that is configured as
Enables with Clear Faults or Enables with Reset

e Access the HDM Control Panel and press Clear Faults or Reset
e Clear the fault over the CANopen network or serial bus
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9.3.6: Tracking Window Details

Proper Tracking Over Time

As described earlier, position error is the difference between the limited position output of
the trajectory generator and the actual position. Velocity error is the difference between
commanded and actual velocity.

When the position or velocity error exceeds the programmed tracking window value, a
status word bit is set. The bit is not reset until the error remains within the tracking window
for the programmed tracking time.

Velocity Tracking lllustration

The following diagram illustrates the use of tracking window and time settings in velocity
mode.

Actual Velocity

Limited Velocity + Tracking Window

Tracking
Time
/ | ‘
/

Tracking Window
Output
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CHAPTER

10: MOTOR PHASING

This chapter shows how to phase the motor using the Auto Phase or Manual Phase tool.
Perform the basic steps outlined below. Details follow in the chapter.

Use the procedure described in this chapter to
Phase Motor with Auto Phase (p. 76).

OR

Use the procedure described in this chapter to
Phase Motor Manually (p. 86).
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10.1: Phase Motor with Auto Phase

Choose the appropriate procedure:

Auto Phase Example: Servo Amplifier (p. 76)

Auto Phase Example: Stepper Amplifier, No Encoder (p. 80)

Auto Phase Example: Stepper Amplifier with Encoder, in Stepper Mode (p. 81)

Auto Phase Example: Stepper Amplifier with Encoder, in Servo Mode (p. 82)

NOTE: The examples in this chapter show particular amplifier operating modes and motor

feedback configurations. Some screens and choices may vary from those described here.
10.1.1: Auto Phase Example: Servo Amplifier

Perform the following steps to Auto Phase a servo amplifier.

NOTE: The following steps show Auto Phase with a brushless rotary motor, digital Halls,

and an incremental quadrature encoder. Screens vary for other configurations.

1 Verify that the Enable Input is not activated and that HV or AC power is applied.

o
Click Auto Phase to open the Auto Phase Motor Direction Setup screen.
E B

Motor Direction Setup

fowe the motor in the directian that you want
to be positive. Press Mextwhen done.

IMakor Actual Position: 0 counts

Release Erake | Mot =" Skip = | Cancel |

3 Move the motor in the direction to be considered positive
OR if you cannot move the motor, click Skip (you will confirm motor direction later).
NOTE: If an output is configured as a brake you can temporarily release the brake by
holding down the Release Brake button. The brake will be reactivated when you
release the button.

4 Click Next to open the Auto Phase Motor Wiring Setup screen:
e

Motor Wiring Setup Commanded Motar Phase Angle

The software will now micro step the motar in 120 @ &0

the positive direciton. Make sure the motor is
free to move. Press Startwhen ready.

180 ]
Auto Phase Current:l 047 A z10 ‘ 330
270
Increment Rate: I 90 elec degisec

Actual Position: 0 counts

Ll I SR | Feady

180 20

= Back Cancel

Continued...
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HD LLC

...Continued:
Activate the Enable Input.

Click Start to begin the motor wiring setup.
The message area displays messages: Configuring Initial Settings, Microstepping, Test
Complete, Motor Wiring has been configured.

During microstepping, a current vector is applied to the motor windings and microstepped
through an electrical cycle at a set rate, causing the motor to move.

If you chose to Skip the motor direction setup step, Auto Phase will prompt for
confirmation of correct motor direction.

If the step fails see Motor wiring setup problems (p. 85).

NOTE: If incorrect values were entered for inductance and resistance, the calculated Cp
and Ci values may produce current loop oscillation, evidenced by an audible high
frequency squeal during auto phasing.

Click Next to open the Auto Phase Phase Count Test screen.

RWroorse x

Phase Count Test Commmanded Motor Phase Angle

The sofbware will now micro step the maotorin an
the negative direcitan. Make sure the motor is 120 Fo
free to move. Press Startwhen ready. 150 20

180 / o
Auta Phase Current:l 147 & 210 =30

240 300

270
Increment Rate: I 90 elec degis

Actual Motar Posttion: 0 counts

Cstat Stop |

Read
Configuration Settings S

Counts per rey 4000

IFalEs 4 « Back | Skip = | Cancel |

Click Start to begin the Phase Count Test. Observe status messages. See the prompt:

Phase Counts x|

i Cbserve motor motion and werify that it
\\2 moves 1 Full turn before any gearing.

Continued...
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11

12

...Continued:

When you are ready to observe motion, click OK. See the prompt:

Phase Counts x|

@ Did motor maove 1 full turn?
] we |

If motor did not turn 1 full turn, click No and see Phase count test problems (p. 85).

If motor turned 1 full turn, click Yes.
The message area displays progress and completion messages.

For a resolver (—R) version of a HD LLC ampilifier, skip to Step 13 (p. 79).
For a non-resolver amplifier, click Next to open the Hall Wiring Setup screen.
5I

Hall Wiring Setup Commanded Motar Phase Angle

& Hall State
The software will now micro step the motor.
hake sure the motar is free to move. [ | [ |
Press Startwhen ready. 120 &0

Wi =0 N
o | 1.2 A
Auta Phase Current: 240 300

Increment Rate: I 40 elec den/sec . .

Hall Offset: 0 deg H B N

Ready Lo Lo Hi

= Back | Eirish | Cancel |

Click Start to begin the Halls wiring setup. The message area displays the messages:
Microstepping. Test Complete. Motor has been properly phased.

During microstepping, a current vector is applied to the motor windings and microstepped
through an electrical cycle at a set rate, causing the motor to move. As the motor moves
the Hall lines are decoded for proper commutation.

If the step fails, see Halls wiring setup problems (p. 85).

Continued...
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14

15

16

17

HD LLC

...Continued:

For a resolver (-R) version of a HD LLC ampilifier, click Next to open the Resolver Phase

Angle Setup screen.

[l Auto Phase

Resolver Phase Angle Setup

Position your motar in center of its range.
The software will now micra step the motar.
Make sure the motor is free to move.

Prass Startwhen ready.

Auto Phase Current: I 28| A

atart |

Offzet

0 geg
Resolver Angle 119 deg
hatar Actual Position: -1 counts

Motor Phasing

Fesolver angle in red. Commanded
motor phase angle in black.

240 300

Testing Fhase angle

Cancel |

= Back | Fimish |

Click Start to start the resolver phase angle setup. The message area displays status

messages.

Click Finish to close the screen and save values to flash memory
OR to close the screen without saving changes, click Cancel.

If the Auto Phase algorithm does not produce desired results, try adjusting the Auto
Phase Current and Increment Rate values, using the guidelines in
Guidelines for Choosing Auto Phase Current and Increment Rate Values (p. 85).

If desired results are not obtained, or to confirm results, proceed to

Phase Motor Manually (p. 86).

79



Motor Phasing HDM User Guide

10.1.2: Auto Phase Example: Stepper Amplifier, No Encoder

1 Verify that the Enable Input is not activated and that HV power is applied.

g
Click Auto Phase to open the Auto Phase Motor Direction Setup screen.
anutu Phase EI

Motor Direction Setup

hake sure the motor is free to move. Move motor and observe direction.
Motar direction can be changed by clicking Invert Motor output check box.

Welocity I 20 rpm Ready
Acceleration I 3 rpst
Deceleration I 3 rps?

MoveMEG | [[ MovaPos
[~ Invert Makar Qukpuk Ok | Cancel |
3 Hold down Move POS to move the motor in the direction considered positive, and

observe the direction of movement.
If the motor does not move see Motor wiring setup problems (p. 85).

4 If the motor moved opposite the direction that you wish to program as positive, click
Invert Motor Output.

5 Click OK to save the direction setting.
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Motor Phasing

10.1.3: Auto Phase Example: Stepper Amplifier with Encoder, in Stepper

Mode
1 Verify that the Enable Input is not activated and that HV power is applied.
|
Click Auto Phase to open the Auto Phase Motor Direction Setup screen.
ﬂnutu Phase |
Motor Direction Setup
Move the motar in the direction that you want
to he positive. Press Nextwhen done.
Mator Actual Position: 578 counts
Skip = | Cancel |
3 Move the motor in the direction you wish to be considered positive.
Activate the Enable Input.
Click Next to open the Auto Phase Motor Wiring Setup screen.
x|
Motor Wiring Setup
The saftware will move the motar. Make sure the
rotar is free to move. Press Startwhen ready.
IMokor Actual Position: 0 counts
‘elocity: I 4,39 rpm Ready
Stop I
< Back | Eimish | Cancel |
6 Click Start to begin motor wiring setup with default values.
After successful motor wiring setup, the message “Test Complete” appears.
7 Click Finish to close the screen and save values to flash memory.
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10.1.4: Auto Phase Example: Stepper Amplifier with Encoder, in Servo
Mode

Verify that the Enable Input is not activated and that HV power is applied.

EI Click Auto Phase to open the Auto Phase Motor Direction Setup screen.

ﬂnutu Phase

Motor Direction Setup

Move the motar in the direction that you want
ta be positive. Press Mextwhen done.

Mator Actual Position:

Skip = | Cancel |

X

Move the motor in the direction you wish to be considered positive.
Activate the Enable Input.

Click Next to open the Auto Phase Motor Wiring Setup screen.

Ellauto Phase

Motor Wiring Setup

The software will now micro step the motor.
Make sure the mataris free to mowe.

FPress Startwhen ready.

fuko Phase Current:l 239 A
Increment Rate: I 2250 elec degfs

Commanded Maotar Phase angle

a0
120 18]

150 a0

180 \ 0
210 a0

240 300
270

Makor Actual Position: 0 counts

Feady

< Back [HERE= | Cancel

Continued...
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...Continued:

6  Click Start to begin the motor wiring setup.
The message area displays messages: Configuring Initial Settings, Microstepping, Test
Complete, Motor Wiring has been configured.

During microstepping, a current vector is applied to the motor windings and microstepped
through an electrical cycle at a set rate, causing the motor to move.

If you chose to Skip the motor direction setup step, Auto Phase will prompt for
confirmation of correct motor direction.

If the step fails see Motor wiring setup problems (p. 85).

NOTE: If incorrect values were entered for inductance and resistance, the calculated Cp
and Ci values may produce current loop oscillation, evidenced by an audible high
frequency squeal during auto phasing.

7 Click Next to open the Auto Phase Phase Count Test screen.

EellAuto Phase x|

Phase Count Test

The sofbware will now micro step the maotorin
the negative direciton. Make sure the motar is
free to move. Press Startwhen ready.

Auto Phase Current:l 147 &

Increment Rate:

I 90 elec degis

Cormmanded Motor Phase Angle

120 =0 G0

150 a0
180 / o

210 330

240 270 300

Actual Motar Posttion: i} it
o Start ! Stop | FodTE

Read
Configuration Settings S

Counts per rey 4000

IFalEs 4 « Back | Skip = | Cancel |

8  Click Start to begin the Phase Count Test. Observe status messages. See the prompt:

Phase Counts x|

1 Cbserve motor motion and werify that it
\\2 moves 1 Full turn before any gearing.

9  When you are ready to observe motion, click OK. See the prompt:

Phase Counts x|

@ Did motar maove 1 full turn?
M |

10  When you are ready to obslerve motion, click OK. See the prompt:
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Phase Counts x|

@ Did motar maove 1 full turn?

Click Next to open the Auto Phase Motor Phase Initialize screen:
x|

Motor Phase Initialize

The amplifier will perfarm phase intialization. Make sure the
motor is free to move. Press Initialize Phase when ready.

= Back | Einisty | Cancel |

Click Initialize Phase to start phase initialization. If successful, this message appears:
“Test Complete. Phasing has been initialized.”

Click Finish to close the screen and save values to flash memory.

After clicking Finish, the following message appears if changes were made:
x|

@ Mew configuration will be saved to arnplifier flash.

Maotar encoder wiring has changed.
Data file should be saved again.

Click OK.
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10.2: Guidelines for Choosing Auto Phase Current and

Increment Rate Values
Here are some considerations in choosing Auto Phase Current and Increment Rate values:

e If friction is high, then more current may be required to move the load.

e High static friction may require more current to overcome stiction.

e Transition from static friction to dynamic friction, and back, may produce jerky motion.
o A faster rate will operate in the dynamic friction range.

o A slower rate will operate in the static friction range.

¢ If the friction is low, as in the case of air bearings, low frequency oscillations may
occur; thus, less current and slower rates may be required. If oscillations persist, then
friction may need to be temporarily added.

10.3: Trouble Shoot the Auto Phase Process

Motor direction setup problems

If motor direction setup step failed:

= Check Encoder or resolver power and signals.
= Verify that the encoder is differential. (Contact factory if encoder is single-ended.)
= Check shielding for proper grounding.

Motor wiring setup problems

If motor wiring setup step failed:

Verify that amplifier is disabled.

Check for mechanical jamming.

Check for smooth motion with no mechanical jerking.

Check for good connections to the motor power wires.

Disconnect motor power wires and measure for proper motor resistance.

Phase count test problems

If phase count test failed, verify that in the Motor/Feedback screen the following
parameters have been set correctly:

Number of Poles for rotary motors. See Verify the motor’s pole count (p. 91).
Magnetic Pole Pair Length for linear motors

Encoder Lines or Fundamental Lines for rotary encoders.

Encoder Resolution for linear encoders.

Halls wiring setup problems

If Halls wiring setup step failed:

= Check Halls power and signals.
= Check for smooth motion with no mechanical jerking.
= Check shielding for proper grounding.

If the auto phase procedure fails despite these corrective measures, see
Phase Motor Manually (p. 86).
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10.4: Phase Motor Manually

The HDM Manual Phase tool lets the user phase a brushless motor, monitor signals, check
configuration wiring, and control a microstepping current vector.

10.4.1: Manual Phase Example: Motor with Encoder

Make sure that no load is attached to the motor.

On the Main screen, choose Tools>Manual Phase to open the window:

x|
~Configurstion——————  [Manitar
Hall Mo faults.
Motor Phase ahgle
Irvert Ingut: & Hall State
Vu v Vw
Hell Wiring: IWVU ,l Hall States ——————————— .120 ED.
- .30 u K W
Hall Offset.l e . . . RE] \ o [l
~hdator Feedback——— i Lo Lo .240 SDD.
IV Invert Input
Motor Phase Angle: 116 deg
rhotar———————————————— Motor Feedback: 10915 counts
v
7 nvert Quteut Actusl Currert: L -D028 % 003 A W 001 A

—Cantrol

Increment Rate: I a0 elec degls Set Zero Position |
o I 0&
CEE & hiowve hotor

" Enable (¥ Disable Rev | el |

Restare Defaults | Ok | Cancel

LS R -

% Enable " Disable

Verify the Current setting and then enable the amp by selecting Enable in the Control
area of the Manual Phase window.

Move Miotar
Rew Frd

To control the current vector rotation, command the motor forward or reverse.
NOTE: Some motors have bearings stiction, so helping the motor with mechanical force is
acceptable. Motors with no friction may need friction added to steady motion.

If the motor cannot keep up with the rate of vector rotation, then reduce the Increment
Rate or increase the Current.

Verify that pressing forward button moves motor forward.
If the motor moves in the wrong direction, toggle the Motor Invert Output setting.

Continued...
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...Manual Phase Example: Motor with Encoder, continued:

7 Verify actual position count agrees with direction of rotation: increasing counts in
forward direction and decreasing counts in reverse direction. If it does not, toggle the
Motor Feedback Invert Input box setting.

8 If the motor has no Halls, skip to
Phase Initialization Steps for Motor without Halls (p. 88).

9 Monitor the vector rotation through one electrical cycle for proper Hall transitions:

= Verify that the red indicator rotates in the same direction as the motor phase angle,
and that the transition occurs when the needle is between indicators (30 degrees,
as shown below).
Waotor Phase dngle & Hell Statz

B an’
120 B0 "
[ RE »~

240 300

= [f the needle and Hall states do not track properly, use the Hall Wiring list box and/or
Invert Input options (shown below) to swap the amplifier's Hall wire configuration.

~Halls

Ireett Inpt:

Mo Ty e
Hall iring: | UWY "I

Hall Offsst: |- 0
SR ey P

~hotor Feedb: iy L [g—
IV ey v U
WL e

Mt

= [f the red indicator transition leads or lags behind the centered needle by more than
30 degrees, then try adjusting the Hall Offset in +/- 30 degree increments:

Hall oftzet: | Bl deg

10 Phasing of a motor with encoder and Halls is complete. Click OK.
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Phase Initialization Steps for Motor without Halls
The Phase Initialization function is designed to phase a motor with no Halls.

Halls are strongly recommended for safe, redundant system.

HD LLC strongly recommends the use of Halls or a commutating encoder for
commutation to provide a safe, redundant system. If the application requires
otherwise, the customer accepts responsibility for verifying system performance
and reliability.

DANGER
Failure to heed these warnings can cause equipment damage, injury, or
death.

The Phase Initialization function uses as little motion as possible (less than 1/3 of one
electrical cycle) to determine phasing. Phase Initialization drives the motor in open loop
current mode, using microstepping of a current vector.

1 This procedure is a continuation of Manual Phase Example: Motor with Encoder (p. 86).
Before proceeding, verify you have completed that procedure through Step 8 (p. 87).

2 Ensure that the motor is free to move (for instance, make sure the brake is OFF).

Ensure that no external force, such as gravity, will cause the motor to move. If it is not
practical to eliminate such forces, it may be necessary to use the Forced Phase feature
later in this procedure.

inialze Phass |To phase a motor with an encoder and no Halls, click Initialize Phase.

Observe the status messages under Monitor.

5 If the message “Phase Initialized” appears, the phasing of a motor with encoder and no
Halls is complete. Click OK to close the Manual Phase window.
6 Fhase Initialize If the phasing function fails (for instance,
rme: | - message “Phase Initialized” is not displayed, or
curent; [ 1454 if a phasing fault is indicated) adjust the phase

{Current set to O uses IPeak)

initialization settings described below and try
Step 4 (Initialize Phase) again.

™ Forced Phase

™ Increment Phase 90 deg

I Use OFfFset Initialize Phase |

Setting Description

Time Used first as a delay, allowing amplifier to ramp up current to drive a small move.
Then used as a settling time. If the value is too low, the settling may not occur in
time, possibly resulting in jerky motion. Default: 400 mS.

Current Use to overcome stiction when rotating current vector. If the current is too large,
motion may not settle; a low value may not provide enough current to drive a
move.

Forced Phase When selected, Forced Phase causes the Phase Initialization function to apply
Phase Init Current to alternate pairs of motor wires using the Phase Init Time.
Forced Phasing has been used to overcome various phasing problems, including
situations where gravity introduces unwanted motion. Forced Phasing tends to
produce more jerk and apparent motion.

Increment If set, the amplifier will increase the starting phase angle by 90 degrees after
Phase 90 deg every failed initialization attempt.

Use Offset If set, the amplifier uses the Hall Offset value as the initialization starting angle.
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10.4.2: Manual Phase Example: Motor with Resolver

Make sure that no load is connected to the motor.

On the Main screen, choose Tools>Manual Phase to open the window:
Manual Phase ' x|

Configuration ~honitor

Mo faults.
rResolver—————— Motor Phase atggle Elack

Resolwer ingle in Red
Offsetl 150 deg
Resolver 120 60

rhictor Feedback————————— 180 1]
Angle 318 deg
¥ Invert Inpt

240 300

Motor Phase Angle: 108 degy
—Matar

Poszitiot -240  counts

Actual Current: LE 00z & A 001 & e -0.03 A

Cartral

Increment Rate: I a0 elec degis Set Zero Position |
. I 047
EEt: & horve hotor

" Enable  * Disable Rey | Fvd |

Restore Defaults | OK | Cancel

=T “

" Dizable

Verify the Current setting and then enable the amp by selecting Enable in the Control
area of the Manual Phase window.

fdawve Motar
Rew Fuvd

To control the current vector rotation, command the motor forward or reverse.
NOTE: Some motors have bearings stiction, so helping the motor with mechanical force is
acceptable. Motors with no friction may need friction added to steady motion.

If the motor cannot keep up with the rate of vector rotation, then reduce the Increment
Rate or increase the Current.

Verify that pressing forward button moves motor forward. If it does not, toggle the Motor
Invert Output box setting.

Verify actual position count agrees with direction of rotation: increasing counts in
forward direction and decreasing counts in reverse direction. If it does not, toggle the
Motor Feedback Invert Input box setting.

Continued...
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...Manual Phase Example: Motor with Resolver, continued:

8 Adjust Resolver Offset configuration as required, testing Fwd and Rev, to produce
alignment of Motor Phase Angle with Resolver Angle as shown here.

Motor Phase ingle Black
Resolwver Angle in Red

120 &0
1a0 ‘-~‘\ 0
240 300

Note: Motor manufacturers typically align the resolver in 30 degree increments, typically
by applying current through a pair of motor power wires.
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10.5: Trouble Shoot Manual Phase w/ Encoder and Halls

To perform trapezoidal commutation after power-up or reset, the amplifier must receive
good Hall signals. After the first Hall transition is detected, then sinusoidal commutation can
be performed. In sinusoidal commutation, the amplifier uses the encoder for commutation
while monitoring the Halls to verify proper phase. If the error between the encoder count
and Hall transition is too large, then the Hall phase correction will not be performed and a
phase fault will be triggered.

Test for phase fault problems in the order shown below.

1 Data accuracy test

=  Verify the motor’s pole count:

= Apply a current vector at zero Increment Rate to lock motor in position.
= Turn the motor shaft and count the number of distinct locking positions.
= Calculate the number of poles: Poles = number of locking positions * 2

= Verify the encoder line count OR a linear motor's magnetic pair length and the
encoder resolution.

2 Encoder wiring test

= |f the Halls produce good trapezoidal commutation but a phase fault is persistent in
sinusoidal commutation mode, the encoder is highly suspect. Try this:

Verify the differential encoder signals.

Verify proper twisted shielded cable with good grounding.

Disable the amplifier and move the motor manually to test for phase fault.

If phase fault only occurs under command of current, make sure the motor
power cable is not bundled with the encoder cable.

3 Hall signals test

= |f you suspect the Halls signals are faulty, try this:

= Make sure Halls change states as the motor moves through one electrical cycle.

= Some Hall signals are noisy and require filtering. Check with motor
manufacturer.

= Some Halls are not properly calibrated to the motor manufacturer’s specification.

4 Hall transition test

= |f you suspect that the location of the Hall transition is not within +/-30 degrees, try
this:

= Adjust Hall offset in smaller increments.
= Verify Hall alignment.
= Make sure motion is smooth.
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CHAPTER

11: CONTROL LOOPS

This chapter shows how to program and tune the control loops. Perform the basic steps
outlined below. Details follow in the chapter.

For each control loop:

1 . Lo P Lo
o |or i l or _2* |CIick the appropriate button to open the loop control screen.
2 395 : .
Changel/verify settings as needed.
3 ﬂl Click Close to close screen and save changes to amplifier RAM.
4 z
Click to open the Scope tool.
5
Run a function or profile and adjust settings to tune the loop.
Trace Status: Reading trace data from -
g 0.5
E ujin]
L .
For an overview of control loop theory, see
Servo Operating Modes and Control Loops (p. 10).
HD LLC

93



Control Loops

11.1: Current Loop Setup and Tuning

HDM User Guide

Initial current loop proportional gain (Cp) and current loop integral gain (Ci) values can be

calculated with The Calculate Function (p. 46).

Enter basic Current Loop settings

1 L .
il Click | Loop to open the Current Loop screen:
B i
Current
Offset
Eoremandted + c t E%rrec:ting
urren N _/_ : . Comy perlsgior orgque
x Actual
Curent

Peak Current Lirnit:
I2T Tirne Limnik:
Continuous Current Limik:

Current Loop Offset;

JJ

& Cpi I 0 i’
i i | 0 il

& Drrive Oukput
¥ Maximize Smoothness

" Maximize Speed

Auto Tune | Bamdwidth |

Close |

2 Changel/verify Current Loop parameters as needed.

Parameter

Description

Peak Current Limit

Used to limit the peak phase current to the motor. Max value depends upon
the amplifier model; Min value > continuous limit.

I°T Time Limit Sets I°T Time Limit in mS. See I°T Time Limit Algorithm (p. 157).
Continuous Current Used to limit the Phase Current. Max Value is < Peak Current and depends
Limit upon the amplifier model. Min value: 0

Current Loop Offset

Sets current loop offset. Leave it set to zero until after tuning. For more
information, see Offset (p. 100).

Cp

Current loop proportional gain. Range 0 — 32,767.

Ci

Current loop integral gain. Range 0 — 32,767.

Drive Output

Maximize Smoothness: Amplifier uses circular vector limiting to produce
smooth operation even into the voltage limits.

Maximize Speed: Allows for slightly more of the bus voltage to be used when
in the voltage limit. This may produce a small disturbance at top speed.

Auto Tune

See Current Loop Auto Tune (p. 97).

Bandwidth

Measure bandwidth using the Cp and Ci values now in the amplifier.

3 Click Close to close screen and save changes to amplifier RAM.
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Manually tune the Current Loop

METHOD: Apply square-wave excitation to the current loop and adjust current loop
proportional gain (Cp) and current loop integral gain (Ci) to obtain a desired waveform.
For instance:

P Oscilloscope

LE Trace Status: Reading trace data from amplifier

P b A g

0000 0002 0004 0005 0008 0010 0042 0014 0046 0048 0020 0022 0024 0026
Time (secands)

NOTES:
1) During tuning, observe any warnings that appear to the left of the trace.
2) Some users prefer the Auto Tune feature. See Current Loop Auto Tune (p. 97).

1 z
Click the Scope Tool.
2 [
Apply Ta: |Currert
- Choose Current from the
Function Generator Apply To: list.
3 On the Settings tab, make sure Auto Setup is selected.
Auto Setup automatically sets the following parameters:
Function Generator Tab
Parameter Description
Function Square Wave.
Amplitude 10% of continuous current value.
Frequency 100 Hz.
Settings Tab
Channel 1 Commanded current (green).
Channel 2 Actual current (white).
4 e [ 047
Ampltuee il Verify that the Amplitude value is not excessive for the motor.
Continued...

HD LLC
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...Continued:

5 _s= | Glick start
6 Cp:l /a7 —

Cic 285

On the Gains tab, adjust current loop proportional gain (Cp):

= Set current loop integral gain (Ci) to zero.

= Raise or lower Cp to obtain desired step response. (Typically, little or no overshoot
with a 100 Hz, low-current square wave.) If the Cp value is too large, ringing may
occur. If the Cp value is too low, bandwidth decreases.

7 Adjust current loop integral gain (Ci) until desired settling time is obtained.

(o)

&l Press Stop to stop the function generator.

Iﬂl On the Main screen, click Save to Flash to avoid losing the changes.
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Control Loops

11.2: Current Loop Auto Tune

Tune the Current Loop with Auto Tune

METHOD: The current loop Auto Tune algorithm applies a square-wave command to the
current loop and adjusts current loop proportional gain (Cp) and current loop integral gain
(Ci) until a desirable waveform is obtained.

Initial current loop proportional gain (Cp) and current loop integral gain (Ci) values can be
calculated with The Calculate Function (p. 46).

+ | Loop

Click | Loop to open the Current Loop screen:

CEX

Correcting

o Compensatar Tarque |
p+Ci

[ Actual
Current

Commanded
Current

Peak Current Limit: 3

I3T Time Lirnit:

Continuous Current Limit:

Current Loop Offset:

Dirive Cubpuk
() Maximize Smoothness

(%) Maximize Speed

[ Auko Tune ]

[ Bandwidth ]

4

Clase

Verify that the amplifier is hardware enabled.

ot | Click Auto Tune to open screen and start the Current Loop Auto Tune.

0.06
004
00z

5 0.00

-0.0z

-0.04

-0.06
00000 00005  0.0010 00015 0.0020  0.0025 00020 00035 0.0040 00045 00050

Time fsecon ds1
Auto Tune Current: I:l A

Status:  Auto Tune in progress

Cp: 10 i 0

To Change the Auto Tune Current, Press Stop, enter the new current in the Aufo Tune
Current field, and then press Start.

Continued...

HD LLC
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... Tune the Current Loop with Auto Tune, continued:

5 Observe the Auto Tune process and results. A typical example:
= Sets Cp and Ci to zero and then adjusts Cp and Ci for optimal values.

Auto Tune Current: 05| A
- Stakus:  Auto Tune in progress,
o M7 G 0 Skart [ Stop ] [ Close ]

Uses a frequency sweep to determine the small signal, current loop bandwidth.

Displays the results: a set of Cp and Ci alternatives, and the bandwidth measured using
the high Cp and Ci values.

Auto Tune Results

» . AUto Tune has determined new values for Cp and Ci along with
. | J high bandwidth measurement. Select desired settings.

Otish o 285 o 53 Bandwidth: 2400 Hz
®Medum cp 171 G 32
) Low cp 114 ¢ 21
O original 0 ci 70

(%) Save Cp and Ci ko Flash
() Keep Cp and Ciin RAM anly

[ Ok ] [ Cancel

Continued...
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... Tune the Current Loop with Auto Tune, continued:

6 Choose an action based on Auto Tune results.

= Choose which set of values to save: High, Medium, Low, or Original.

The Medium values, selected by default, are appropriate for most applications.
= Optionally choose how to save: Save Cp and Ci to Flash

or Keep Cp and Ci in amplifier RAM only.

7 Click OK to save the values as chosen, and close the Auto Tune Results window.
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11.3: Notes on the Current Mode and Current Loop

11.3.1: Current Loop Diagram

As shown below, the “front end” of the current loop is a limiting stage. The limiting stage
accepts a current command, applies limits, and passes a limited current command to the

summing junction. The summing junction takes the commanded current, subtracts the actual

current (represented by the feedback signal), and produces an error signal. This error
signal is then processed using the integral and proportional gains to produce a command.
This command is then applied to the amplifier's power stage.

Current Command—»| Current Limiter Limited Current

/N

Current Offset —

Current Loop PWM

Current Integral Gain Ci) I—* + | Command

Current Proportional Gain Cp) \—»@» !
o

\
~

»

—

Limits:
e Peak Current

e Continuous Current

Feedback (Actual Current)

o Peak Current Limit Time

11.3.2: Current Loop Inputs
e The amplifier's analog or PWM inpults.
o A CANopen network via the amplifier's CAN interface.
e A HD LLC Virtual Motion (HDVM) control program.
e The amplifier's internal function generator.
In velocity or position modes, the current command is generated by the velocity loop.

11.3.3: Offset

The current loop offset is intended for use in applications where there is a constant force
applied to, or required of, the servomotor and the system must control this force. Typical

applications would be a vertical axis holding against gravity, or web tensioning. This offset

value is summed with the current command before the limiting stage.

11.3.4: Limits

The current command is limited based on the following parameters:

Limiter Description

Peak Current | Maximum current that can be generated by the amplifier for a short duration of time.

Limit This value cannot exceed the peak current rating of the amplifier.

Continuous Maximum current that can be constantly generated by the amplifier.

Current Limit

I?T Time Limit | Maximum amount of time that the peak current can be applied to the motor before it
must be reduced to the continuous limit or generate a fault.
For more details, see I°T Time Limit Algorithm (p. 157).
Note: Although the current limits set by the user may exceed the amplifier's internal
limits, the amplifier operates using both sets of limits in parallel, and therefore will not
exceed its own internal limits regardless of the values programmed.

Ramp Rate of change in current command. Used to limit jog moves initiated from the Control
Panel Jog function in current mode, and in advanced Indexer Program functions.

100
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11.3.5: Current Loop Gains
The current loop uses these gains:

Gain

Description

Cp - Current loop
proportional

The current error (the difference between the actual and the limited commanded
current) is multiplied by this value. The primary effect of this gain is to increase
bandwidth (or decrease the step-response time) as the gain is increased.

Ci - Current loop
integral

The integral of the current error is multiplied by this value. Integral gain reduces
the current error to zero over time. It controls the DC accuracy of the loop, or
the flatness of the top of a square wave signal. The error integral is the
accumulated sum of the current error value over time.

11.3.6: Current Loop Output
The output of the current loop is a command that sets the duty cycle of the PWM output

stage of the amplifier.

HD LLC
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11.4: Velocity Loop Setup and Tuning

Initial velocity loop proportional gain (Vp) and velocity loop integral gain (Vi) values can be
calculated with The Calculate Function (p. 46).

102

Enter basic Velocity Loop settings

Wel, Limit: 1000 | rpm

Fast Skop Ramp:

WL . . . .
ﬁl Click V Loop (screen contents vary with model and configuration):
[ | Velocity Loop g|§|gl
Commanded Commanded
+

{ Actual
Welociy

Vp: 250
Wi 300

33| rps?

Tracking
|’ windau: &00 | rpm

Time: 100 | ms

Command Filter ol 0

Change/verify Velocity Loop parameters as needed.

Parameter

Description

Velocity Limit

Top speed limit. Max value may depend upon the back EMF & the Encoder
value. Min value: 0.

Acceleration Limit

Maximum acceleration rate. Max value may depend upon load, inertia, & peak
current. Min value: 1. (Does not apply in position mode.)

Deceleration Limit

Maximum deceleration rate. Max value may depend upon load, inertia, & peak
current. Min value: 1. (Does not apply in position mode.)

Tracking Window

Tracking Time

See Tracking Window Details (p. 73).

Vp

Velocity loop proportional gain. Range: 0 to 32,767.

Vi

Velocity loop integral gain. Range: 0 to 32,767.

Fast Stop Ramp

Deceleration rate used by the velocity loop when the amplifier is hardware
disabled. Range: 0 to 100,000,000. Default: velocity loop Decel. Limit value.
For more information, see Velocity Loop Limits (p. 104).

Low Gains Shift

Increases the resolution of the units used to express Vp and Vi, providing more
precise tuning. For more information, see Velocity Gains Shift (p. 105).

Hi Gains Shift

Decreases the resolution of the units used to express Vp and Vi, providing more
precise tuning. For more information, see Velocity Gains Shift (p. 105).

Vi Drain (integral
bleed)

Vi drain modifies the effect of velocity loop integral gain. The higher the Vi Drain
value, the faster the integral sum is lowered. Range: 0 to 32,000. Default: 0.

Command Filter

Programmable command input filter. Disabled by default. See Velocity Loop
Command and Output Filters (p. 105).

Output Filter

Programmable output filter. Default filter type: Low-Pass, 2-pole Butterworth (Cut
Off Frequency 200 Hz). See Velocity Loop Command and Output Filters (p. 105).

Click Close to close screen.
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HD LLC

Manually Tune the Velocity Loop

Velosity (1pmi)

0.00 0.05 0.10 0.15 0.20 0.25 0.20 0.35 0.40 0.45 0.50

NOTE: During tuning, observe aﬁ—y{"v;/"ahr\nings that appear to the left of the trace.

Click the Scope Tool.
‘ Apply To: |Veloc'rt3-'

Choose Velocity from the Function Generator Apply To: list.

2256 On the Settings tab, make sure Auto Setup is selected.
Auto Setup automatically sets the following parameters:

Function Generator Tab

Parameter Description

Function Square Wave.

Amplitude 10% of maximum velocity value.
Frequency 5 Hz.

Settings Tab

Channel 1 Limited velocity (green).
Channel 2 Actual Motor Velocity (white).

smpitude =2 Verify that Amplitude value is not excessive for the motor.

_sen| Click Start.

On the Gains tab, adjust velocity loop proportional gain (Vp):

= Set velocity loop integral gain (Vi) to zero.
= Raise or lower proportional gain (Vp) to obtain desired step response. (Typically, little
or no overshoot on a 5 Hz small, slow-speed square wave.)

Adjust velocity loop integral gain (Vi) until desired settling time is obtained.

&l Press Stop to stop the function generator.

Iﬂl On the Main screen, click Save to Flash to avoid losing the changes.
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11.5: Notes on the Velocity Mode and Velocity Loop

11.5.1: Velocity Loop Diagram

As shown below, the velocity loop limiting stage accepts a velocity command, applies
limits, and passes a limited velocity command to the input filter. The filter then passes a
velocity command to the summing junction. The summing junction subtracts the actual
velocity, represented by the feedback signal, and produces an error signal. (The velocity
loop feedback signal is always from the motor feedback device even when an additional
encoder is attached to the load.) The error signal is then processed using the integral and
proportional gains to produce a current command. Programmable digital filters are provided
on both the input and output command signals.

Velocity Loop
Velocity Integral Gain (Vi I
Velocity Limited y ? “ I v
o1 Feefl . + i
Command™| Velocity Limiter > pijgey ( Velooly L Z Velocity Proportional Gain ¥/p) | Filter L, Current
+ Command

Limits: |

o Velocity

o Acceleration* Feedback (Derived Velocity)

o Deceleration”
o Emergency Stop Deceleration*
*Not used when velocity loop is controlled by position loop. See "Velocity Loop Limits" for details.

11.5.2: Inputs
In velocity mode, the velocity command comes from one of the following:

e The amplifier's analog or PWM inpults.

o A CANopen network via the amplifier's CAN interface.

e A HD LLC Virtual Motion (HDVM) control program.

e The amplifier's internal function generator.

In position mode, the velocity command is generated by the position loop.

11.5.3: Velocity Loop Limits

The velocity command is limited based on the following set of parameters designed to
protect the motor and/or the mechanical system.

Limiter Description

Velocity Limit | Sets the maximum velocity command input to the velocity loop.

Acceleration Limits the maximum acceleration rate of the commanded velocity input to the velocity
Limit loop.

This limit is used in velocity mode only. In position mode, the trajectory generator
handles acceleration limiting.

Deceleration Limits the maximum deceleration rate of the commanded velocity input to the velocity
Limit loop.

This limit is used in velocity mode only. In position mode, the trajectory generator
handles deceleration limiting.

Fast Stop Specifies the deceleration rate used by the velocity loop when the amplifier is hardware

Ramp disabled. (Fast stop ramp is not used when amplifier is software disabled.) If the brake
output is active, the fast stop ramp is used to decelerate the motor before applying the
brake.

Note that Fast Stop Ramp is used only in velocity mode. In position mode, the trajectory
generator handles controlled stopping of the motor. There is one exception: if a non-
latched following error occurs in position mode, then the amplifier drops into velocity
mode and the Fast Stop Ramp is used.

For more information, see Following Error Fault Details (p. 72).
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11.5.4: Diagram: Effects of Limits on Velocity Command
The following diagram illustrates the effects of the velocity loop limits.

Limited Velocity

Commanded Velocity
> N

Vel Limit= — =— 1‘ -

R VR
|
Accel Limit = f=— |==— Decel Limit ==
11.5.5: Velocity Loop Gains
The velocity loop uses these gains:
Gain Description
Vp - The velocity error (the difference between the actual and the limited commanded
Velocity loop | velocity) is multiplied by this gain. The primary effect of this gain is to increase
proportional bandwidth (or decrease the step-response time) as the gain is increased.
Vi - The integral of the velocity error is multiplied by this value. Integral gain reduces the
Velocity loop | velocity error to zero over time. It controls the DC accuracy of the loop, or the flatness
integral of the top of a square wave signal. The error integral is the accumulated sum of the
velocity error value over time.

11.5.6: Velocity Gains Shift

The Velocity Gains Shift feature adjusts the resolution of the units used to express Vp
and Vi, providing more precise tuning. If the non-scaled value of Vp or Viis 64 or less, the
Low Gains Shift option is available to increase the gains adjustment resolution. (Such low
values are likely to be called for when tuning a linear motor with an encoder resolution finer
than a micrometer.) If the non-scaled value of Vp or Viis 24001 or higher, the High Gains
Shift option is available to decrease the gains adjustment resolution.

11.5.7: Velocity Loop Command and Output Filters

The velocity loop contains two programmable digital filters. The input filter should be used
to reduce the effects of a noisy velocity command signal. The output filter can be used to
reduce the excitation of any resonance in the motion system.

Two filter classes can be programmed: the Low-Pass and the Custom Bi-Quadratic. The
Low-Pass filter class includes the Single-Pole and the Two-Pole Butterworth filter types.
The Custom Bi-Quadratic filter allows advanced users to define their own filters
incorporating two poles and two zeros.

For more information, see Low-Pass and Bi-Quad Filters (p.163).

11.5.8: Velocity Loop Outputs
The output of the velocity loop is a current command used as the input to the current loop.
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11.6: Position Loop Setup and Tuning

Initial position loop proportional gain (Pp), velocity feed forward (Vff), and acceleration
feed forward (Aff) values can be calculated with The Calculate Function (p. 46).

Enter basic Position Loop settings

+ F Loop

Click P Loop to open the Position Loop Values screen:

Trajectory Yalues | Position Loop Walues

Prifile
Acceleration o

Caommanded
Welocit

Prafile
Welocity

Limited

[] Disable Fault

Pasition
— Actual
T Puasition
Fp: | 15000] Yif: | 16384 AfF: i} Gains Multiplier: 1

100% Yff = 163584

Following Error Tracking Position Wrap

Fault: 800 | counts indow: 200 | counts

Warning: 400 | counts Tirne:! 10| ms

Close

2 Change/verify Position Loop Values as needed. Click Close when done.

Gain Description
Aff Acceleration feed forward. Range: 0 to 32,767. See Trajectory Limits (p. 113).
Vff Velocity feed forward. Range: 0 to 32,767. 100% Vff: 16,384.
See Trajectory Limits (p. 113).
Pp Position loop proportional gain. Range: 0 to 32,767. See Trajectory Limits (p. 113).

Gains Multiplier

Position loop output is multiplied by this value before going to the velocity loop. In
dual encoder systems, the multiplier’s initial value is calculated based on the ratio
of motor encoder turns to position encoder turns. See Feedback Parameters (p.
42).

Following Description

Error

Fault The level (in encoder counts) at which the following error produces a fault, which
stops the servo loop. We recommend raising the fault level before tuning the loop.
See Following Error Fault Details (p. 72).

Warning The level (in counts) at which the following error produces a warning (without
stopping the loop). See Following Error Fault Details (p. 72).

Disable Fault Stops following error from faulting. Following Error Fault Details (p. 72).

Tracking Description

Tracking Window

Width of tracking windowin counts. See Tracking Window Details (p. 73).

Tracking Time

Position must remain in the tracking window for this amount of time to be considered
tracking. See Tracking Window Details (p. 73).
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3 Optionally click Position Wrap to open the Position Wrap screen:

x|
Mokor Position Yrap: I D| counks

1 revalution of the mator is 4000 counts.

Load Position 'Wrap: I 0 counts

Load positioning mot configured.

QK | Cancel | Help |

4 Changel/verify the position wrap parameters as needed. Set both values to zero to

disable position wrapping. Note that the changes do not take effect until OK is pressed.
For more information about this feature, see Position Wrap (p. 114).

Parameter Description

Motor Position Position at which the actual motor position count returns to zero. In a single

Wrap feedback system, it also applies to the actual load position.

Load Position Position at which the actual load position count returns to zero in dual feedback

Wrap systems. If the position encoder is set to passive mode, this value applies to the
passive encoder position.

S Click on the Trajectory Values tab:

Trajectory Yalues | Pasition Loop Yalues
Prafile

Commanded Prafile

Pasition Accelerstion
— = » —_— > Yy —DCCEEISEN
_/_ Lirnite:d
Puasition

Max Velocity: 50| | rpm Max Accel.: 166.6 |rps?
Max Decel.: 166.6 |rps?
Clear Limits
Abort Decel.: 166.6 |rps?
Set Default Limits

= Position Loop E“E@

Close
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Changelverify the trajectory values as needed:

Parameter Description

Max Velocity Maximum trajectory velocity. Max value may depend upon the back EMF and the
Max feedback count. Min:0. Default: 0.25 x motor velocity limit.

Max Accel Maximum trajectory acceleration. Max value may depend upon the load inertia and
peak current. Min:0. Default: 0.5 x velocity loop Accel. Limit value.

Max Decel Maximum trajectory deceleration. Max value may depend upon the load inertia and
peak current. Min:0 (disables limit). Default: 0.5 x velocity loop Accel. Limit value.

Abort Decel Deceleration rate used by the trajectory generator when motion is aborted. Min:0.
Default: 0.5 x velocity loop Accel. Limit value.

Jerk Rate of change of acceleration. The value of jerk set during the calculate procedure

produces an S-Curve whose maximum slope is equal to the trajectory profile slope.
This value will produce a maximum acceleration that is not more than the initial
default value of acceleration. Small values will produce less jerking but will take
longer to complete move. Large values will produce more jerking and a more
trapezoidal profile but will complete the move faster.

Note that setting limits to zero disables the trajectory generator so that the
command input is not limited by the generator. Velocity is only limited by the
Velocity Limit set in the Velocity Loop.
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5

Manually tune the position loop

METHOD: Minimize following error and oscillation by running profiles and adjusting
position proportional gain (Pp), velocity feed forward (Vff), acceleration feed forward
(Aff) and other settings. For instance:

griaceslalus Ready

s E:
) ol s

A CWTEAIRAAMARAL AL L A 8 R
1 - % LT
Wy e WV T IJ

(52G0Nds]

NOTE: Dr|ng tuning, obsrve warnings that appear to the left of the trace.

Click the Scope Tool.

ratar  Profile |

Select the Profile tab.

AR S On the Settings tab, make sure Auto Setup is selected. Auto Setup
automatically sets the following parameters:
Profile Tab

Parameter Description
Move Relative

Type Trap

Distance 2000 counts

Reverse and repeat | Not selected

Settings Tab
Channel 1 Profile velocity (green)

Channel 2 Following error (white)

Distance: I 2000  counts
If the Auto Setup default profile distance is not appropriate,
enter an appropriate short distance.

il Click Start. The Profile Generator executes a short move.

NOTES:

1) The profile may not reach constant velocity during a short move.

2) If a following error occurs, open the Control Panel and click Clear Faults.

Continued...
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...Continued:
6 Function Generator Profile
Seftings | Gains  Trajectory Limits I Posttion Paratns | Welocity Par
Maimumm Welociy: I B250  rpm Move: Type:
* Relative * Trap
Madirmumm Acceleration: I 20835 rps?
" Absolute " SCurve
Maximum Deceleration: I 20835 rps?
Wepdmumm Jerk | 3340 | ppe® Distance: | 2000  counts
and

Set up a trapezoidal profile by setting the trajectory limits and distance. See table:

Trajectory Limits Tab
Parameter Description
Maximum Velocity
Maximum
Acceleration Set values typical of those expected to be used in the application.
Maximum
Deceleration
Profile Tab
Distance Set the move distance to produce a complete trajectory profile. Be sure
that this distance does not exceed mechanical limits of the system.
Move Relative
Type Trap
7 Pp: a000 ill

AT | 0 ill
Wt | 16384 ill

Adjust position proportional gain (Pp) to minimize following error:
= On the Gains tab, set velocity feed forward (Vff) and acceleration feed forward
(Aff) to zero.
= On the Profile tab, click Start. On the Gains tab, adjust position loop proportional gain
(Pp) until best result is obtained.
= Click Start after each adjustment to test on a new profile move.

NOTES:
1) Too much position loop proportional gain (Pp) might cause oscillation.
2) If a following error occurs, open the Control Panel and click Clear Faults.

8  Adjust velocity feed forward (Vff):

= Velocity feed forward (Vff) reduces following error in the constant velocity portion
of the profile. Often, a velocity feed forward (Vff) value of 16384 (100%) provides
best results.

= Click in the Vfffield and adjust the value.

= Click Start after each adjustment to test on a new profile move.

Continued...
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...Continued:

9 Adjust acceleration feed forward (Aff):

= Acceleration feed forward (Aff) reduces following error during profile acceleration
and deceleration.

= Click in the Afffield and adjust the value.

= Click Start after each adjustment to test on a new profile move.

NOTES:

1) If, after tuning the position loop, the motor makes a low frequency audible noise while
enabled but not moving, the velocity loop gains (Vp and Vi) may be lowered to reduce
the noise. If the gain values are set too low, the response to instantaneous rates of
change might be reduced (i.e., slow correction to disturbances or transients).

2) If the amplifier is set up to run in position mode under analog input command, and the
analog command signal produces too much noise at the motor after tuning, the Analog
Command Filter or the Velocity Loop Command Filter may be used to reduce the noise
further.

See Low-Pass and Bi-Quad Filters (p. 163).

10 Tune to multiple sets of profiles representing typical moves that might be executed in the
application. Starting with Step 6 (p. 110), repeat the process as needed.
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Test S-Curve Profile

DISCUSSION: If the amplifier will perform S-Curve profile moves, use this procedure to
tune the level of jerk. (Jerk is the rate of change of acceleration. S-Curve moves reduce
jerk to provide a smooth profile.) Run an S-Curve profile and adjust velocity, acceleration,
deceleration, and jerk levels until the desired profile is obtained. For instance:

Trace Stalus. Ready

oa 0.1 0z 03 04 05 08 (o Jr SR - 04 10 1.4 42 1.3
Time (= ds)

s Profile

Type:
= Trap
% 5Curve

On the Profile tab, click the S-Curve button.

Set up an S Curve profile by adjusting the following parameters to represent a typical
move under normal operation.

Trajectory Limits Tab

Parameter Description

Maximum Velocity Maximum speed of the profile.

Maximum Acceleration/ Maximum acceleration/deceleration of the profile. The deceleration
Deceleration is set to be the same as acceleration.

Maximum Jerk The value of jerk set during the calculate procedure produces an

S-Curve whose maximum slope is equal to the trajectory profile
slope. This value will produce a maximum acceleration that is not
more than the initial default value of acceleration. Small values will
produce less jerking but will take longer to complete move. Large
values will produce more jerking and a more trapezoidal profile but
will complete the move faster.

Profile Tab
Distance Increase the move distance to produce a complete trajectory
profile. Use an acceptable value the does not exceed mechanical
limits of the system.
Move Relative
Type S-Curve
Click Start.

Try multiple sets of profiles representing typical moves that might be executed in the
application. Starting with Set up an S Curve profile, repeat the process as needed.

HD LLC



HDM User Guide Control Loops

11.7: Notes on the Position Mode and Position Loop

11.7.1

: Position Loop Diagram

The ampilifier receives position commands from the digital or analog command inputs, over
the CAN interface or serial bus, or from the HDVM Control Program. When using digital or
analog inputs, the amplifier's internal trajectory generator calculates a trapezoidal motion
profile based on trajectory limit parameters. When using the CAN bus, serial bus, or HDVM
Control Program, a trapezoidal or S-curve profile can be programmed. The trajectory
generator updates the calculated profile in real time as position commands are received.

The output of the generator is an instantaneous position command (limited position). In
addition, values for the instantaneous profile velocity and acceleration are generated.
These signals, along with the actual position feedback, are processed by the position loop
to generate a velocity command.

To bypass the trajectory generator while in digital or analog position modes, set the
maximum acceleration to zero. The only limits in effect will now be the velocity loop velocity
limit and the current limits. (Note that leaving the maximum acceleration set to zero will
prevent other position modes from operating correctly.)

The following diagram summarizes the position loop.

Position L
Profile Velocity N - osition -0op
> Velocity Feed Forward (Vff) .
Target Trajectory ] ; i ;
Position Generator Profile Acceleration »| Acceleration Feed Forward (Aff) Gain » Velocity
Multiplie Command
. . +
I—’ /L Limited Posiion ®—>| Position Proportional GainRp) +
X -
Limits:
e Max velocity P
e Max accel Feedback O from motor encoder or resolver
o Max docel Od----------mmmmm oo from optional position encoder (on load)
e Abort decel

11.7.2: Trajectory Limits

In position mode, the trajectory generator applies these limits to generate the profile.
Limiter Description
Maximum Velocity Limits the maximum speed of the profile.

Maximum Acceleration Limits the maximum acceleration rate of the profile.

Maximum Deceleration Limits the maximum deceleration rate of the profile.

Abort Deceleration Specifies the deceleration rate used by the trajectory generator when motion
is aborted.

11.7.3: Position Loop Inputs From the Trajectory Generator

The position loop receives the following inputs from the trajectory generator.

Input Description

Profile Velocity The instantaneous velocity value of the profile. Used to calculate the velocity
feed forward value.

Profile Acceleration The instantaneous acceleration/deceleration value of the profile. Used to
calculate the acceleration feed forward value.

Limited Position The instantaneous commanded position of the profile. Used with the actual
position feedback to generate a position error.

11.7.4: Position Loop Gains

HD LLC

The following gains are used by the position loop to calculate the velocity command:
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Gain Description

Pp - The loop calculates the position error as the difference between the actual and

Position loop limited position values. This error in turn is multiplied by the proportional gain

proportional value. The primary effect of this gain is to reduce the following error.

VFf - The value of the profile velocity is multiplied by this value. The primary effect

Velocity feed forward of this gain is to decrease following error during constant velocity.

Aff - Acceleration feed The value of the profile acceleration is multiplied by this value. The primary

forward effect of this gain is to decrease following error during acceleration and
deceleration.

Gain Multiplier The output of the position loop is multiplied by this value before being passed
to the velocity loop.

11.7.5:

Position Loop Feedback
Some HD LLC amplifiers feature dual-sensor position loop feedback, configured as follows:
e Single sensor. Position loop feedback comes from the encoder or resolver on the
motor.
e Dual sensor. Position loop feedback comes from the encoder attached to the load.

(Note that in either case, velocity loop feedback comes from the motor encoder or
resolver.) For more information, see Feedback Notes (p 44).

Position Loop Output
The output of the position loop is a velocity command used as the input to the velocity loop.

11.7.6: Position Wrap

114

The position wrap feature causes the position reported by the amplifier to “wrap” back to
zero at a user-defined value instead of continually increasing. Once set, the reported
position will be between 0 and n-1 where n is the user entered wrap value. This feature is
most useful for rotary loads that continually turn in one direction and only the position
within a revolution is of interest to the user.

Relative moves with the wrap value set will move the relative distance called for. Example;
if the wrap value is set to 1000 and a relative move of 2500 is commanded, the axis will
turn 2 _ revolutions.

Absolute moves will move the shortest distance to arrive at the programmed position. This
could be in the positive or negative direction. Moves programmed to a point greater then the
wrap value will cause an error.

To configure the position wrap feature, see Enter basic Position Loop settings (p. 106).

HD LLC




HDM User Guide Control Loops

11.8: Auto Tune all Loops for Linear Motors

The Auto Tune all loops feature is available for use with linear motors.

Make sure motor is mounted firmly and verify accuracy and completeness of
motor data.

Failure to heed this warning can cause equipment damage, injury, or death.

DANGER

Tune All Loops with Auto Tune (Linear Motors)

At any point, use Back to return to the previous screen. Use Skip to tune the velocity loop
without tuning the current loop, or to tune the position loop without tuning the velocity loop.

1 Verify the motor is mounted firmly. Also verify the accuracy and completeness of the motor
settings. See Motor/Feedback (p. 37).

Current Loop

2 Make sure the amplifier's Basic Setup (p. 31) and Motor Phasing (p. 75) procedures have
been performed, and that the system is capable of a 10 mm move.

Click Auto Tune to open the Current Loop Tune screen.
[putoTune x
Current Loop Tune
@ Ready
Cp: 180 Felect initial move direction, then
ress start to tune current 10013.

ci 192

[v Inital Move Positive

start | (B3 sip | cancel |

The status indicator is blue when the amplifier is ready for tuning.

4 Verify the Initial Move Positive setting. In most cases, this option should be set. If positive
initial motion is not possible, you can specify negative initial motion by clearing this option.
For instance, negative initial motion may be used when a vertical axis is at the bottom of the
motion range and the positive direction is down.

Continued...
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...Continued:

5 Click Start to tune the current loop. During tuning, the status indicator is amber.
Cp and Ci values change as the text in the status box gives progress updates.
When the current loop has been tuned, the status indicator turns green, and the status box
contains instructions for the next step

Xl
CLrrent LOOD Turne
€ Done
Cp: 180 randwidth 1200 Hz
Press next to tune welocity loop.
i 192
¥ Inital Move Positive
Stop | Mext Cancel
Velocity Loop:
6 Click Next to open the Jog screen.
CTTEE—— 5I
Jog
Jog Speed: 50 mm/s Position your motor in
the center of its range.
Jog MNeg | Jog Pos
Actual Current - A
v Enable jog Current Loop Offset Current 0A
pack | mext | cancel |

7 Move the motor to the center of its motion range. To use a jog move:
= Set the Enable Jog option.
= Optionally adjust the jog speed
= Jog the motor in either direction to move it to the center of its motion range.

Continued...
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...Continued:

8 When the motor is centered, click Next.
If the amplifier must apply current to hold the new position against a force (such as gravity

in a vertical application), the following message appears:
Auto Tune Current offsek required x|

& current loop offset requirement of 0,49 A
has been detected. If you are using a verticle
system the current loop offset should be

changed to compensate For graviky.
Make recommended change?

Cancel

i

If this message appears, click OK.
The Velocity Loop Tune screen opens:

Yelocity Loop Tune
Target Bandwidth @ Ready

—J— Higher Auto tune will arttempt to make &
10mm mowve. If your system is not

¥p: 18 capable of a l0mm move cancel how.

vii 9

Adjust target bandwidth then
press start to tune velocity loop.

Back | Skip | Cancel I

9 Optionally adjust the Target Bandwidth.
TIP: Increase bandwidth for more stiffness in the holding position. Decrease bandwidth to
eliminate buzzing or oscillations caused when the load is removed.

Continued...

HD LLC 117



Control Loops HDM User Guide

...Tune All Loops with Auto Tune, Velocity Loop, continued:

10 Click Start to tune the velocity loop. During tuning, the status indicator is amber.
Vp and Vi values change as the text in the status box gives progress updates.
When the velocity loop has been tuned, the status indicator turns green, and the status box
contains instructions for the next step:

: x|

Yelocity Loop Tune

Target Bandwidth € Done
._J_ Higher Bandwidth 70 Hz
Press next to tune position loop.
Voo 92
Wi 48

Stop | Back | et | Cancel

Position Loop:

11 Click Next to open the Position Loop Tune screen:
x|

Position Loop Tune

Move Type

5 Curve Wi = 1005 (optimal settling and Following
wff

¥ Trap Best Settling J— Best Following

@ FReady
Lurto tune will attempt to make a
P 1750 10mm mowe. IE your system is not
Y 153g4 capahle of a 10mm wmowve cancel now.
BT 4EE Select mowve Cype then press start
to tune position loop.
Skart | Stop | Back | Einish | Cancel |

12  Verify the Move Type setting (S-Curve or Trap).

13 For a trapezoidal profile, optionally optimize the tuning along the scale between Best Settling
(for quicker settling) and Best Following (for less following error).

Continued...
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...Tune All Loops with Auto Tune, Position Loop, continued:

14 Click Start to tune the position loop. During tuning, the status indicator is amber.
Pp, Vff, and Aff values change as the text in the status box gives progress updates.
When the position loop has been tuned, the status indicator turns green, and the status box
contains instructions for the next step:

Position Loop Tune

Move Type

% 5 Curve WEF = 100% {optimal settling and Following)
i

= Trap Best Settling l— Best Fallowing

€ Done
Press finish to sawve tuning
Pei 1200 values and exit.
ViF 16384
aff: 4096
{USkart i Stop | Back | Einish Cancel

15 Click Finish. See the reminder:

Tuning values Changed 5[

Mew gains must be saved to
flash after wverification

16 Click OK.

AL |
On the HDM Main screen, click Save to Flash.
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CHAPTER

HD LLC

12: HOMING

Set homing parameters and run optional homing tests. Perform the steps outlined below.

4| On Main screen, click Home to open the Homing screen.

Homing x
Saftware Lini
Positive: 0 pSteps Deceleration Rate:l 0 rps*
Megative: 0 pSteps
Disablz |

Mathod: [Set Current Postion as Home = |

Direction of Mation
¥ Postive ¢ Megative OfFset: 0 pSteps

Current Limit: 0.19 A

Fast Welocity: 100 rpm
Slow Yelocity: 20 rpm
Accel/Decel: 17 rps?

Follawing Swarning;
Actual Current:

Actual Position:

Current Delay. Time: 250 | ms

1000, pSteps
A

0 pSteps

Save Exit |

Select the following homing parameters:

Parameter

Description

Software limits: Positive

Position of user-defined travel limits that take effect after homing

Software limits: Negative

operation.

Software limits:
Deceleration Rate

Deceleration rate used to stop a motor when approaching a software
limit.

Software limits: Disable

Disables the use of software limits by setting both limits to zero.

Method

Homing method. See Homing Methods (p. 165).

Direction of Motion

Initial direction of motion for the homing method (Pos or Neg).

Fast Velocity

The velocity used to find a limit or home switch. Also used when moving
to an offset position, or a resolver or Servo Tube index position.

Slow Velocity The velocity used to find a switch edge, incremental or analog encoder
index pulse, or hard stop.

Accel/Decel The acceleration and deceleration rate used during homing.

Offset Execute a move of this distance after the reference is found. Set actual

position to 0 and call the new position home.

Current Limit

Hard stop home is reached when the amplifier outputs the homing Current

Current Delay Time

Limit continuously for the time specified in the Delay Time.

Following Warning

Shows the programmed following warning level.

Actual Current

Shows actual current being applied to windings during homing.

Actual Position

Shows the actual position of the axis.

Optionally click Home to begin a homing sequence. To stop immediately, click Stop.

Click Save to save the settings to flash memory. Click Exit to close the screen.
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CHAPTER

13: CONTROL PANEL

Become familiar with the HDM Control Panel and its functions. Perform the steps outlined
below to access the panel and its functions. Details follow in chapter.

1 —
Click to open the Control Panel
Tl Control Panel =10 x|

—atatus rTanitar

# Motor Qutput: Active ILimited Position ﬂ _ counts
e # Hardware Enabled: Enabled
I.C\ctual Matar Position ﬂ _ caunks

& Software Enabled: Enabled

& Paositive Limit: Mat Ackive
& i Megakive Limit: Mok Ackive
% Software Limits: Mot Active |-¢\ctual Mokor Velocity ﬂ _ rpm
Error Log | & Motor Phase: oK
& Motion Abort Input; Mat Active Mode: Position, Digital Input
- %M Control Program: Mot Funning
5> Home: Mok Referenced
A Status; ieve

Gain Scheduling: Yelaity: I 7S rpm
Acceleratian I 100 | rps2
~Contral Dece/eration I 100 rps?

é'EI'é"mé Set Zero Posikion

Disable Clear Faults | Resat I™ Enatle Jog otz MES | [ PO |
Close |
2 See this chapter for a Control Panel Overview (p. 124) and details on:
= Status Indicators and Messages (p. 124)
= Control Panel Monitor Channels (p. 125)
= Control Functions (p. 126)
= Jog Mode (p. 127)
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13.1: Control Panel Overview

Each of the Control Panel features labeled below is described in the following sections.

[ slControl Panel
Status

Red if fault
is active

—_—

Yellow if warning >

is active

Display error log —p» Error Log

Message box ———pp»

C

Status indicators Monitor real-time amplifier values

and operational mode

=10l x|
Monitar
# Motor Output: Active |Limited Position counts
# Hardware Enabled: Enabled
# Software Enabled: Enabled |A sl Motor Post ﬂ p— 3
% Pasitive Linit: Mat Active cuat Floter Fostan By oL

& Megative Limit: Mok Ackive

% Software Limits: Mot Active

# Motor Phase: oK

2 Mation Abort Input: Mok Ackive
CYM Control Program: Mok Running
Harme: Mok Referenced

= I

|Actual Motor Velocity

Mode: Position, Digital Input

Move

—=
—
—

Set Zero Position |

Control functions ——»
Disable

[~ Enable Jog | |

Clear Faults | Reset

I
Jog mode controls

13.2: Status Indicators and Messages

The Status area includes status indicator lights (described below) and a message box.
Any red lights indicate that motion will be inhibited.

Indicator States/Description

Motor Output State of the PWM output stage. Red if the output stage is inactive (disabled)
Hardware State of the hardware enable input(s). Red if one or more enable inputs are inactive.
Enabled

Software State of the software enable. Red if the amplifier is disabled by software.

Enabled

Positive Limit

State of the positive limit switch input. Red indicates an activated positive limit switch.

Negative Limit

State of the negative limit switch input. Red indicates an activated negative limit switch.

Software
Limits

State of the software limits. Red indicates an activated software limit.

Motor Phase

Indicates a motor phasing error. Red indicates a motor phasing error exists.

Motion Abort State of the programmed Motion Abort Input. Red indicates the input is active.

Input

HDVM Control | Status of the HDVM Control Program.

Program

Home Indicates whether the axis has successfully been referenced (homed).

CAN Status Status of the CAN Bus. Yellow indicates CAN warning limit reached. Red indicates bus
error detected. (For DeviceNet, see the HD LLC DeviceNet Programmer’s Guide.)

Gain Scheduiing Indicates whether Gain Scheduling (p. 187) is active.

Q

The fault indicator goes red when a fault is active. Check the status message box for a

description of the most recent fault: Fault: Under Voltags
Check the Error Log for a full history of faults and warnings.

AN

The warning indicator goes yellow when a warning is active. Check the status message

box for a description of the most recent; Yarming: Pas Gutside of Tracking tindow
Check the Error Log for a full history of faults and warnings.

Message Box

Displays status descriptions.

124
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13.3: Control Panel Monitor Channels

Control Panel

The Control Panel Monitor channels can display real-time values on up to three separate

variables. The procedure follows.

Set up a monitor display channel

Manitor

ICommanded Position

Inctual Maotar Position

ILimited Fosition

Mode: Position, Digital Input

Click in the list box and select a variable from the list. Disabled disables the
display. Other options represent the following amplifier values:

Actual Current

Actual Motor Velocity
Actual Motor Position
Actual Load Velocity
Actual Load Position

Velocity Error

o Following Error

o Commanded Current
e Commanded Velocity
o Commanded Position
o Profile Velocity

o Profile Acceleration

Passive Load Position
Limited Position
Analog Command

Bus Voltage

Amplifier Temperature
Motor Phase Angle

Mode: Displays the amplifier's present operating mode. In camming it also displays

the active cam table number.

HD LLC

125



Control Panel HDM User Guide

13.4: Control Functions

126

The Control area of the screen provides functions related to overall amplifier control. The
screen options vary with model and configuration.

Use the Control Panel Control Functions

Control

Enable | Set Zero Position |

Disable | Clear Faults | Reset |

Control the operational state of the amplifier using the buttons as described below.

Control Description

Enable Click to software enable the ampilifier.

Disable Click to software disable the amplifier. This will also stop any HDVM
programs that are running.

Set Zero Position Click to set the amplifier’s actual position counter to zero.

Clear Faults Click to clear all amplifier faults.

Reset Click to reset the amplifier.

Risk of unexpected or uncontrolled motion.

Using the HDM Set Zero Position function while the amplifier is operating under
external control could cause unexpected or uncontrolled motion.

Failure to heed this warning can cause equipment damage.
WARNING
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13.5: Jog Mode

Jog mode provides a simple means for generating forward or reverse commands, as

Control Panel

shown in the procedure below.

Run a move in jog mode

1 To put the amplifier in jog mode, set the Enable Jog option.
2 Set up a jog move by setting the following mode-specific parameters:
Mode Parameter | Description
Current Current Current applied to the motor. Limited by current loop Continuous

Current.
Warning: Unloaded motors may, depending on torque setting,
ramp up in speed very quickly.

Velocity | Jog Speed Velocity of the jog move. Limited by velocity loop Vel. Limit.
Position | Velocity Velocity of the jog move. Limited by velocity loop Vel. Limit.
Acceleration | Acceleration limit of the jog move.
Deceleration Deceleration limit of the jog move.
3 Command the move:
Mode Steps
Current e Hold Pos to apply positive current to the motor or hold down Neg to apply
negative current to the motor.
¢ Release the button to command zero current.
Velocity |e Hold Jog Pos to command a forward velocity or hold down Jog Neg to
command a negative velocity.
¢ Release the button to command zero velocity.
Position

¢ Hold Move Pos to generate a forward move profile or hold Move Neg to
generate a negative move profile.

¢ Release the button to stop movement.

NOTE: Position mode jog is accomplished by continuously updating the
commanded position. If a following error develops with Following Error Fault
disabled, motion will not stop on button release. Instead, it stops when actual
position = commanded position.

HD LLC
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CHAPTER

14: ScoPE TooL

This chapter shows how to use the HDM Scope Tool to program and test motion
sequences. Perform the steps outlined below to access the Scope Tool. Details follow in
the chapter.

FEX
Trace Status: Ready

Function Generator ‘ Profile| Settings | Gains || Trajectary Limits | Position Params | Yelocity Params | Measurement |
Apply To! Auka Setup

[ single Trace
Bpctiony [ Auta Scale Lack
Amplitude: counts Trace Tim€:
Frgquency: He Sample Rate: Zms

Stark Stop
»‘I' [ Record ] [ Stop Trace ] [ Clear ] [ Close
| | |
2 See this chapter for a Scope Tool Overview (p. 130) and details on:

Function Generator and Profile Tabs (p. 131)
Trace Channel Variable Parameters (p. 132)
Trigger Setup (p. 133)

Trace Time, Sample Rate and Single Trace (p. 133)
Scope Display Parameters (p. 134)

Auto Setup (p. 135)

Measurement Tab (p. 136)

Control Loop Parameters (p. 137)
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14.1: Scope Tool Overview

130

Function/Profile ﬁpp\yTD: ICurrent - Sflfcommanded current | [ Buto Setup

The Scope Tool can be used to tune the amplifier, monitor performance, and perform
diagnostics. Function Generator and Profile Generator can drive the motor without
external control. Aufo Set Up feature sets typical initial values for scope parameters.

[Tl Oscilloscope i [ m) ll
File menu —9»

Trace Status: Trace Canceled - Ready To Start Mew Trace

B

g

oy
&

Scope Trace

o
S

-
2
7 g
Bk g3
Eam g - 02325 m
£__c 2o O
o 600 = D.Dg o 2
= Tg = 6}
= 40 o 25 §
g

200 -50

o 78

-200 -100

0.00 0.0s 0.0 015 0.z0 025 020 0.246 040 045 0450
Time (seconds)
Function Generator | Prufilel Settings | Gainsl Trajectory Lirmtsl Position Paramsl Velocity Paramsl Measurementl

Trigger Setup |

Generation chz I~ single Trﬁ Scope settings and
Function: |Suuare Wiave 'l ch3 [ Auto Scale Cock control loop parameters
Arnplibude: I 008 A Ch4 Trace Time: |25 ms ¥
chs
Fraquancy’:l 100 Hz che

Sample Rate: 67 Us

Start | Stop

:ﬂ Record | Stop Trace | Clear | Close | E‘—- Scope controls
| ----1-------------------T -------------- 4—-Statusmessagebar
Button Description
ﬂ Save a trace. See Scope Trace Files (p. 140).
Record Begins recording a trace.
Stop Trace Stops recording a trace.
Clear Clears the trace from the screen and trace data from buffer.
Close Closes the scope tool.

Run a move with the Function Generator or Profile Tool
Click on the Function Generator or Profile tab.

Adjust Function Generator or Profile settings, scope tool settings, gains, limits, and
parameters (as described later in this chapter).

Click Start to begin move and trace. Click Stop to stop the move.

Monitor externally controlled motion
As required, adjust scope tool settings.

Click Record to begin trace.

Begin move with external controller. Click Stop Trace to stop the trace recording.
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14.2: Function Generator and Profile Tabs

The Function and Profile generators can provide inputs to the different control loops for
tuning and diagnostics purposes without using an external control source.

Function Generator | Profile | Function Gererator  Priofile |

Appy o |Current | MD(\:‘E Reletive TW(E-" Trep
Function: B .: © Absalte 5 curve
Arnplitucie: W A Distance; lm courts
Petiod, 10 ms I™ Reverse and Repest

Start Stop Start Stop

The Start button starts the function or profile generator. The Stop button stops the
generator and aborts any profiles in progress.

14.2.1: Function Generator Tab

Parameter | Description

Apply To Control loop to which the Excitation will be applied: Current (available in all modes),
Velocity (available in velocity or position mode), or Position (available in position mode
only).

Function Function that will be applied to the control loop selected in the Apply To list box. The

choices vary with the control loop selected:
Selected Control Loop Functions Available

Current Sine Wave, Square Wave, Step Forward, Step Forward and
Reverse, and Impulse
Velocity Sine Wave, Square Wave, Step Forward, Step Forward and
Reverse
Position Sine Wave, Square Wave
Amplitude Amplitude of the command. Units vary depending on the value chosen in the

Apply To field.

Frequency (Sine Wave and Square Wave only.) Frequency of input command cycle.

Period (Step Forward, Step Forward and Reverse, and Impulse only.) Duration of each input
pulse.

14.2.2: Profile Tab

Parameter | Description

Move Relative: Moves axis a specified distance from the starting position.
Absolute: Moves axis to a specific position.

Type Trap or S-Curve.

Distance Distance for Relative move.

Position Target position for Absolute move.

Reverse and | (Relative move only.) When selected, will continuously generate forward and reverse
Repeat moves of the distance specified until Stop is pressed.
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14.3: Trace Channel Variable Parameters

Choose a trace variable for display in a Scope channel

1
x|
Trace Variable
Analog command
Bus voltage
Analog sin input
Analog cos input
Terminal Yoltage Stepper
Terminal Yoltage Serva
Event: Status Faults
Event Status Warnings
Event Status Misc,
O | Cancel |
2 Choose a category and a trace variable.
Category | Trace Variable Category | Trace Variable
Disabled | <Channel disabled, no Misc. | Motor Phase Angle, Amplifier
associated variable> Temperature, Hall States
Current | Commanded Current, Actual Digital Inputs | Digital input line states
Current, Limited Current.,
1T Amplifier Accumulator,
1T Motor Accumulator.
Velocity | Profile Velocity, Digital | Digital output line states
Commanded Velocity, Outputs
Limited Velocity, Actual
Motor Velocity, Actual Load
Velocity, Unfiltered Motor
Velocity, Velocity Error
Position | Commanded Position, Event Status | Short Circuit, Amp Over
Limited Position, Actual Faults | Temperature, Over Voltage, Under
Load Position, Actual Motor See Fault | Voltage, Motor Over Temperature,
Position, Following Error, Configuration | Feedback Error, Motor Phasing
Passive Load Position Parameters | grror, Following Error, Command
(P-89)- | Input Fault, Amplifier Fault (a
latched fault is active).
Acceleration | Profile Acceleration Event Status | Current Limited, Voltage Limited,
Warnings | Positive Limit Switch, Negative
See Custom | Limit Switch, Following Warning,
Event Functions | Velocity Limited, Acceleration
(P-52). | Limited, Positive Software Limit,
Negative Software Limit, Pos
Outside of Tracking Window, Vel
Outside of Tracking Window.
Voltage | Analog Command Event Status | Amp Disabled by Hardware,
Bus Voltage Misc. | Amp Disabled by Software,
Analog sin Input See Custom | Attempting to Stop Motor, Motor
Analog cos Input Event Functions | Brake Active, PWM Outputs
Terminal Voltage Stepper (p-52). [ Disabled, Position Has Wrapped,
Terminal Voltage Servo Home Switch Active, In Motion,
Phase Not Initialized.
3 Click OK.
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14.4: Trigger Setup

Set up Scope trace trigger (manual setup)

. Trigger Setup |
Rt Click Tri ger Setup to open the screen:

Trigger Settings

xI

Trigger Type: IEuent Status Rising Edge LI

Trigget o IChanneI 1 - I
Position: ILeft - I
Level: I

Ewvent Stabus Bit; Current Limited

(o4 | Cancel |

Choose from the settings described below:

Setting Description
Trigger Type Selects trigger type.
e Immediate Trigger: Trace begins as soon as Record is pressed.
¢ Rising Edge: Trace triggers when (after Record is pressed) the trigger signal rises
though the trigger level setting.
¢ Falling Edge: Trace triggers when (after Record is pressed) the trigger signal falls
though the trigger level setting.
e Above Level: Trace triggers when the trigger signal is greater than or equal to the
trigger level setting.
¢ Below Level: Trace triggers when the trigger signal is less than or equal to the
trigger level setting.
e Function Generator: Trace begins in synchronization with the Function Generator.
e Move Start (position mode only): Trace begins in synchronization with the trajectory
generator.
¢ Event Status Rising Edge/Event Status Falling Edge: trigger on the rising or falling
edge of changes to events chosen in the Event Status Bit setting (below).
e Input Level High/Input Level Low: trigger when specified input is high or low.
e Output Active/lnactive: trigger when specified output is active or inactive (note that
outputs can be configured to be active when high or low).
Trigger On Selects which channel will be used as the trigger signal: 1, 2, 3, 4, 5, or 6.
Position Selects placement of the trigger event on the screen. (Value is not configurable for
Immediate or Function Generator trigger types.).
o Left for optimal viewing of events following the trigger.
» Middle for optimal viewing of events preceding and following the trigger.
¢ Right for optimal viewing of events preceding the trigger.
Level Sets the trigger level, in units appropriate to the channel selected.

Event Status
Bit

With an event status trigger type selected, choose the event status word bit that will
trigger the trace. For descriptions of the event status word bits,
see Custom Event Functions (p. 52).

14.5: Trace Time, Sample Rate and Single Trace

HD LLC

Trace Time sets the length of the recorded trace.
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Sample Rate is the rate at which the signals are sampled. The rate depends on the trace
time, the number of channels selected, and which variables are being traced.

Single Trace puts the scope in a single trace mode of operation. In this mode, the trigger
is not re-armed after a trace until the user presses the Record button. Single Trace is
automatically set by the generators in certain cases.

14.6: Scope Display Parameters

The user can set the line style and other scope screen preferences. Right-click on the
scope screen to display the menus, as shown below.

R0 =cilloscope

Trace Status: Waiting for trigger position delay to expire

=10l x|

1500

1000

a00

g, ® line

Position (counts)
o

Preferences » plus
-1000

connected plus

I I I

0.0 a1 0z fuc] 0.4 05 0g o7 og 09 1.0 1.1 1.2 1.2
Time (seconds)

-1500

The Scope display parameters are described below.

Menu Parameter Description
Line Style line A line connects the plotted data points.
plus The Scope plots data points as plus signs, with no connecting line.

connected plus | Data points are plotted as plus signs and are connected with a line.

Preferences anti-aliasing When anti-aliasing is selected, the Scope smoothes out any screen-
related jaggedness in the displayed trace. Use of this feature may
slow down the refreshing of traces on slow computers.

grid When selected a grid is displayed on the scope screen.

14.6.1: Auto Scale and Auto Scale Lock
The Scope automatically scales the display axes to optimally display all channels.
With Auto Scale Lock selected, the y-axis locks its scale for all subsequent traces.
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14.6.2: Zoom

1

2

3

Zoom in on a Trace Segment
Hold the left mouse button down while dragging a box around the area of interest.

Trace Status: Trace Canceled - Ready To Start Mew Trace

|'1I"‘I "ﬂ“'lﬁ"\‘\l")t \1 lhlflnu"p hl'w'hiliflm
| | |

|
-,IFPF‘#M«_. ||II'!' ’7 ) K I'II ||I|J |.|”|| |J1'1 i W I “

Release the button to let the display zoom in on the selected area.

Trace Status: Trace Canceled - Ready To Start Mew Trace

A o

——P-A
', I|'||”'

To restore the normal zoom level immediately, left-click anywhere on the trace.
(Normal zoom level is also restored when the next trigger event occurs.)

14.7: Auto Setup

HD LLC

With Auto Set Up selected, if the function generator tab is active, HDM automatically sets
the scope settings and the function generator's amplitude and frequency/period to best suit
the function generator's Apply To and Excitation mode settings. If the Profile tab is active,
HDM automatically sets the scope settings and sets a standard move into the profile
generator. Changing any of the preset settings de-selects the Auto Set Up feature.
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14.8: Measurement Tab

The Measurement tab allows you to measure and analyze data from up to three
parameters during an interval defined by adjustable cursors. The Cursor Data area
displays a parameter’s values at the left and right cursor locations, and the difference
between the two values. The Analysis area displays the minimum, maximum, average, and
root mean square of the parameters during the cursor period.

Cursors
EuBhs cilloscope -3l =]
Trace
1800 -z0oo 125
1900 4000 100
1200 6000 e
1000 8000 50 %
3 z -
£ s00 -10000 Ses
i o
£ z 2 3
% 500 .5-12000 o0 2
o *Q‘ e )
* am &-14000 25 5
s
200 16000 50
0 -18000 ¢ 75
200 20000 -100
0.00 0.05 0.10 0.15 0.20 0.25 0.30 0.35 0.40 0.45 0.50
Time (zeconds)
Function Generator | profile | Settings | Gains | Trajectory Limits | Position Params | velocity Params  Measurement | c dat
Cursor raw data P CursorData lysis < ursor data
Left Right Delta Min [Max Avg tms  Units analySIS
Apply Ta:  [Posit l
T | hs Time: 01654 | 0.3331 | 0.1677 s
Function: [sarewave =] | [t =] N N NN | I I T NN cois
Amplitude: I 8000 counts RS 95
Frequency:l 1 Hz
Stark | Stop
ﬂ Record | Stop Trace | Clear | Close |

When Show Cursors is not set, the Cursor Data fields are inactive and the Analysis
fields show calculations based on data from the entire trace cycle.

Basic Measurement Operations

1 v shewursers T, display cursors and activate the Cursor Data fields, set Show Cursors.

2 To move a cursor, click on the cursor and hold the left button while dragging the cursor
to the desired location. Release the left button to place the cursor in the new location.

3 To select a parameter to measure and analyze within the cursors, choose a channel in
one of the three channel lists on the Measurement tab:

]
I
Y
=
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14.9: Control Loop Parameters

The Scope tool provides convenient access to all of the control loop parameters that might
be used in tuning and diagnosing an amplifier. The user can adjust these parameters and
see the results immediately on the scope. Control loop parameters are accessed through a
set of tabs, shown below.

Settings  Gains I Trajectory Limitsl Position Params| Welocity Params' Measurementl

Position Welocity Current
Pp: | 1000 il v | 14336 il Cp | 1310 il
&FF: | 0 i’ it | 3186 il Gt | 166 il

Cutput Filker Fc:

W I 16384 ﬂ

200

Note that the parameters represented on these tabs can also be accessed through the
screens used to configure the control loops and the digital position input. Changing a value
in the Scope tool automatically updates the value on the other screens where it appears,
and vice versa.

Control loop parameter tab descriptions follow.

14.9.1: Gains Tab

The Gains tab provides access to all of the gains appropriate to the operating mode, as
described below.

Modes Gains | Description For More Information
- Pp Position loop proportional gain.
(F;’r?lsyltlon mode Aff Acceleration feed forward. Trajectory Limits (p. 113).
Vff Velocity feed forward.
- Vp Velocity loop proportional gain. Velocity Loop Gains (p.
Position or Vi Velocitv | int | qai 105).
velocity mode i elocity loop integral gain.
only Output Velocity Loop Output Filter cut-off Low-Pass and Bi-Quad
Filter Fc | frequency. Filters (p. 163).
Cp Current loop proportional gain. Current Loop Gains (p.
Ci Current loop integral gain. 101).
Al modes ECp Encoder Correction Gain. Error! Reference source
not found. (p. Error!
Bookmark not defined.).

14.9.2: Trajectory Limits Tab
In position mode, the Trajectory Limits tab can be used to set trajectory limits.

Settingsl Gains  Trajeckary Limits I Pasition Paramsl Yelociby Paramsl Measuremeant |

Mazximum Velocity:

Maximumn Acceleration:

Maximurn Deceleration:

Iairnurm Jerk:

[ 10 rom
|7500 rps®
I—WD rps?
IW rps*

For more information on the velocity and acceleration limits, see Trajectory Limits (p. 113).
For more information on the Maximum Jerk setting, see Test S-Curve Profile (p. 112).

HD LLC
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Position Loop Parameters
In position mode, the Position Params tab can be used to set position loop parameters.

Settingsl Gainsl Trajectary Limits  Position Params | Welocity Params | Measurement |

Position Tracki
RN WS Actudl Posttion: 21319728 counts

Window:l 1000 counks
Set Zera Posikion
Tirne: I 10 ms —I
Followsing Errar: I 4000 counts

[~ Disable Fallowing Errar Faulk

Set Zero Position sets the amplifier's actual position count to zero. For more information on
the other settings, see Position and Velocity Error Notes (p. 71).

14.9.3: Velocity Loop Parameters

In position and velocity modes, the Velocity Params tab can be used to set velocity loop
parameters.

Settingsl Gainsl Trajeckary Limitsl Position Params  Velocity Params I Measurerment |

Velocity Tracking

Window:l 600 rpm Accel Limik: I 1000 rps?
Tirne: I 100 ms Decel Limit: I 1000 tps?

For information on the Velocity Tracking parameters, see
Position and Velocity Error Notes (p. 71). For information on the limits, see
Velocity Loop Limits (p. 104).
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14.10: Scope Files

The Scope Tool allows you to save both scope settings and scope trace data. Saving the
scope settings is useful for saving custom settings used for tests that are run frequently.

Saving the trace data is useful for archiving the performance of a system so that it can be
used as a reference at a later date for comparison.

14.10.1: Scope Settings Files

HD LLC

The Scope Tool File->Save Settings command allows you to save scope settings (settings
on the Function Generator, Profile, and Settings tabs in a .sco file. The File>Restore
Settings command restores them for quick setup.

Save scope settings:

On the Function Generator, Profile, and Settings tabs, choose the scope settings you
wish to save.

Choose File>Save Settings.

When prompted, enter a File Name. If needed, navigate from the default ScopeData
folder to another folder where you wish to store the file.

Click Save to save the .css file and close the screen.

Restore scope settings:

In the Scope Tool, choose File->Restore Settings.

If needed, navigate from the default ScopeData folder to the folder containing the .css
file.

Highlight the filename and click Open.
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14.10.2: Scope Trace Files

140

The Scope Tool can save trace data in HD LLC scope files (.sco files) that can be opened
later with the HDM Trace Viewer. Simultaneously, a version of the same trace is stored in a
comma-separated text file (.csv) and a tab delimited file (.txt), either of which can be
opened with a spreadsheet application such as Microsoft Excel (or other programs) for
mathematical analysis. The format of the .csv and the .txt file is the same:

Column 1: time

Column 2: Trace Channel 1

Column 3: Trace Channel 2 (if used)
Column n: Trace Channel n (if used)

NOTE: By default, scope files are saved in the ScopeData folder in the HDM installation
folder. For instance, c:\Program Files\HD LLC Motion\HDM\ScopeData. Use these
procedures to save and view trace files:

Save trace data:

Generate the trace you wish to save.

ﬂ In the Oscilloscope window, click the Save to Disk icon.

When prompted, enter a File Name. If needed, navigate from the default ScopeData
folder to another folder where you wish to store the file.

Click Save to save the .sco, .txt, and .csv files in the same folder and close the screen.
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View a trace file:

On the Main screen, choose Tools>View Scope Files to open the window.

2 Click Open File. When prompted, select the name of the file you wish to open.
Then, click Open to display the file in the Trace Viewer window.

3ethings | Measurement |

—Funckion Generator —————— —Scope —Trigger
Type: Function Generator
Apply To:  Position
Excitation: Square Wave Apply To: NfA
Amplitude: 2000 counts Position: M/
Period: Z Hz Level: e

Close |

The Measurement tab allows you to measure and analyze data from up to three
parameters during an interval defined by adjustable cursors. See Measurement Tab (p.
136).
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CHAPTER

15: DATA, FIRMWARE, AND LOGS

This chapter describes how HDM manages amplifier data and firmware, how to download
firmware, and use the amplifier logs.

Amplifier RAM and Flash Memory (p. 144)

Disk Storage of Amplifier and Motor Data Files (p. 144)
Data Management Tools (p. 145)

Amplifier Firmware (p. 147)

Error Log (p. 149)

Communications Log (p. 150)
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15.1: Amplifier RAM and Flash Memory

Amplifier RAM holds status data and certain user-entered data during operation. Its
contents are flushed when the ampilifier is reset or powered off. Flash memory
permanently stores the data. The contents of flash are loaded into amplifier RAM at power-

up or reset, as described below.

HDM User Guide

Amplifier RAM

Flash

Contents erased when amplifier is reset or
powered off.

Permanent. Contents retained when the amplifier is reset
or powered off.

Initial contents read from flash on power-up.
Contents then updated in real time to reflect
certain operational conditions and changes
entered with HDM software. At any time, the
user can use HDM to restore data from flash
into amplifier RAM.

Modified only by using a Save to Flash tool or by closing
certain screens (Motor/Feedback, Basic Setup, Homing,
or CAN Configuration), whose contents are automatically
saved to flash upon closing of the screen.

As described below, some data resides in
some in both.

flash only, some in amplifier RAM only, and

Data Resides In

Data

Flash only

This category includes all data represented on the
Motor/Feedback screen, Basic Setup screen, and CAN
Configuration screen. This data is automatically saved to
flash as soon as its entry is confirmed (when the user
clicks the appropriate Save to Flash button, or closes
the screen).

Flash and amplifier RAM

Includes all user-entered data represented on other
screens, such as gains, limits, and /O, faults, and regen
settings. Initial values for this data are factory-set in
flash. They are loaded from flash to amplifier RAM with
each power-up or amplifier reset. This data is saved to
flash only when a user clicks the appropriate Save to
Flash button. It is flushed from amplifier RAM with each
power-down or amplifier reset.

Amplifier RAM only

Includes operating status data such as actual position,
actual current, and amplifier temperature. Such data is
never stored in flash. It is flushed from amplifier RAM
with each power-down or amplifier reset.

15.2: Disk Storage of Amplifier and Motor Data Files

At any time, the user can save certain data from amplifier RAM and flash memory to a file
on disk. From the Main screen, the user can save all user-entered data represented on all

144

screens (the data described as Flash only

and Flash and amplifier RAM on p. 144). This

data is saved in a HD LLC amplifier data file with a .ccx filename extension.

From the Motor/Feedback screen, the user can save all data represented on the
Motor/Feedback screen. This data is saved in a HD LLC motor data file with a .ccm

filename extension.

A .ccx file can be restored to return the amplifier to a previous state or to copy settings
from one amplifier to another, as described in Copy Amplifier Data (p. 153).

HD LLC




HDM User Guide Data, Firmware, and Logs

15.3: Data Management Tools

15.3.1: Amplifier Data Management Tools

Operations performed using the amplifier data management tools at the top of the Main
screen (shown below) affect amplifier settings, including motor/feedback data. (HDVM
Control Program data is not saved by these operations.)

L8l CME 2 {XSL-230-40 Xenus 1}

File  Amplifier Tools Help e N
GEVEDE A

Amplifier Data Management Tools

The amplifier data management tools are described below.

Icon Name Description
Save amplifier | Saves all data represented on all screens to a disk file with a .ccx filename
data to disk extension.
Restores amplifier and motor data from a .ccx file to the PC and amplifier RAM
Restore and flash memory. Note that only certain data is saved to flash by this
ﬂ amplifier data operation (the data described as Flash only on p. 144). To assure that all data
from disk (including the data described as Flash and amplifier RAM) is stored in flash,

use the Save amplifier data to flash tool.

Save amplifier | Saves contents of amplifier RAM to amplifier flash memory.
data to flash

Restore Restores contents of amplifier flash memory to amplifier RAM.
ﬂ amplifier data
from flash

To use a data management tool, click the icon and respond to prompts.

15.3.2: Motor Data Management Tools

Operations performed using the data management tools at the bottom of the
Motor/Feedback screen (shown below) affect only user-entered data that is represented
on the Motor/Feedback screen.

Motor/Feedback i ﬂ ﬂ ﬂ i - Calculate‘ oK | Cancel

Data Management Tools

The motor data management tools are described below.

Name Description

Saves only motor/feedback data from the PC to a disk file with a .ccm
Save motor filename extension. Amplifier data that is not represented on the
data to disk Motor/Feedback screen is not saved in this file, and this operation does not

affect any .ccx files.

Restores only motor data from a disk file with a .ccm filename extension to
the PC. Amplifier data that is not represented on the Motor/Feedback screen
is not affected.

Restore motor
data from disk

Saves the contents of the Motor/Feedback screen from PC to amplifier flash
Save motor memory. Amplifier data that is not represented on the Motor/Feedback screen
data to flash is not saved. Can be used to assure that all changes are saved to flash
without closing the Motor/Feedback screen.

Restores only motor data from amplifier flash memory to the PC. Amplifier
data that is not represented on the Motor/Feedback screen is not affected.
Can be used before closing the Motor/Data screen to restore settings to the
previously saved values.

Restore motor
data from
flash

€8 b B

To use a data management tool, click the icon and respond to prompts.
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15.3.3: Save MACRO File for Delta Tau Controllers

This feature is available only on HD LLC MACRO ampilifiers such as the DDP Series
MACRO, with a minimum firmware version of 1.2.

Save a MACRUO file:

1 On the HDM Main screen, choose File>Save MACRO File to open the MACRO File
Save window:

x|
MACRO node: | i

oK | Cancel |

Enter the ID of the MACRO node with the settings you want to save and click OK.

When prompted, enter a File Name. If needed, navigate from the default AmpData folder
to another folder where you wish to store the file.

4 Click Save to save the .pmc file in the same folder and close the screen.
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15.4: Amplifier Firmware

The amplifier's flash memory holds the amplifier’'s firmware. As needed, perform the
following steps to obtain new firmware and download it to amplifier flash memory.

NOTE: Firmware can only be downloaded to an amplifier via a direct serial port or CAN
connection between the amplifier and the PC. HDM does not support downloading firmware
to a node amplifier via a multi-drop gateway amplifier.

NOTE: To check the firmware version currently loaded, click the Amplifier Properties button
or choose Help—>About.
WARNING: Do not power down or disconnect the amplifier during firmware download.

Download Firmware to the Amplifier

1 On the Main screen choose Tools>Download Firmware to open the Download
Firmware window.

Download Firmware x|

@ Do you weant to save yvour data befare
downloading new firmmware’?

[+l | Cancel |

2 To download new firmware without saving amplifier and motor data, click No
and then proceed to Step 4.

3 To save amplifier and motor data for backup purposes before downloading firmware,
click Yes.

Save Amplifier Data x|

[+ Save Data To Disk
[v Save Data To Flash

Cancel |

= Choose whether to save to disk, flash, both, or neither.

= Click OK to save data and continue to select a firmware image,
or click Cancel to continue without saving data.

= |f Save Data to Disk was selected, use the Save Amplifier Data to Disk screen to
browse to the folder where you want to save the .ccx file. Then enter a name in the
Name field. Then click Save.
When the Firmware Images window appears, proceed to Step 4.

Continued...
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...Download Firmware to the Amplifier, continued:

4 Use the Firmware Images window to locate and select a firmware image file.

B e mases ﬂ

Look in: IE] Firmwarelmage LI I -..5 E

File natne; IAcceInet_4.32.c:ff Open |
Files of type: IFirmware Imace Files (* o) LI Cancel |

5 Click Open to begin the download. A message window displays a series of progress

messages:
Writing new firmware image
L 3%

When the message window closes, the firmware download is complete.
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15.5: Error Log

HD LLC amplifiers track faults and warnings in a log in flash memory.

View the HDM Error Log

e Click the Error Log tool on the Main screen.

2 Click a tab to view a section of the log:

Tab Contents

Active Type and description of each active fault and warning. The contents of this tab are
automatically refreshed as new events occur.

History Type, description, and time of occurrence of each fault and most warnings since the
log was last cleared. The contents of this tab are not refreshed automatically as new
events occur. The contents are refreshed only when the tab is displayed or when
Refresh is clicked.

Frequency Type, description, and frequency of each fault and warning that has occurred since
the log was last cleared. The contents are refreshed only when the tab is displayed
or when Refresh is clicked.

CAN Network | (Under CAN control only.) Status of CAN bus. Lists warnings and errors.

3 To update the contents of the History or Frequency tabs, click Refresh.

=l

To save the log to a disk file, click the Save to Disk icon on the log screen.
Then navigate to the appropriate folder, enter a File Name for the log, and click Save.

To clear the log if needed, press Clear Log. (Contents cannot be recovered.)

To close the log screen, click Close.
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15.6: Communications Log

The communications log tracks all communications between HDM and the amplifier. The log is
maintained in the PC’s RAM. Typically it is used only on request of customer service for
troubleshooting purposes. When required, perform the following steps to manage the tracking and
storage of these messages.

NOTE: Do not leave the Enable Logging control selected for any longer than necessary. Leaving it
enabled for long periods can affect the PC’s performance.

View the HDM Communications Log

1 On the Main screen, choose Tools>Communications Log to open the screen:
l0ix]

16:38:33.678 COML Send: Get Latched Event 3tatus 00 £6 01 Oc 0OC
16:38:33.741 COM1 Recwv: Get Latched Ewvent Status 00 9a 02 00 32
16:38:33,.756 COML Zend: Get Event Status 00 £7 01 Oc 00 al

16:38:33.756 COML Recw: Get Event Status 00 85 02 00 20 00 £0 C
16:35:33.772 COM1 Send: Get Sticky Event Status 00 £b 01 Oc 00
16:3535:33.772 COM1 Recw: Get Sticky Event Status 00 53 02 00 20
16:38:33,772 COM1 Send: Get Fault Latch 00 £3 01 Oc 00 ad

16:38:33.772 COML Recw: Get Fault Latch 00 56 02 00 00 00 00 OC
16:38:33,772 COML Send: Get CAN network status 00 54 01 Oc 01 C
16:38:33,772 COML Recw: Get CAN network status 00 5d 01 00 04 C
16:35:33,772 COML Send: Get Trajectory Status 00 9e 01 Oc 00 cf
16:38:33.767 COML Recv: Get Trajectory Statwus 00 5b 01 00 00 OC
16:38:33.991 COML Send: Get Latched Event Scatus 00 £6 01 Oc 0OC
16:38:33.991 COM1 Recw: Get Latched Event 3tatus 00 9a 02 00 32

¥ Enable Lugying

[ Enable Event Statis Logging

v GF

ﬂ Clear | Closs |

2 Select the logging options described below.

Option Description

Enable Logging When selected, logging is enabled and all communications, with the exception
of status messages, are recorded in the log

Enable Event Status | When selected, status messages are included in the log. Note that Show
Logging “Get Variable” Cmnds must also be checked to log Event Status
commands.

Show “Get Variable” | When selected, “Get Variable” commands are added to the log.
Cmds

3 To clear the log contents from the PC’s RAM, press Clear.
NOTE: The log is limited to 2000 lines. When it reaches that limit, HDM automatically clears
the oldest 1000 lines.

M-
To save the log contents from the PC’s RAM to a disk file, click the Save to Disk icon.

When prompted, enter a File name.
Then, click Save to save the log file and close the window.
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16: VIRTUAL AMPLIFIER

Virtual amplifiers can be used for training and for creating motor data files off line.

A new virtual amplifier can be created based on a virtual amplifier template file (.ccv). HDM
includes a set of .ccv files representing HD LLC amplifiers. Perform these steps to create a
virtual amplifier:

Start HDM (p. 13).

2 Bl HoM V6.0 (DEP-180-18 unname(
File Amplifier Tools Help

Ay =6 23 (0B ] B

[=+/_4 HD Neighbarhasd
Lo BB vitual Amplifier
B -—- W01 unnamed

lnpu
Choose Virtual Amplifier from the HD Neighborhood tree to open the Open Virtual
Amplifier screen:

Open Yirtual Amplifier x|

Choose the method wou wantto use to create the
virtual amplifier.

& Create new amplifier file

" Open existing amplifier file

Cancel | Help |

3 (To open a virtual amplifier from an existing amplifier file, skip to Step 4 now.)
To create a new virtual amplifier file based on a virtual amplifier template file:

= Select Create new amplifier.

=  When prompted, highlight the virtual amplifier template filename (.ccv) that represents
the type of virtual amplifier you wish to create.

= Click Open to open the file and the Basic Setup screen.

Motor and amplifier values may now be viewed, entered, and adjusted.

4 Alternately, to open an existing amplifier file:

= Select Open existing amplifier file.
= When prompted, highlight the name of the file you wish to open.
= Click Open.

Motor and amplifier values may now be viewed, entered, and adjusted.
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APPENDIX

A:CoPY AMPLIFIER DATA

Perform steps 1-5 to configure an amplifier/motor pair by copying a .ccx file that was
prepared for the amplifier/motor combination.

To load a HDVM Program file as well, also perform step 6,
and to load a Cam Table file, also perform step 7.

Make sure the amplifier is connected to the PC using the serial or CAN connector.

ZIEIH

Start HDM (p. 13).

3 Use the command appropriate for your starting point:

ﬂ Starting from the Main screen, click Restore amplifier data from disk.

Load cox Fi |
OR g Starting from the Basic Setup screen, click Load ccx File.

4 When prompted, navigate to the folder containing the appropriate .ccx file.
Highlight the file name and then click Open to load the file data into amplifier RAM.

ﬂ On the Main screen, click Save to Flash to save the new settings to flash memory.

6 If you do not need to load a HDVM Control Program, skip to Step 7.
To load a HDVM Control Program, choose File>Restore HDVM Control Program.
When prompted, navigate to the folder containing the appropriate .ccp file.
Highlight the file name and then click Open to load the file data into flash memory.

This procedure also results in the setting of the Indexer 2 Program option Enable Control
Program on Startup. This configures the program to auto start when the amplifier is
powered up or reset.

7 If you do not need to load a set of Cam Tables, the process is complete.
To load a set of Cam Tables, choose File>Restore Cam Tables.
When prompted, navigate to the folder containing the appropriate .cct file.
Highlight the file name and then click Open to load the file data into flash memory.

TIP: When copying amplifier data to multiple amplifiers in a production environment,
consider locking HDM to prevent accidental changes to settings.
See Lock/Unlock HDM Controls (p. 155).
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APPENDIX

B:Lock/UNLOCK HDM CONTROLS

Optionally lock HDM to prevent changes to amplifier settings.
TIP: Lock HDM to prevent accidental changes to settings when copying amplifier files.

1 On the Main screen choose Tools>HDM Lock/Unlock.

2 | Setanew iassword in the Password and Verify Password fields.

Enter password ba lock HDM

werify Password: I:l

3 Click OK to lock out amplifier setting controls.

Bl HDM V6.0 (ADP-090-09 unnamed) WHEN HDM IS LOCKED:
Fie amplfier G Help
HEENEEE e o
T x| a0 User can not change any amplifier or
| —— motor settings.
|
T User can download amplifier and
Frogramme 4 2uston |/ P Loon |V Loon |—b{ [Laae || MotorT edback motor files and Cam Tables, Jog the
1 | motor, run scope functions and
profiles, and monitor amplifier
performance with the scope and
5 Lliss control panel.

Sine Commutaton Rotary Motor

4 To unlock, choose Tools>HDM Lock/Unlock.
HDM Unlock X

Enter password to unlock HDM

Unlack For this session anly

[ Ok l[ Cancel ]

5 Enter the password. Unlock for this session or until locked again. Click OK.
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APPENDIX

C: I°T TiME LIMIT ALGORITHM

This chapter describes the algorithm used to implement the T limit.
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C.1: I’T Algorithm

C.1.1: I’T Overview

The I?T current limit algorithm continuously monitors the energy being delivered to the motor
using the [T Accumulator Variable. The value stored in the F'T Accumulator Variable is
compared with the I°T setpoint that is calculated from the user-entered Peak Current Limit,
PT Time Limit, and Continuous Current Limit. Whenever the energy delivered to the motor
exceeds the I°T setpoint, the algorithm protects the motor by limiting the output current or
generates a fault.

C.1.2: I’T Formulas and Algorithm Operation

Calculating the I’T Setpoint Value

The I°T setpoint value has units of Amperes®-seconds (A?S) and is calculated from
programmed motor data. The setpoint is calculated from the Peak Current Limit, the T Time
Limit, and the Continuous Current Limit as follows:

PT setpoint =
(Peak Current Limit? — Continuous Current Limit?) * I*T Time Limit

I’T Algorithm Operation

During amplifier operation, the I°T algorithm periodically updates the I°T Accumulator
Variable at a rate related to the output current Sampling Frequency. The value of the FT
Accumulator Variable is incrementally increased for output currents greater than the
Continuous Current Limit and is incrementally decreased for output currents less than the
Continuous Current Limit. The I°T Accumulator Variable is not allowed to have a value less
than zero and is initialized to zero upon reset or +24 Vdc logic supply power-cycle.

Accumulator Increment Formula
At each update, a new value for the I°T Accumulator Variable is calculated as follows:

PT Accumulator Variable .4 =

PT Accumulator Variable ,

+(Actual Output Current 4> — Continuous Current Limit®) * Update period
After each sample, the updated value of the T Accumulator Variable is compared with the
PT setpoint. If the T Accumulator Variable value is greater than the T Setpoint value, then
the amplifier limits the output current to the Continuous Current Limit. When current limiting is
active, the output current will be equal to the Continuous Current Limit if the commanded
current is greater than the Continuous Current Limit. If instead the commanded current is
less than or equal to the Continuous Current Limit, the output current will be equal to the
commanded current.
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C.1.3: I’T Current Limit Algorithm — Application Example

I’T Example: Parameters
Operation of the I°T current limit algorithm is best understood through an example. For this
example, a motor with the following characteristics is used:
e Peak Current Limit—12 A
e FPT Time Limit—1S
e Continuous Current Limit—6 A
From this information, the I*T setpoint is:
PT setpoint = (12 A>-6 A?) * 1 S = 108 A’S
See the example plot diagrams on the next page.
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I*T Example: Plot Diagrams

The plots that follow show the response of an amplifier (configured w/ I°T setpoint = 108
A?S) to a given current command. For this example, DC output currents are shown in order
to simplify the waveforms. The algorithm essentially calculates the RMS value of the output
current, and thus operates the same way regardless of the output current frequency and
wave shape.

I’T current limit

16 [ \
144 | e |_commanded

12 1 |t i A | I_actual /

Current (A)
oo
\

0 1 2 3 4 5 6 7
Time ()

I’T Accumulator

120 -
100 -
80 A
60 -
40 A 1"2T Accumulator

20 +

. 1"2T Setpoint

I’T energy (A2-S)

0 1 2 3 4 5 6 7
Time (S)

B)
At time 0, plot diagram A shows that the actual output current follows the commanded
current. Note that the current is higher than the continuous current limit setting of 6 A.
Under this condition, the I°T Accumulator Variable begins increasing from its initial value of
zero. Initially, the output current linearly i increases from 6 A up to 12 A over the course of
1.2 seconds. During this same period, the T Accumulator Variable increases in a non-
linear fashion because of its dependence on the square of the current.

At about 1.6 seconds, the I°T Accumulator Variable reaches a values equal to the PT
setpoint. At this time, the amplifier limits the output current to the continuous current limit
even though the commanded current remains at 12 A. The I°T Accumulator Variable value
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remains constant during the next 2 seconds since the difference between the actual
output current and the continuous current limit is zero.

At approximately 3.5 seconds, the commanded current falls below the continuous current
limit and once again the output current follows the commanded current. Because the actual
current is less than the continuous current, the °T Accumulator Variable value begins to
fall incrementally.

The I*’T Accumulator Variable value continues to fall until at approximately 5.0 seconds
when the commanded current goes above the continuous current limit again. The actual
output current follows the current command until the I°T Accumulator Variable value
reaches the I*T setpoint and current limiting is invoked.

C.2: I*T Scope Trace Variables

Two Scope Tool trace variables are available for monitoring whether the PT accumulator is
accumulating or discharging.

The I°T Amplifier Accumulator variable evaluates the accumulator against the factory set
current limits of the amplifier.

The 1T Motor Accumulator variable evaluates the accumulator against the user-
programmed current loop values.

The value shown in the scope has been normalized so that 100% equals the I°T setpoint.
When either trace variable line reaches 100%, current limiting will be invoked.

For instructions on using these variables in the Scope Tool, see Trace Channel Variable
Parameters (p. 132).
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HD LLC

D: Low-PAss AND BI-QUAD FILTERS

HDM supports 2 classes of filters on the analog input and on the Velocity Loop command
and output: the Low-Pass and the Custom Bi-Quad. The Low-Pass filter class includes the
Single-Pole and the Two-Pole Butterworth filter types.

Set Filter Parameters:

Velocity Loop Filters

Analog Input Filter

il Click V Loop to open the Velocity
Loop screen.

Analog Command .
g—l Click Analog Command

to open the Analog Command screen.

Cormmand Fiter | Output Fitter

Click
Command Filter or Output Filter to
open the filter screen.

_ pnaboginput Fter | )i Analog Input Filter

to open the filter screen.

The velocity loop and analog input filter controls are identical. The filter window label
indicates the source of the filter call and the target of the filter changes. The sample
below shows the Velocity Loop Output Filter screen.

¥elocity Loop Output Filter

~Butterwiarth Low Pass Filter

]

-40db
decade

-3db
db

cut Off Frequency: I 200 Hz

R

Filter Type:  |Low-Pass, 2 Pole Buttervworth LI

Default |

Cloze
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Adjust the filter settings described below.

Filter Description

Class/Type

Low-Pass/ The single-pole low pass filter is the simplest filter. The value entered in the Cut-off

Single Pole Frequency field provides the -3 db point. The filter will attenuate at -20 db/decade past
the cut-off frequency, reducing excitation of high frequency resonance.

Low-Pass/ The Butterworth filter is a maximally flat low pass filter. This second order two-pole

2 Pole filter has a damping ratio of 0.707 and produces no peaking in the Bode plot. The

Butterworth value entered in the Cut off Frequency field provides the -3 db point. The filter
attenuates at
-40 db/decade past the cut off frequency. The phase-lag at lower frequencies is
greater than the phase lag of other second order filters that exhibit more peaking.

Custom The Bi-Quadratic filter has two quadratic terms: one in the numerator, and one in the

Bi-Quad denominator. The numerator affects the filter's two zeros and the denominator affects
the filter's two poles. Many filter classes and types can be expressed in the Bi-Quad
form by entering the coefficients. The coefficients can be calculated using any
commercially available math software package and entered as floating point numbers.
However, due to the fixed-point representation, the numbers may be rounded.
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E: HOMING METHODS

This appendix describes the homing methods that can be chosen using the HDM homing
controls described in Homing (p. 121).

Contents include:

Section Page
E.1: HOMING METNOAS OVEIVIEW ...ttt ettt ettt 166
E.2: Legend to Homing Method Descriptions ...166
E.3: Homing Method Descriptions.................. .. 167
E.3.1: Set current position as home. ...167
B 3120 INEXE INAEX...eiereteeeeeieieicicieecie et e ettt s et e ssaessaesaseses et esasasasesesesasesesasasesasasesesasesesas et esasesesatesesasesebatesabasesesasesabetesesasesesesesesasene 167
3,31 LMt SWIECN. ...ttt bbb bbb bbb bbb bbb bbb bbb bbb bbb bbb bbb bbb bbb bt ne 168
E.3.4: Limit Switch Out to Index ...169
E.3.5: Hardstop ......ccccceevvvrvennee. ..170
E.3.6: Hardstop Out to Index. A7
E.3.7: Home Switch.........cccceuueee. 72
E.3.8: Home Switch Out to Index.. .73
E.3.9: Home Switch In to Index..... .74
E.3.10: Lower Home.................. .75
E.3.11: Upper Home........cccceevenns ..176
E.3.12: Lower Home Outside Index..... LA77
E.3.13: Lower Home Inside Index........ .. 178
E.3.14: Upper Home Outside Index. .79
E.3.15: UpPer HOME INSIAE INAEX.....c.ciiiieuiiieeieiisieiei sttt saebe s ae e et esase et ese et esenssasese e ssese e sesese s et eneneasnsenssensan 180
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E.1: Homing Methods Overview

There are several homing methods. Each method establishes the:
¢ Home reference (limit or home switch transition or encoder index pulse)

¢ Direction of motion and, where appropriate, the relationship of the index pulse to limit or
home switches.

E.2: Legend to Homing Method Descriptions

As highlighted in the example below, each homing method diagram shows the starting
position on a mechanical stage. The arrow line indicates direction of motion, and the circled
H indicates the home position. Solid line stems on the index pulse line indicate index pulse
locations. Longer dashed lines overlay these stems as a visual aid. Finally, the relevant limit
switch is represented, showing the active and inactive zones and transition.

Mechanical Stage Limits
|

V o AXis v

[ — ]

Starting position—> | T

_— <— Direction of motion

E—— ®<—| <— Starting position

Index pulse location
: e I | I

Index Pulse
Positive Limit
Switch AT
Switch inactive T Switch active

Switch transition

Home position

Note that in the homing method descriptions, negative motion is leftward and positive motion
is rightward.
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E.3: Homing Method Descriptions

E.3.1: Set current position as home
The current position is the home position.

E.3.2: Next Index

Direction of Motion: Positive

Home is the first index pulse found in the positive direction. Direction of motion is positive. If
a positive limit switch is activated before the index pulse, an error is generated.

[ I ]

B

Index Pulse |

Direction of Motion: Negative

Home is the first index pulse found in negative direction. Direction of motion is negative. If a
negative limit switch is activated before the index pulse, an error is generated.

[

®f'

Index Pulse
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E.3.3: Limit Switch

Direction of Motion: Positive
Home is the transition of the positive limit switch. Initial direction of motion is positive if the
positive limit switch is inactive.

Positive Limit L
Switch

Direction of Motion: Negative

Home is the transition of negative limit switch. Initial direction of motion is negative if the
negative limit switch is inactive.

Negative Limit .
Switch
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E.3.4: Limit Switch Out to Index

Direction of Motion: Positive

Home is the first index pulse to the negative side of the positive limit switch transition. Initial
direction of motion is positive if the positive limit switch is inactive (shown here as low).

[ =

Positive Limit
Switch

Index Pulse

Direction of Motion: Negative

Home is the first index pulse to the positive side of the negative limit switch transition. Initial
direction of motion is negative if the negative limit switch is inactive (shown here as low).

= ]

Negative Limit
Switch

Index Pulse
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E.3.5: Hardstop

170

Direction of Motion: Positive

Home is the positive hard stop. Direction of motion is positive. In servo modes, the hard
stop is reached when the amplifier outputs the homing Current Limit continuously for the
amount of time specified in the Delay Time.

If a positive limit switch is activated before the hard stop, an error is generated.

[ il

| -®

Direction of Motion: Negative

Home is the negative hard stop. Direction of motion is negative. The hard stop is reached
when the amplifier outputs the homing Current Limit continuously for the amount of time
specified in the Delay Time. If a negative limit switch is activated before the hard stop, an
error is generated.
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E.3.6: Hardstop Out to Index

HD LLC

Direction of Motion: Positive

Home is the first index pulse on the negative side of the positive hard stop. Initial direction
of motion is positive. The hard stop is reached when the amplifier outputs the homing
Current Limit continuously for the amount of time specified in the Delay Time. If a positive
limit switch is activated before the hard stop, an error is generated.

[ =

| <?<—>

Index Pulse

Direction of Motion: Negative

Home is the first index pulse on the positive side of the negative hard stop. Initial direction
of motion is negative. The hard stop is reached when the amplifier outputs the homing
Current Limit continuously for the amount of time specified in the Delay Time. If a negative
limit switch is activated before the hard stop, an error is generated.

| [ ]
C

Index Pulse |
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E.3.7: Home Switch

Direction of Motion: Positive

Home is the home switch transition. Initial direction of motion is positive if the home switch
is inactive. If a limit switch is activated before the home switch transition, an error is

generated.

o
i

Home Switch

Direction of Motion: Negative

Home is the home switch transition. Initial direction of motion is negative if the home switch
is inactive. If a limit switch is activated before the home switch transition, an error is
generated.

Home Switch
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E.3.8: Home Switch Out to Index

Direction of Motion: Positive

Home is the first index pulse to the negative side of the home switch transition. Initial
direction of motion is positive if the home switch is inactive. If a limit switch is activated
before the home switch transition, an error is generated.

[

Home Switch

@
|

Index Pulse

Direction of Motion: Negative

Home is the first index pulse to the positive side of the home switch transition.
Initial direction of motion is negative if the home switch is inactive. If a limit switch is
activated before the home switch transition, an error is generated.

[ I ]

Home Switch

Index Pulse
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E.3.9: Home Switch In to Index

174

Direction of Motion: Positive

Home is the first index pulse to the positive side of the home switch transition. Initial
direction of motion is positive if the home switch is inactive. If a limit switch is activated
before the home switch transition, an error is generated.

[ = |

Home Switch

Index Pulse | |

Direction of Motion: Negative

Home is the first index pulse to the negative side of the home switch transition. Initial
direction of motion is negative if the home switch is inactive. If a limit switch is activated
before the home switch transition, an error is generated.

[

Home Switch

—@| |

Index Pulse
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E.3.10: Lower Home

Direction of Motion: Positive

Home is the negative edge of a momentary home switch. Initial direction of motion is
positive if the home switch is inactive. Motion will reverse if a positive limit switch is
activated before the home switch; then, if a negative limit switch is activated before the
home switch, an error is generated.

[ = |

i
.
Home Switch l_/ /_‘

Positive Limit

Switch // [

Direction of Motion: Negative

Home is the negative edge of a momentary home switch. Initial direction of motion is
negative. If the initial motion leads away from the home switch, the axis reverses on
encountering the negative limit switch; then, if a positive limit switch is activated before the
home switch, an error is generated.

[s = / ]
5

Home Switch

Negative Limit
Switch | / /
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E.3.11: Upper Home

Direction of Motion: Positive

Home is the positive edge of a momentary home switch. Initial direction of motion is positive.
If the initial motion leads away from the home switch, the axis reverses on encountering
the positive limit switch; then, if a negative limit switch is activated before the home switch,

an error is generated.
| /H]
2C)
I ( -
Home Switch ’_/

Positive Limit

Switch // [

Direction of Motion: Negative

Home is the positive edge of momentary home switch. Initial direction of motion is negative
if the home switch is inactive. If the initial motion leads away from the home switch, the
axis reverses on encountering the negative limit switch; then, if a positive limit switch is
activated before the home switch, an error is generated.

- /L ]

—~®

7

Home Switch
Negative Limit
Switch | / /

176 HD LLC



HDM User Guide Homing Methods

E.3.12: Lower Home Outside Index

Direction of Motion: Positive

Home is the first index pulse on the negative side of the negative edge of a momentary
home switch. Initial direction of motion is positive if the home switch is inactive. If the initial
motion leads away from the home switch, the axis reverses on encountering the positive
limit switch; then, if a negative limit switch is activated before the home switch, an error is
generated.

__®______|
X
N/

Home Switch

Positive Limit
Switch

Index Pulse | |

Direction of Motion: Negative

Home is the first index pulse on the negative side of the negative edge of a momentary
home switch. Initial direction of motion is negative. If the initial motion leads away from the
home switch, the axis reverses on encountering the negative limit switch; then, if a
negative limit switch is activated before the home switch, an error is generated.

" ]

~L!
~

J

T)--|--

T

Home Switch

Negative Limit

Switch _l

/

Index Pulse |
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E.3.13: Lower Home Inside Index

Direction of Motion: Positive

Home is the first index pulse on the positive side of the negative edge of a momentary
home switch. Initial direction of motion is positive if the home switch is inactive. If the initial
motion leads away from the home switch, the axis reverses on encountering the positive
limit switch; then, if a negative limit switch is activated before the home switch, an error is

]7/ /
/

[

s

Home Switch ’_'_/ /L|

Positive Limit /)
Switch ]/
Index Pulse | |

Direction of Motion: Negative

Home is the first index pulse on the positive side of the negative edge of a momentary
home switch. Initial direction of motion is negative. If the initial motion leads away from the
home switch, the axis reverses on encountering the negative limit switch; then, if a
negative limit switch is activated before the home switch, an error is generated.

[ ' g i}// | ]

»
™

a

U ____@

Home Switch
Negative Limit
Switch ] [/
[/
Index Pulse |
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E.3.14: Upper Home Outside Index

Direction of Motion: Positive

Home is the first index pulse on the positive side of the positive edge of a momentary home
switch. Initial direction of motion is positive. If the initial motion leads away from the home
switch, the axis reverses on encountering the positive limit switch; then, if a negative limit
switch is activated before the home switch, an error is generated.

/] ]
] [
| |

Home Switch /

Positive Limit /)
Switch ]/

Index Pulse

Direction of Motion: Negative

Home is the first index pulse on the positive side of the positive edge of a momentary home
switch. Initial direction of motion is negative if the home switch is inactive. If the initial
position is right of the home position, the axis reverses on encountering the home switch.

/ ]
] [
[ | / / H ]

Home Switch '
Negative Limit
Switch _I // //

Index Pulse | |
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E.3.15: Upper Home Inside Index

Direction of Motion: Positive

Home is the first index pulse on the negative side of the positive edge of momentary home
switch. Initial direction of motion is positive. If initial motion leads away from the home
switch, the axis reverses on encountering the positive limit switch; then, if a negative limit
switch is activated before the home switch, an error is generated.

[ /Al al

Home Switch d /L_|

Positive Lilmit /) |
Switch ] [
Index Pulse | |

Direction of Motion: Negative

Home is the first index pulse on the negative side of the positive edge of a momentary
home switch. Initial direction of motion is negative if the home switch is inactive. If initial
motion leads away from the home switch, the axis reverses on encountering the negative
limit; then, if a negative limit switch is activated before the home switch, an error is
generated.

Home Switch

Negative Limit
Switch _I /

Index Pulse
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F: REGEN RESISTOR CONFIGURATION

Optionally configure a regen resistor. Details follow in the chapter.

Incorrect values may damage amplifier or external regen resistor.

For the regen I°T algorithms to work correctly, the values entered in the following
steps must be correct. Damage to the external regen resistor may result from
incorrect values entered. Damage to the amplifier may result if an incorrect
resistance value is entered.

WARNING

Failure to heed this warning can cause equipment damage.
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Configure a Custom Regen Resistor

1 e Sange | Click Regen Settings to open the Regen Settings screen.

Regen Settings il
Resistance: 1 ¥]
Conkinuous Power: 0
Peak Power: 0w
Time ak Peak Power: 0 ms

2 If configuring a standard regen resistor, select the model number and click Finish to save
the configuration and close the screen.

Otherwise, continue.

3 Enter appropriate values for Resistance, Continuous Power, Peak Power, and Time at
Peak Power.

4 Click OK to save the configuration and close the screen.

182 HD LLC



HD LLC

APPENDIX

G: ASCIl CoMMANDS/SERIAL CONTROL

This chapter describes how to configure and operate an amplifier by sending ASCII
commands over the serial bus. Contents include:

The HD LLC ASCII Interface (p. 184).
HDM ASCII Command Line Interface Tool (p. 184).
Single-Axis Serial Connection (p. 185).

Multi-Drop Serial Connection (p. 185).

COMPATIBILITY: This chapter applies to DDP Series, RTL Series, and amplifiers only.
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G.1: HD LLC ASCII Interface

An amplifier's RS-232 serial bus can be used by an external control application (HMI, PLC,
PC, etc.) for setup and direct serial control of the amplifier. The control application can

issue amplifier commands from the set of ASCII format commands that make up the HD LLC
ASCI!I Interface.

For more information, see the HD LLC ASCII Interface Programmer’s Guide.

G.2: HDM ASCII Command Line Interface Tool

As described below, the HDM ASCIlI Command Line Interface tool provides a simple way to
enter HD LLC ASCII commands.

Use the ASCIl Command Line Interface to Enter Commands

1 From the Main screen, choose Tools->ASCIl Command Line to open the tool.

x ~10/
Comtnarc: Il
Response:
Kl 5
Helf | Close |

Enter an ASCIl Command in the Command field.

Press the Enter key to send the command to the amplifier. Observe the Response field.
If a value is returned, it is preceded by the letter “v.” In the following example, the get
command was used to retrieve the amplifier RAM value of variable 0x32 (actual position).
11X

Command: Ig r0x3 2|

Response: 38
4 [

Help | Close |

An error code would be preceded by the letter “e.”
TIP: To view an error definition, hold the mouse pointer over the error number.

For more information, see the HD LLC ASCII Interface Programmer’s Guide and the HD
LLC Amplifier Parameter Dictionary.
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G.3: Single-Axis Serial Connection

For RS-232 serial bus control of a single axis, set the CAN node address of that axis to
zero (0). Note that if the CAN node address is switched to zero after power-up, the
amplifier must be reset or power cycled to make the new address setting take effect.

A&l _
FL, PLC, or B8 | C0W port SER-CK "Sarial Cabile K" WO LLEC A ifir ——
Spin D-aul RJ11 with ASCH
for ASCI Conbel fow " AR .
B5-232

ADDRESS MUST BE SET
TO ZERD BEFORE
FOWER-UF QR RESET

G.4: Multi-Drop Serial Connection

A serially connected amplifier can be used as a multi-drop gateway for access to other
amplifiers linked in a series of CAN bus connections. Set the CAN node address of the
serially connected amplifier (gateway) to zero (0). Assign each additional amplifier in the
chain a unique CAN node address value between 1 and 127. For more information on CAN
node address assignment, see CAN Network Configuration (p. 67). Use 120 Ohms
termination on the first and last ampilifier.

TERMBA TION MUET BE 130 O
LUSED M FIREST AMD LAET Teriraizs
HODE

Saiinl .
P PLE. of HI BER-Cx “Serinl Catie b QAT
for ASCH Coriird Fm!ﬂ? bpn O-sub with ASC|| RS-232

AN Mebwork Cable LUTP CAT.OE Gigabe Eieanat

@ CAN Poim

ADDRESSES MUET BE 1220 O
SET BEFORE POWER-LUP Tarmnaisd
OF RESET
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H: GAIN SCHEDULING

The Gain Scheduling feature allows you to schedule gain adjustments based on changes

to a key parameter. For instance, Pp, Vp, and Vi could be adjusted based on changes to
commanded velocity.

Gain adjustments are specified in a Gain Scheduling Table. Each table row contains a key
parameter value and the corresponding gain settings. The amplifier uses linear interpolation
to make smooth gain adjustments between the programmed settings.

Gain scheduling involves the basic steps outlined below. Details follow in the chapter.

Configure Gain Scheduling (p. 188)

Set Up the Gain Scheduling Table(s) (p. 189), observing the Gain Scheduling Table
Guidelines(p. 193)
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H.1: Configure Gain Scheduling

1
2

3

188

Use this procedure to select basic Gain Scheduling options.

If necessary, Start HDM Software (p. 13).

On the Main screen, choose Am

Bl Gain Scheduling

Key Parameter: | Disable Gain Scheduling

[ Use Absalute Yalue of Key Parameter

Select Gains

[] Position Loop Pp
[] velocity Loop ¥p
[ velacity Laop vi

[] Cisable Gain Scheduling Unkil Axis is Referenced

lifier> Gain Scheduling.

Choose the Key Parameter:

Key Parameter

Description

Disable Gain Scheduling.

Disable gain scheduling.

Use Written Parameter.

An external controller can write to this parameter using any of several
protocols and corresponding parameter IDs: HD LLC ASCII Interface or
the HD LLC Indexer 2 Program (ID 0x128), CANopen and EtherCat (Index
0x2371), DeviceNet (object ID 0x2372), and MACRO I-variable (0x528).
See the HD LLC ASCII Interface Programmer’s Guide, the HD LLC Indexer
2 Program User Guide, the HD LLC CANopen Programmer’s Guide.

Use Commanded Velocity.

Schedule gain adjustments based on changes to commanded velocity.

Use Actual Velocity.

Schedule gain adjustments based on changes to actual velocity.

Use Commanded Position.

Schedule gain adjustments based on changes to commanded position.

Use Actual Position.

Schedule gain adjustments based on changes to actual position.

Optionally set controls:

Control

Description

Use Absolute Value of Key
Parameter

If a velocity or position value is chosen for the Key Parameter and this
option is set, the Key Parameter is interpreted as an absolute value.

Disable Gain Scheduling
Until Axis is Referenced

When this option is set, the scheduled gain adjustments do not take place
until the axis is referenced (homed).

Select the gains that you w

ish to adjust by schedule. The choices are Pp, Vp, and Vi. For

each gain you select, a column will be enabled in the Gain Scheduling Table.

Continue with Set Up the Gain Scheduling Table(s) (p. 189).
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H2: Set Up the Gain Scheduling Table(s)
H.2.1: Create a Gain Scheduling Table

Gain Scheduling

1 If necessary, Start HDM Software (p. 13).
2 On the Main screen, choose Amplifier->Gain Scheduling.

3 On the Gain Scheduling screen, open the Table tab:

[ il
File Edit
Config Table I
I Key Value (0.1 counts)s) I P Loop Pp Y Loop Vp I W Loop ¥i I

CYM memory usage: 0% &l ﬂl
ﬂl ﬂ' ﬁl ﬂl Cose |

If there is a table stored in amplifier flash, the screen will show it as in this sample:

=01

File  Edit
Canfig {Tabi]
Key Yalue F Loop Pp W Loop Vp W Loop Wi
i 1} 10 20 20
1 500000 20 20 20

CWI memary usage: 1% &l ﬂl
ﬂl ﬂl ﬂl ﬂl Close |

4 ﬂ If there is already a table stored in flash:
Optionally Save Settings and Table Data to Disk (p. 191).

'ﬁ' | Then click the Delete tool to delete the gain scheduling table data from
amplifier flash and PC RAM.

HD LLC
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5 &' On the Table tab, click the Create a new gain scheduling table tool. See the
rompt:

" lNew Table

Enker Mumber of Lines: I z

Ok, | Zancel |

6 Enter the number of lines (the number of gain adjustment specifications).
Click OK.

7 Enter the Key Parameter and gain adjustment values. All values must be integer, and
each Key Parameter value must be greater than the previous as described in Gain
Scheduling Table Guidelines (p. 193). Click in a field to enter or modify a value. Standard
mouse and keyboard editing techniques are available.

8 =j | On the Table tab, click Save gain scheduling table and setup to amplifier
flash memory before attempting to run the new table. This saves the Table tab
data and all Config tab settings.

9 Close the screen.

190 HD LLC



HDM User Guide Gain Scheduling

H.2.2: Edit Gain Scheduling Table Values

1 If necessary, Start HDM Software (p. 13).
2 On the Main screen, choose Amplifier->Gain Scheduling.

3 On the Gain Scheduling screen, open the Table tab:

E TeEY
File  Edit

Config  Table I

Key Walue {counts) F Loop Pp YW Loop Vp W Loop Wi
10000 10 10 20
450000 40 40 =11
100000 30 30 Foo
200000 100 1004 1nnl

[ =1

WM memory usage: 1%s &l E
ﬂl ﬂl ﬂl ﬁl Cose |

4 Edit using standard keyboard and mouse techniques. Note that if you begin typing
immediately, the digits you enter will be inserted in front of any existing digits.

All values must be integer, and each Key Parameter value must be greater than the
previous as described in Gain Scheduling Table Guidelines (p. 193).

5 =§ | On the Table tab, click Save gain scheduling table and setup to amplifier
flash memory before attempting to run the new table. This saves the Table
tab data and all Config tab settings.

6 Close the screen.

H.2.3: Save and Restore Gain Scheduling Tables and Settings

The Config tab settings and Table tab data can be saved to a HD LLC gains file (filename
extension .ccg) on disk. A .ccg file can be restored and then saved to flash.

Save Settings and Table Data to Disk

1 ﬂ On the Gain Scheduling screen, click the Save gain scheduling table and
setup to disk tool to open the Save Table to Disk screen. Enter a name for the
file, and click Save. Config tab settings and Table tab data are saved to the file.

2 .:;m Click Save gain scheduling table and setup to amplifier flash memory
before attempting to run the new table. This saves the Table tab data and all
Config tab settings to amplifier flash.

3 Close the screen.
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Restore Settings and Table Data from Disk

1 Set Up the Gain Scheduling Table(s) (p. 189) or
Edit Gain Scheduling Table Values (p. 191).
Observe the Gain Scheduling Table Guidelines (p. 193).

2 On the Gain Scheduling screen, click the Restore gain scheduling table and
setup from disk tool to open the Restore Gain Scheduling Table from Disk
screen. Highlight the name of the file containing the settings and data you wish to
restore, and click Open. The settings and data are restored to the Config and
Table tabs.

3 .:,;ﬂl Click Save gain scheduling table and setup to amplifier flash memory
before attempting to run the new table with the new settings. This saves all
Config tab settings and Table tab data to amplifier flash.

4 Close the screen.
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H.3:

H.3.1:

H.3.2:

HD LLC

Gain Scheduling Table Guidelines

A Gain Scheduling Table contains a progression of Key Parameter values and
corresponding gain adjustment values.
Gain Schedule Table Storage Limits

The maximum number of lines (gain adjustment specifications) that can be stored in the
Gain Scheduling Table is 1000. A typical Gain Schedule Table will contain far fewer lines.

The number of Gain Scheduling Table lines is limited by the amount of HDVM memory space
available in the amplifier. A Gain Scheduling Table loaded into the amplifier shares that
space with HD LLC Virtual Machine (HDVM) programs and Camming Tables. Therefore, the
maximum number of Gain Schedule Table lines will decrease if HDVM programs or
Camming Tables are stored in the amplifier.

The Gain Scheduling screen Tables tab displays the percentage of amplifier memory
used:

CYM mermory usage: 1% [:?%

Gain Schedule Data Rules

o All must be whole numbers (no fractional values).
o All Key Values must be increasing.
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